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INTRODUCTION TO MEGA SUITE FOR 
DODAF 2

Enterprise architecture (EA) is a term related to the practice of modeling the elements of business
strategies, business processes and supporting technologies, and policies and infrastructures that
make up an enterprise. Its role is to provide support for decision-making in the enterprise strategy.
The architecture is also used as an analysis tool to develop new capabilities and structure
organizations and to optimize processes and spending. This is typically what the MEGA Modeling
tool helps to do. Regardless of the modeling tool used, a set of frameworks have been designed to
be used either as guidelines to implement enterprise architecture projects (for example, TOGAF) or
to define the deliverables expected as a result of such projects. This is the case of DoDAF 2.

The Department of Defense Architecture Framework (DoDAF) defines a standard way of organizing
enterprise architectures into complementary and consistent views. The design of this framework
was motivated by legal obligation (the Clinger-Cohen Act and United States Office of Management
and Budget Circulars A-11 and A-130). All major U.S. Government Department of Defense (DoD)
weapons and information technology system acquisitions are required to develop and document an
EA using the views prescribed in DoDAF. This recognition is however, not restricted to the U.S.
sector; many international military-oriented companies use this framework as a basis to model
enterprise architectures.

Bearing all this in mind, a DoDAF implementation tool should be able to generate standardized
documents that deal with enterprise architectures and that support the search for sponsorship and
funding of major mission-oriented systems.

The framework details all the viewpoints addressing the different aspects of enterprise architectures
(the overall purpose, the operational perspective, the system perspective and the technical
perspective).

The MEGA Suite for DoDAF 2 is designed to generate DoDAF deliverables. It is based on the
standard features of the MEGA Modeling tool, however, dedicated features have been introduced
to guide the DoDAF expert to use the product with the vocabulary with which he/she is accustomed.

The MEGA Suite for DoDAF 2 is based on the DoDAF v.2 release.

The present guide details how all views defined in the DoDAF v.2 standard are implemented in the
MEGA Suite for DoDAF 2 product.

 "Modeling Architectures in a Repository", page 14
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Introduction

MODELING ARCHITECTURES IN A REPOSITORY

The MEGA Modeling suite is designed to facilitate modeling and analyzing enterprise
architectures. When several architectures are to be designed, the issue of
architecture management is raised straight away. Why model several architectures
in a single repository? This may have to do with one of three things:

 "Architecture Composition", page 14
 "Evolution Traceability", page 14
 "Evolution Traceability", page 14

Architecture Composition

The issues dealt with in architecture modeling range from business processes to
technical infrastructure via systems and applications. Architecture modeling is a
very broad subject and modeling a huge architecture which is composed of many
business processes can be hard work. Splitting the task into smaller architectures
can help to achieve the modeling effort. Adopting this solution means that a set of
sub-architectures must be contained in the same repository. These architectures
are then reused to compose bigger ones. To facilitate this, the MEGA Suite for
DoDAF 2 supplies a referencing service that allows users to integrate architectures
into a new one.

Evolution Traceability

DoDAF has several models that address the issue of architecture evolution (SV-8,
SV-9, StdV- 2). These models help to determine the plans for future architecture
changes. However, once the plan has been implemented, the architecture itself is
in a new state that may be in line with the plan but which may also have differences
due to unpredictable situations. In this case, the actual evolution of an architecture
can be modeled via several architectures. Each of these architectures matches the
actual state of the architecture at a given time and contains its own plans for the
future.

Architecture Comparison

One of the main reasons behind having a Standard that specifies the format of
enterprise architecture deliverables is that this facilitates the comparison of several
architectures. All architectures display their properties and definitions in the same
way. This enables readers to compare and analyze the differences in architectures
and select the architecture that best corresponds to their needs.
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THE MEGA IMPLEMENTATION OF 
DODAF V.2

This section deals with MEGA's implementation of DoDAF v.2. The aim is to present the main
principles that govern this implementation and guide the user in his/her use of the MEGA Modeling
tool to create DoDAF 2 deliverables.

 "The DoDAF 2 Viewpoints", page 16
 "The DoDAF 2 Models", page 19
 "The MEGA Implementation", page 29
 "Importing Solution Packs", page 34
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THE DODAF 2 VIEWPOINTS

DoDAF 2.0 is composed of a set of deliverables, called viewpoints, which address
different parts of an enterprise architecture. These viewpoints are grouped into
models. Models that focus on the same perspective are placed in the same
viewpoint.

DoDAF 2.0 organizes architectures into eight different viewpoints: 
• All Viewpoint (AV)
• Capability Viewpoint (CV)
• Data and Information Viewpoint (DIV)
• Operational Viewpoint (OV)
• Project Viewpoint (PV)
• Services Viewpoint (SvcV)
• Standards Viewpoint (StdV)
• Systems Viewpoint (SV)

Each viewpoint portrays certain architecture features. Some features span several
viewpoints and provide integrity, coherence, and consistency to architecture
descriptions. 

All Viewpoint (AV)

There are some overarching aspects of an architecture that relate to all the
viewpoints.

These overarching aspects are captured in the All Viewpoint (AV) models. The AV
models provide information pertinent to the entire architecture, but do not
represent a distinct viewpoint of the architecture. AV models provide an overview of
the architecture, setting the scope and context of the architecture. The scope
includes the subject area and timeframe for the architecture.

The setting in which the architecture exists comprises the interrelated conditions
that compose the context for the architecture. These conditions include:

• Doctrine
• Tactics
• Techniques
• Procedures
• Relevant goals and vision statements
• Concepts of operations
• Scenarios
• Environmental conditions

The AV models also include such things as the rules, constraints, assumptions and
derived vocabulary that pertains to the architecture. It captures the intent of the
architecture to help ensure its continuity in the face of leadership, organizational,
and other changes that can occur over a long development effort.
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The MEGA Implementation of DoDAF V.2
The DoDAF 2 Viewpoints

Capability Viewpoint (CV)

The Capability Viewpoint (CV) supports the process of analyzing and optimizing the
delivery of capabilities in line with DoD’s strategic intent. The CV achieves this by
capturing essential elements of DoD’s strategic vision and concepts and other
capability planning processes, and decomposing this data into a capability
taxonomy. The taxonomy is augmented with schedule data and measures of
effectiveness to enable the analysis of capability gaps and overlaps. The CV also
details the dependencies between capabilities, enabling capability options to be built
in a more coherent manner.

Data and Information Viewpoint (DIV)

The Data and Information Viewpoint (DIV) portrays the operational and business
information requirements and rules of the architecture. It describes the information
that is associated with the information exchanges in the architecture, such as
attributes, characteristics, and interrelationships.

Several levels of abstraction are necessary to accurately communicate the
information needs of organizations and enterprises. The appropriate levels of
abstraction for a given architecture depend on the use and the intended users of the
architecture.

DoDAF V2.0 incorporates three levels of abstraction that correlate to the different
levels associated with most data models developed in support of the operations or
business. These levels are:

• Conceptual
• Logical
• Physical

Operational Viewpoint (OV)

The Operational Viewpoint (OV) is a description of the tasks and activities,
operational elements, and information exchanges required to accomplish DoD
missions. DoD missions include both war-fighting missions and business processes.
The OV contains graphical and textual content that comprise an identification of the
operational nodes and elements, assigned tasks and activities, and information
flows required between nodes. It defines the types of information exchanged, the
frequency of exchange, which tasks and activities are supported by the information
exchanges, and the nature of information exchanges.

Project Viewpoint (PV)

The Project Viewpoint (PV) describe the relationships between capability
requirements and the various programmes and projects being implemented. More



18 MEGA Suite for DoDAF 2

1

precisely they describe how the programmmes and projects deliver the capabilities,
the organizations that contribute to them, and the dependencies between them.

Services Viewpoint (SvcV)

The Services Viewpoint (SvcV) describes services and their interconnections that
provide or support DoD functions. The viewpoint also supports the description of
service taxonomies, service orchestrations, a mapping of services to operational
activities and a description of service behavior.

The Service Models associate service resources to the operational and capability
requirements. These resources support the operational activities and facilitate the
exchange of information. The relationship between architectural data elements
across the Services Viewpoint to the Operational Viewpoint and Capability Viewpoint
can be exemplified as services are procured and fielded to support the operations
and capabilities of organizations. 

A service within the SvcV is understood in its broadest sense, to be a unit of work
through which a provider provides a useful result to a consumer. Services are not
limited to internal system functions and can include Human Computer Interface
(HCI) and Graphical User Interface (GUI) functions or functions that consume or
produce service data to or from service functions. The external service data
providers and consumers can be used to represent the human that interacts with
the service.

Standards Viewpoint (StdV)

The Standards Viewpoint (StdV) is the minimal set of rules governing the
arrangement, interaction, and interdependence of system parts or elements. Its
purpose is to ensure that a system satisfies a specified set of operational
requirements. The StdV provides the technical systems implementation guidelines
upon which engineering specifications are based, common building blocks are
established, and product lines are developed. The StdV includes a collection of the
technical standards, implementation conventions, standards options, rules, and
criteria organized into profile(s) that govern systems and system elements for a
given architecture.

Systems Viewpoint (SV)

The Systems Viewpoint (SV) is a set of graphical and textual models that describes
systems and system interconnections that provide for or support operatonal
activities. The SV associates system resources to the OV. These system resources
support the operational activities and facilitate the exchange of information among
operational nodes.
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THE DODAF 2 MODELS

Each of the eight viewpoints defined above groups models. In DoDAF 2 vocabulary,
a model is either a graphical, textual or tabular deliverable that describes the
characteristics that are relevant to the architecture product. Each model is
associated to a short name created from the abbreviation of the viewpoint to which
it belongs (AV, CV, DIV, OV, PV, SvcV, StdV, SV) and suffixed by a number. 

The following tables list the different DoDAF 2 models with their coded names and
a brief description.

DoDAF 2 All Viewpoint Models

Code Model Name Comment

AV-1 Overview and Summary 
Information

Describes a Project's Visions, 
goals, objectives, plans, 
activities, events, conditions, 
measures, effects 
(Outcomes), and produced 
objects. Also defines 
architecture project while 
specifying its scope, purpose, 
viewpoint, context tools and 
file formats used, analytical 
findings and costs.

AV-2 Integrated Dictionary Architecture data repository 
with definitions of all terms 
used in the architectural data 
and presentations.
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DoDAF 2 Capability Viewpoint Models

Code Model Name Comment

CV-1 Vision An overall vision for transfor-
mational endeavors, which 
provides a strategic context 
for the capabilities described.

CV-2 Capability Taxonomy Structured list of capabilities 
referenced in one or more 
architecture descriptions and 
which are required during a 
particular time-frame.

CV-3 Capability Phasing Representation of available 
capabilities at different points 
in time or during specific 
timeframes.
The CV-3 shows the capabi-
lity phasing in terms of the 
activities, conditions, desired 
effects, rules complied with, 
resource consumption and 
production, and measures, 
without takinh into account 
the performer or location 
solutions.

CV-4 Capability Dependencies Presents capabilities, capabi-
lity functions, describes the 
dependencies between capa-
bilities and defines the logical 
groupings of capabilities.



21

The MEGA Implementation of DoDAF V.2
The DoDAF 2 Models

CV-5 Capability to Organizational 
Deployment Mapping

Presents capabilities, system 
connectivity, organizational 
structures, and programma-
tic information.
The fulfillment of capability 
requirements shows the 
planned capability deploy-
ment and interconnection for 
a particular Capability Phase. 
The CV-5 shows the planned 
solution for the phase in 
terms of performers and 
locations and their associated 
concepts.

CV-6 Capability to Operational 
Activities Mapping

Describes the mapping 
between capability elements 
and the operational activities 
that these capabilities sup-
port.

CV-7 Capability to Services Map-
ping

Describes the mapping 
between capabilities and the 
services that these capabili-
ties enable.

Code Model Name Comment
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DoDAF 2 Data and Information Viewpoint Models

Code Model Name Comment

DIV-1 Conceptual Data Model Presents the required high-
level data concepts and their 
relationships which include 
the operational objects, infor-
mation and business rules 
used to analyze the informa-
tion aspect of the operational 
domain and guide the design 
of information systems.

DIV-2 Logical Data Model Presents the documentation 
of the data requirements and 
structural business process 
(activity) rules. This enables 
an analysis of a system’s 
data definition aspect, with-
out consideration of imple-
mentation-specific or 
product-specific issues and 
provides a common dictio-
nary of data definitions to 
consistently express models 
wherever logical-level data 
elements are included in the 
descriptions.
In DoDAF V1.5, this was the 
OV-7.

DIV-3 Physical Data Model Physical implementation of 
the Logical Data Model 
entities, for example, 
message formats, file 
structures, physical Schema.
In DoDAF V1.5, this was the 
SV-11.
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DoDAF 2 Operational Viewpoint Models

Code Model Name Comment

OV-1 High Level Operational 
Concept Graphic

High-level graphical 
description of the operational 
environment of the 
architecture, in terms of 
operational elements 
involved, geographic regions, 
nodal connectivity, types of 
forces employed, etc., and its 
functionality.

OV-2 Operational Resource Flow 
Description

A description of the resource 
flows exchanged between 
operational activities. This 
includes an oindication of 
operational nodes, 
connectivity and the 
information exchange 
needlines between nodes.

OV-3 Operational Resource Flow 
Matrix

A description of the resources 
exchanged between nodes 
and the relevant attributes of 
the exchanges.

OV-4 Organizational Relationships 
Chart

The organizational context, 
role or other relationships 
among organizations.

OV-5a Operational Activity 
Decomposition Tree

The capabilities and 
operational activities 
organized in a hierarchal 
structure.

OV-5b Operational Activity Model Capabilities, operational 
activities/operational tasks 
and their relationships 
among activities, inputs and 
outputs; additional data can 
show cost, performing nodes 
or other pertinent 
information.



24 MEGA Suite for DoDAF 2

1

DoDAF 2 Project Viewpoint Models

OV-6a Operational Rules Model One of three models used to 
describe operational activity. 
It identifies business rules 
that constrain operations.

OV-6b State Transition Description One of three models used to 
describe operational activity. 
It identifies how an 
operational node or activity 
responds to events.

OV-6c Event-Trace Description One of three models used to 
describe operational activity. 
It traces actions in a scenario 
or sequence of events.

Code Model Name Comment

Code Model Name Comment

PV-1 Project Portfolio Relationships A description of the depen-
dency relationships between 
the organizations and pro-
jects and the organizational 
structures needed to manage 
a portfolio of projects.

PV-2 Project Timelines A timeline perspective on 
programmes or projects, with 
the key milestones and 
interdependencies.

PV-3 Project to Capability Mapping Mapping of programmes and 
projects to capabilities to 
show how the specific pro-
jects and programme ele-
ments help to achieve a 
capability.
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DoDAF 2 Services Viewpoint Models

Code Model Name Comment

SvcV-1 Services Context Description The identification of ser-
vices, service items and their 
interconnections.

SvcV-2 Services Resource Flow Des-
cription

A description of Resource 
Flows exchanged between 
services.

SvcV-3a Systems-Services Matrix The relationships among or 
between systems and ser-
vices in a given architecture.

SvcV-3b Services-Services Matrix The relationships among ser-
vices in a given architecture. 
It can be designed to show 
relationships of interest, (e.g. 
service-type interfaces and 
planned vs. existing inter-
faces).

SvcV-4 Services Functionality Des-
cription

The functions performed by 
services and the service data 
flows among service func-
tions (activities).

SvcV-5 Operational Activity to Ser-
vices Traceability Matrix

A mapping of services (activi-
ties) to operational activities.

SvcV-6 Services Resource Flow 
Matrix

Provides details of service 
Resource Flow elements 
being exchanged between 
services and the attributes of 
the exchange.

SvcV-7 Services Measures Matrix The measures (metrics) of 
Service Model elements for 
the appropriate time frames.

SvcV-8 Services Evolution Descrip-
tion

The planned incremental 
steps toward migrating a 
suite of services to a more 
efficient suite or toward evol-
ving current services to a 
future implementation.
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DoDAF 2 Standards Viewpoint Models

SvcV-9 Services Technology & Skills 
Forecast

The emerging technologies, 
software/hardware products, 
and skills that are expected 
to be available at a given set 
of time frames and that will 
affect future service develop-
ment.

SvcV-10a Services Rules Model One of three models used to 
describe service functionality. 
It identifies the constraints 
that are imposed on system 
functionality due to some 
aspect of system design or 
implementation.

SvcV-10b Services State Transition 
Description

One of three models used to 
describe service functionality. 
It identifies responses of ser-
vices to events.

SvcV-10c Services Event-Trace Descrip-
tion

One of three models used to 
describe service functionality. 
It identifies service-specific 
refinements of critical 
sequences of events descri-
bed in the Operational 
viewpoint.

Code Model Name Comment

Code Model Name Comment

StdV-1 Standards Profile Listing of standards that 
apply to the Systems and 
Services Viewpoint elements 
in a given architecture and 
how they need to be, or have 
been, implemented.

StdV-2 Standards Forecast Description of emerging 
standards and the potential 
impact on the architecture 
and its constituent elements, 
within a set of time frames.



27

The MEGA Implementation of DoDAF V.2
The DoDAF 2 Models

DoDAF 2 Systems Viewpoint Models

Code Model Name Comment

SV-1 Systems Interface 
Description

Identification of systems, 
system items and their 
interconnections and the 
information exchanges 
between them.

SV-2 Systems Resource Flow 
Description

A description of the resource 
flows exchanged between 
systems.

SV-3 Systems-Systems Matrix Describes relationships 
between systems in a given 
architecture. It can be 
designed to show 
relationships of interest, for 
example, system-type 
interfaces, planned vs 
existing interfaces, etc.

SV-4 Systems Functionality 
Description

The functions (activities) 
performed by systems and 
the system data flows among 
system functions activities.

SV-5a Operational Activity to 
Systems Function Traceability 
Matrix

A mapping of system 
functions (activities) back to 
operational activities.

SV-5b Operational Activity to 
Systems Traceability Matrix

A mapping of systems back 
to capabilities or operational 
activities.

SV-6 Systems Resource Flow 
Matrix

Provides details of system 
data elements being 
exchanged between systems 
and the attributes of this 
exchange.

SV-7 Systems Measures Matrix The measures (metrics) of 
System Model elements for 
the appropriate timeframes.

SV-8 Systems Evolution 
Description

The Planned incremental 
steps toward migrating a 
suite of systems to a more 
efficient suite, or toward 
evolving a current system to 
a future implementation.
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SV-9 Systems Technology & Skills 
Forecast

The emerging technologies 
and software/hardware 
products and skills that are 
expected to be available in a 
given set of time frames and 
that will affect future system 
developments of the 
architecture.

SV-10a Systems Rules Model One of three models used to 
describe system functionality. 
It identifies constraints that 
are imposed on the 
architecture or its systems 
due to some aspect of 
system design or 
implementation.

SV-10b Systems State Transition 
Description

One of three models used to 
describe system functionality. 
It identifies responses of 
systems to states, events 
and actions.

SV-10c Systems Event-Trace 
Description

One of three models used to 
describe system functionality. 
It identifies system-specific 
refinements of critical 
sequences of events 
described in the Operational 
Viewpoint.

Code Model Name Comment
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THE MEGA IMPLEMENTATION

As an enterprise architecture tool, the MEGA Modeling application can be used to
implement a DoDAF project. Many different frameworks have been designed to help
implement enterprise architecture projects. Even though common concepts can be
retrieved in each framework, vocabularies may differ and sometimes the same
words can be used with slight variations. MEGA has its own history and the
vocabulary contained in the MEGA Modeling tool metamodel reflects MEGA's vision.
The tool also supplies a rich set of diagrams that are dedicated to modeling the
different levels of enterprise architecture, however, because of the history, the
diagrams are either not named or are not exactly equivalent to those described in
the DoDAF V2.0 standard.

DoDAF 2 Model Generation

According to the DoDAF V2.0 standard, there are three kinds of deliverables:
• Graphical
• Textual
• Tabular 

Take for example, the AV-1, OV-4 and OV-3 viewpoints. The AV-1 viewpoint
describes the scope and purpose of the architecture. It can be delivered as a textual
document. The OV-4 viewpoint graphically describes the hierarchy and relationships
in the organization. This is graphically described in a MEGA organizational chart.
Finally, in an OV-3 viewpoint, the expected result is a tabular representation of the
exchange between operational nodes.

Even though there are three kinds of report chapters, the MEGA implementation of
the DoDAF V2.0 viewpoints is consistent; it always relies on the report platform that
allows for the generating of viewpoint contents in the MEGA Modeling tool both as
working and input tools, and in HTML and RTF formats.

Objectives and Requirements

The OV-6a and SV-10a viewpoints identify the business, operational and system
rules that apply to meet the objectives of systems, system hardware/software
items, and/or system functions, enterprises, missions, operations, businesses, and
architectures. These rules can act as either constraints or requirements.

To ensure that objectives and requirements are displayed in the OV-6a and SV-10a
viewpoints the Objectives and requirements modeling option must be activated
in MEGA. By default, this option is activated.
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If by chance, however, you are not able to view your objectives and requirements
activate the Objectives and requirements modeling option:

 Select Options > Business Process and Architecture Modeling > 
Objectives and requirements modeling.

Tagging Constraints, Contents and Requirements as Operational or 
System Items

In the MEGA Suite for DoDAF 2 contents, requirements and constraints can either
be operational or system items. When these objects are created from the
corresponding viewpoint folder, for example, the "Operational Constraints" folder in
the OV-6a Operational Rule Model viewpoint, the constraint is automatically tagged
as operational. If constraints, contents or requirements are created in diagrams
they are not automatically tagged as system or operational items. They may,
however, have been linked to other objects in the repository. It is important to tag
these objects to avoid any form of confusion and to enable their identification.
Tagging each of these objects one by one can be a tedious task. You can, however,
simplify this task by tagging several objects simultaneously. This can be done by
using the Query feature.

You can also use the Query feature when you want to change the View Type of an
object.

The best way to proceed is to find all the operational or system contents,
requirements and constraints retrieved by linked objects.
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The available Queries are:
• All Operational Contents retrieved by linked objects (EAF)
• All System Contents retrieved by linked objects (EAF)
• All Operational Constraints retrieved by linked objects (EAF)
• All System Constraints retrieved by linked objects (EAF)
• All Operational Requirements retrieved by linked objects (EAF)
• All System Requirements retrieved by linked objects (EAF)

For instance you want to find the contents linked to operational objects.

To tag objects as operational items:
1. Use the Query tool and find the All Operational Contents retrieved 

by linked objects (EAF) query.
2. Select the query and in the list that appears click on Find button.

3. In the dialog box select Architecture Description.
4. Specify the architecture on which the query is to be applied and click OK.
5. The list of objects retrieved appears in the Result tab.
6. From the show menu select Columns.
7. Add the "DoDAF 2.0 Object View Type" to the list of columns to be 

displayed and click OK.
The "DoDAF 2.0 Object View Type" column is displayed for the list of
retrieved objects.

8. Select the objects you wish to tag and click in the "DoDAF 2.0 Object 
View Type" box.
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9. From the list proposed, select the desired option, for example 
"Operational" if you want to tag the content objects as operational items.

The View Type for the selected objects has been modified.

Variations

The MEGA Suite for DoDAF 2 contains a feature that allows users to create and
manage alternative versions of objects and models. This is the variation feature.

Variants are used to describe objects and models differently from the reference
model or object or to make updates to objects and models over time.

Variants inherit the elements of the object from which they derive. Inherited
elements are displayed in the navigation tree with an inheritance arrow next to
them.

For more information on variations, see the MEGA Common Features user guide
"Handling Repository Objects", "Object Variations".

 In the MEGA Suite for DoDAF 2, variants can be used for 
processes, more particularly, in OV-5, OV-6c and SV-4. 

Graphical visualization of variations

In diagrams, variations are displayed as inheritances. The inheritance arrow
available in UML class diagrams is used to represent variations, and goes from the
variant item to the varied item. 

Activating variations

For architecture modeling using the MEGA NAF on HOPEX product, users are
encouraged to display variations. The option that allows users to display and use
variations is deactivated by default. 
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To activate the variation option:
 In the MEGA menu select Options > Business Process and 

Architecture Modeling > Activate variations.

Services and interconnections

The MEGA Suite for DoDAF 2 approach is based on the following MEGA concepts:
• Interaction, that represents the requests for services between the 

components.
 An interaction represents a contract established in a specific 
context between autonomous entities that are internal or external to an 
enterprise. These entities can be enterprise org-units, applications, 
activities or processes, as well as external org-units. The content of this 
contract is described by an exchange contract.

• Service Definition, that describes the content of an interaction.

 A service definition is a model of a contract between organizational 
entities. This contract is described by exchanges between an initiator 
role and one or several contributor roles.

In the MEGA Suite for DoDAF 2 navigation tree, the Services Viewpoint is splitted
into:

• the Operational Service Viewpoint,
• the System Service Viewpoint.
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IMPORTING SOLUTION PACKS

As a standard the MEGA Suite for DoDAF 2 is delivered with certain solution packs
that can be imported to enhance the architecture descriptions and analyses. 

Preparing Files for Import

The DoDAF 2 solution packs are delivered in compressed files and must be
decompressed before they can be imported into a repository.

Three compressed files provide the DoDAF 2 solution packs:
• DoDAF2 (DoDAF2.exe): contains the "Metamodel Customization" 

(metamodel renaming), "Sample" and "Data" solution packs.
• Mega Architecture (Mega.exe): contains the "Mega Architecture 

framework".
• Military Terms (Military Terms.exe): contains the Military Terms 

Dictionary.

To decompress the DoDAF 2 compressed files:
1. In your MEGA installation folder open the Utilities then the Solution 

Pack or Solution Pack.R3 folders.
2. Double-click the compressed file, for example DoDAF 2.exe.
3. In the dialog box that opens click Extract.

The dialog box closes and the solution pack files are extracted to the Solution Pack
folder.

To import a solution pack, see MEGA Administration - Supervisor > Managing
Objects > Importing Reference Frameworks in MEGA > Importing a Solution Pack.

Metamodel Customizations

The MEGA Modeling tool comes with its own set of concepts and vocabulary. To
minimize the differences between the names of concepts in this tool and in the
MEGA Suite for DoDAF 2, a solution pack can be imported into MEGA that
renames certain concepts using the DoDAF 2 vocabulary. This renaming is only done
in English. To retrieve the list of renamed terms, refer to the paragraph "MEGA
Metamodel Renaming", page 232.
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Using the Military Terms Dictionary

A dictionary is provided with the 2009 version of the MEGA Modeling suite. The
dictionary contains: 

• Over 6000 terms with their definitions. These terms are all approved by 
the Department of Defense (DoD) and some of them (approx. 50%) are 
also approved by NATO.

• Over 6000 acronyms used within the context of DoD projects.

Before you can access this dictionary from the DoDAF 2.0 navigation window you
must first import it into the MEGA interface from the MEGA Administration
application. 

After import, the DoDAF dictionary is instantly available in the DoDAF 2.0 navigation
window of the MEGA application.

MEGA Architecture Framework

The MEGA Architecture framework has been created with a list of pre-existing
artifacts and provided as an add-on.

 An artifact is any material item of a system that is neither software 
or an organizational unit (where organizations are people). Depending 
on the context and user preferences, artifacts can be represented as 
platforms, components and any physical item that occupies space and 
has attributes.

Artifacts are normally used within the context of architecture modeling to represent
all the non-human components of an architecture. This concept is usually delivered
with the MEGA Architecture product, however, it can also be useful for DoDAF
which deals to some extent with infrastructure modeling.

The MEGA Architecture framework also gives access to communication protocols
and resource architectures.

 A resource architecture is a set of material and organizational 
resources required for a system. It describes the interactions between 
components and their means of communication. It also indicates the 
service ports necessary for allowing users to connect and integrate with 
it. This architecture can be modeled in a resource architecture diargam 
and usually contains sub-architectures, equipment and human 
resources.
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To access these elements in your working repository you must import the MEGA
Architecture framework.

Viewing artifacts and resource architectures

If after importing the MEGA Architecture framework you are unable to access
artifacts and resource architectures, you will need to activate the "Business Process
and Architecture Modeling / Infrastructure Modeling post-2009 SP2" option in the
MEGA Options.

You should also ensure that you have Expert level access to the metamodel
(Options > Repository > Metamodel Acess > Expert)
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OVERVIEW OF THE MEGA SUITE FOR 
DODAF 2 APPLICATION

This guide presents how to make best use of MEGA Suite for DoDAF 2 to assure efficient
management of your modeling projects.

 "The DoDAF 2.0 Navigation Tree", page 38
 "Creating DoDAF 2 Architectures", page 41

This guide is supplemented by MEGA Common Features guide describes the basic functions
common to MEGA products and solutions.

 It can be useful to consult this guide for a general presentation of 
the interface. Procedures are described using MEGA Web Front-End 
interface.
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THE DODAF 2.0 NAVIGATION TREE

The second tool is a dedicated navigation tree. This tree shows all the architectures
contained in the MEGA repository. This is a more common tool for the MEGA
Modeling users since a large set of navigation trees are already available.

The DoDAF 2.0 navigation tree starts navigation from two points: the architectures
and the DoDAF dictionaries.

To launch the DoDAF 2.0 navigation tree:
 In the View part of the MEGA menu bar, click on the button 

corresponding to navigation trees and select DoDAF 2.0.
The DoDAF 2.0 navigation window appears in the workspace.

By default, the DoDAF 2.0 navigation window displays the repository in which the
DoDAF architectures are located. It also contains an "Architectures" folder in which
all the architectures of the current repository are located as well as a "DoDAF
Dictionaries" folder which contains the official DoDAF terms and acronyms.

The Architecture Tree

In the DoDAF 2.0 navigation window, the DoDAF architectures are found in the
"Architectures" folder. Each architecture has eight main folders each of which
corresponds to one of the eight DoDAF viewpoints:

• All Viewpoint
• Capability Viewpoint
• Data and Information Viewpoint
• Operational Viewpoint
• Operational Service Viewpoint
• Project Viewpoint
• Standards Viewpoint
• Systems Viewpoint
• System Services Viewpoint
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These folders are automatically created with architectures. When expanded, each
Viewpoint folder reveals other folders which contain items that correspond to the
models associated to the Viewpoint in question. For example, in the "All Viewpoint"
folder the AV-1 and AV-2 folders are displayed. The items of the different model
folders could include reports, documents, diagrams, etc.

The Dictionary Tree

While creating architectures, it is extremely important that consensus be made
about the terms used for any item defining the architecture. This is why the DoD
created a set of official definitions for all common terms used in the defense sector.

The MEGA Suite for DoDAF 2 is supplied with a MEGA dictionary of the official
DoDAF definitions. It contains more than 6000 terms as well as over 6000 acronyms
and abbreviations.

Viewing the terms of the DoDAF Dictionary

To view the DoD terms and acronyms contained in the MEGA dictionary:
 In the DoDAF 2.0 navigation window, expand the DoDAF Dictionaries 

folder.

The terms and acronyms are arranged in alphabetical order. Any of these definitions
can be attached to the items relating to a specific architecture.
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Viewing the terms associated to an architecture

To view the terms associated to a particular architecture:
1. In the DoDAF 2.0 navigation window, expand the architecture 

concerned.
2. Expand All Viewpoint > AV-2 Integrated Dictionary and double click 

the AV-2 Integrated Dictionary report icon.
3. In the window that opens in the workspace to the right of the navigation 

window, click AV-2 - Complete Integrated Dictionary.
4. Scroll down the list to see all the terms associated to the architecture 

with their accompanying definitions and/or comments, if they exist.

Linking terms to an architecture

To link a term to an architecture:
1. In the DoDAF 2.0 navigation window, select the architecture concerned.
2. In the MEGA menu bar, select View > Edit Windows > Properties.

The properties dialog box of the architecture appears in the frame on the
right of the workspace. 

3. Select the General tab > Definitions sub-tab.
4. In the DoDAF 2.0 navigation window, expand the folder in which the 

term to be attached is located.
5. Drag and drop the term in the Properties window of the architecture.

 The terms in the "Definition" frame are the terms that define the 
architecture. The terms in the "Related Definition" frame are the terms 
that relate to the architecture.

Ideally, you should link terms to the different items of the architecture, for example,
an operational node, service, etc.).

The procedure is the same as for adding a term to an architecture except that you
will instead add the term in the properties dialog box of the item concerned.
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CREATING DODAF 2 ARCHITECTURES

A DoDAF Architecture can be created from the different tools previously discussed
(the DoDAF 2.0 navigation tree or the MEGA Suite for DoDAF 2.0 Windows Front-
End Start page). 

To create a DoDAF architecture from the DoDAF 2.0 navigation tree:
1. Click on Architecture folder page and select New > Architecture 

Description.

2. In the dialog box that appears, enter the name of the new architecture.
3. Click OK.

The new architecture appears in the list of architectures on the start page and in the
"Architectures" folder in the DoDAF 2.0 navigation tree.

When you create a DoDAF architecture, a set of related objects are also created.
These objects are contained in a new MEGA library. The architecture itself is also
contained in this library which is used as a container for all the architecture items.
All these new objects are defined to represent a given perspective of the
architecture, for example the operational or the system perspective.

Reports are not created with each new DoDAF architecture. A command is available
on the architecture which allows you to create the desired reports for the different
DoDAF 2.0 Viewpoints.

All the objects created are transparent to the DoDAF user. They are used by the
system to group all the main items created within a given architecture. The
navigation tree and the DoDAF 2.0 Start page give direct access to these objects.

Once an architecture is created, the Viewpoints and models can be accessed via the
DoDAF 2.0 navigation tree or the DoDAF 2.0 Start page. Detailed information is
provided for each model later on in this document.

You can also set an architecture as the default architecture. In so doing, all the
objects created will be created within the context of this architecture and
consequently are contained in the library of the architecture.
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The Default Architecture

When an architecture is created, several other objects are also created. To ensure
that all these objects are taken into account in reports, they must all be enclosed
within the architecture scope.

Items created within the framework of a hierarchy are automatically retrieved from
the starting point of the hierarchy. For example, in an organizational chart, all org-
units belonging to a hierarchy are retrieved from the top level org-unit. However,
many other objects are not created within the framework of hierarchies. For
example, data flows between two operational nodes do not belong to any tree. In
this case, the MEGA Modeling tool ensures that these objects can be safely retrieved
by placing them in a MEGA library. MEGA libraries define a partition of the MEGA
repository and can be seen as boundaries for given modeling projects. If a library
has been set as the default library, all new objects are created within its boundary. 

The MEGA Suite for DoDAF 2 functions similarly, however, for the DoDAF expert
the main item is the architecture not the library. So, when creating a new
architecture a new library is automatically created which will receive all new objects.
When you set a default architecture, the corresponding library is automatically set
as the default library and so all new created objects are contained in the library of
the DoDAF architecture.

Setting the default architecture

To set an architecture as the default architecture:
1. In the DoDAF 2.0 navigation window, right-click the architecture you 

wish to set as the default architecture.
2. In the pop-up menu that appears, select Set as default.

A green check mark appears next to the name of the architecture concerned.
 You can also set the default architecture from the Home navigation 
window. In this case, right-click the library in which all data pertaining 
to your architecture is based and select Set as Default. The results are 
the same as above.
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GENERATING DODAF 2 MODELS 
DOCUMENTATION

The major purpose of the DoDAF 2 framework is to generate documentation of models of a given
architecture in a comparable format. This section details how the user can generate documentation
in relation to the expected format.

The different types of documentation that can be generated are:

 "Reports", page 44
 "Documents", page 48
 "Static Html Documentation", page 51
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REPORTS

All the documentation generated is based on the report template that corresponds
to the different DoDAF 2 models. These report templates are located in the Utilities
navigation window of the MEGA Window Front-End workspace. 

To view these templates:
 Expand the Report Templates > MEGA > DoDAF 2 folders.

The templates for the different models along with their report generators,
parameters and so on are located in the different Viewpoint folders.
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To create a new report for a given architecture, the user creates a new report
instance based on the expected model template. For example, to create an OV-1
document, a report is created from the DoDAF 2 architecture based on the OV-1
Report Template.

Depending on the model, the report template supplies one or more chapters. Each
chapter addresses a part of the expected model. The idea is to be able to build
reports with the essential information.

Several reports can be created for a given model. Each report addresses a different
subset of the architecture. This allows for generating smaller documents which are
easier to read.

From the MEGA Modeling tool desktop, reports can be used for understanding
architecture designs but also for designing architectures. In the second perspective,
the user can change the properties of the objects cited in the document since the
contextual menu is always accessible. Additional accesses are also provided
depending on the generated content. One such access is the Add button. For
example, in the AV-1 model, the properties used to generate the report are followed
by an Add button when the value is not set. This button gives access to the property
page of the appropriate object so that the user can fill in the missing information.
When you pass the mouse cursor over the word Add, a tooltip appears with the
name of the property to be updated. Add buttons are not displayed on generated
web pages or in Word documents.

It is also possible to specify two distinct reports: 
• A report for the reader and 
• A report as a working tool 

For example, in the AV-2 template a report generates the dictionary of the
commented items of a given architecture. A second report lists all the items of the
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architecture and so the designer will be able to identify the uncommented items and
add the missing information.

Creating Reports

When creating reports, you have the option of doing so for each model of the
DoDAF 2 architecture, one by one, or for all the models of the architecture at one
go.

To create a report:
1. From the DoDAF 2.0 navigation tree, expand the architecture 

concerned, as well as the Viewpoint folder containing the model for 
which the report is required.

2. Expand the model folder.
3. Right-click the Reports folder and select New > Report.

The prefix for the name of the report depends on the model associated.
For example, you will select New > AV-1 Report to create a report for
the AV-1 model.

4. In the dialog box that appears, enter the name of the report.
 A name is automatically proposed and the template on which the 
report is to be based is automatically selected.

5. Click Next.
6. If you wish to create subsets of the report, do so in the window that 

appears and click Next.
7. Verify that the type of report you wish to generate is selected and click 

Finish.
 Normally if you do not wish to add subsets to report parameters, 
click Finish in the dialog box in which you enter the name of the report.

Your report is created and appears in the DoDAF 2.0 navigation window
under the folder of the corresponding model.

8. Double-click the name of the report in the tree to open the report and 
view its contents.

 If you left the Open report at validation option checked, the 
report automatically opens when creation is complete.

Creating Reports for Complete Model Sets of An Architecture

To create all the reports for all the models of a particular Viewpoint of the
architecture:

1. In the DoDAF 2.0 navigation window, right-click the architecture 
concerned.



47

Generating DoDAF 2 Models documentation
Reports

2. In the pop-up menu that appears, select Complete Reports Set and 
select the report creation option which corresponds to the Viewpoint 
concerned, for example, "Create All Viewpoint Reports".

All the reports for the All Viewpoint models are created and appear in the
tree under the All Viewpoint folder.

3. Proceed in like manner to create all the reports for the other Viewpoints 
of the architecture.
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DOCUMENTS

To keep track of the status of reports, a report can be converted into an RTF or PDF
Document. This document is simply a format conversion of reports. Versions of the
document can be created so that evolutions of the architecture design are stored.

Converting Reports into Documents

To convert a report into a document:
1. In the DoDAF 2.0 navigation window of the MEGA tool, right-click the 

report to be converted and select New > RTF (or PDF). 

The new document is generated and opens.
2. Name and save the document in the desired location.

This documented is disconnected from MEGA.

Managing Different Versions

Converting reports into documents is quite useful if you wish to distribute generated
documents (for example, diagrams and their descriptions) to persons without
access to MEGA or if you simply want to keep different versions of the same
document.

The generated RTF or PDF document reflects the state of objects at a given moment
and can no longer be modified in MEGA as all links with MEGA are removed. To
have your document reflect modifications of the report, simply convert the report
again and save the new document.

Of course you have the option of saving each new document as a new version to
allow you to retrieve information relating to objects at a particular point in time.

The generated documents and their different versions can be added to MEGA as
external references allowing you to easily access them from the MEGA workspace.
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Adding external references

To attach a document as an external reference with MEGA Windows Front-End:
1. Right-click the element (report, architecture) to which the external 

reference is to be added and in the pop-up menu that appears, select 
Properties.

 When adding an external reference to the overall architecture itself, 
the pop-up menu is accessible immediately after right-clicking the 
architecture.

2. In the Properties dialog box that appears, select the General tab and 
the References sub-tab.

3. Click the New button and in the dialog box that appears select File > 
Next.

4. Next the "Access Path" field click the Browse button to specify the 
location of the document to be added as an external reference.

5. Click Next when you have specified this location.
The name of the document and the complete address of the document are
recapitulated in the dialog box that appears. 

6. If you are satisfied with the information in the dialog box, click Finish.
The document appears in the References sub-tab in the list of external
references. If the external reference was added to the architecture itself,
this reference also appears in the DoDAF 2.0 navigation window under the
OV-1 model as well as in the DoDAF 2 start page for this same model.

Accessing external references

You can access versions of documents saved as external references from the
Properties dialog box of the corresponding element.

To access external references:
1. In the DoDAF 2.0 navigation window, select the architecture and right-

click the element concerned.
2. In the pop-up menu that appears select Properties.
3. In the General tab, Reference sub-tab, double-click the external 

reference concerned to open it.

Using the BOOK to Organize Document Display

MEGA has introduced the Book concept which facilitates structuring the way
information is pesented.

 This function is available with HOPEX Productivity Pack only.

This concept can be used to organize your documents. For example, you could
decide to create a book which presents reports, in a particular order, in chapters
with diagrams, etc.
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For more information on books, see the MEGA Common Features user guide,
"Using Books" chapter.

Example of a Book



51

Generating DoDAF 2 Models documentation
Static Html Documentation

STATIC HTML DOCUMENTATION

The complete set of reports attached to a DoDAF 2 architecture can be exported in
a static HTML file. The advantage of this format is that it contains all the information
regarding the architecture and the hyperlink system enables navigation from item
to item. Since the documentation is in a static format, it can be compressed and
sent to other persons. A CHM file can also be generated.

The static HTML documentation is based on a web site template (called DoDAF 2).
The starting point is the DoDAF 2 Architecture. All architecture items are inserted
from this starting point.

Generating HTML Documentation

 Web sites are available with MEGA Windows Front-End only.

To create HTML documentation from a Web site template: 
1. In the MEGA workspace, select the Documentation navigation window 

tab.
 If the Documentation navigation window is not visible in the 
workspace, in the MEGA menu bar select View > Navigation 
Windows > Documentation.

2. In the Documentation navigation tree, right-click the "Web Sites" folder 
and select New > Web Site. 
The Create Web Site dialog box appears.

3. Enter the Name of the Web site.
E.g.: "Site 1".
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4. By default, the Web site is generated in the <environment 

path>\Intranet folder. To chose another folder, click . It is 
recommended that you create a sub-folder for each Web site generated, 
for example by creating folders with the same name as your Web site 
under the "Intranet" folder.

 The content of the "Intranet" folder is deleted at each generation. 
This being so, when you have obtained a satisfactory site you want to 
keep, remember to copy it to an appropriate folder. 

5. In the From Web site template list box, click the  button.
6. Select a Web site template, in this case "DoDAF2" and click Next.
7. Select the architecture on which the web site is based by clicking next to 

the term "Architectural Description" then on the arrow that appears.
8. Select the word list to view all the libraries that exist in your 

environment.

9. Select the correct architecture from the list displayed and click OK.
The name of the architecture appears in the web site creation dialog box.

10. Click Finish.

The web site is created but not generated. You must generate the Web site for
visualization.

To generate the Web site:
1. In the Documentation navigation window, right-click the site 

concerned.
2. In the pop-up menu that appears, select Generate.

A dialog boxes appear, indicating the progress of the Web site generation. 

When the Web site has been generated, a dialog box proposes opening the site. This
Web site is static.

You can access the generated Web site at any time by double clicking it in the
Documentation navigation window, Web Sites folder. 
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Contents of the Generated Web Site

The generated Web site contains different information. It displays the DoDAF 2
architecture to which the Web site corresponds. There are also different tabs which
correspond to the different Viewpoints of the architecture. These tabs give access
to the reports of each Viewpoint, as well as to the notes and external references.
There is also a generic page which displays each item of the architecture and
indexes. Access to the generic page is from the "Site Map" link.

For more information on generating Web sites, see the HOPEX Studio user guide,
"Creating a Web site" chapter.
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DODAF 2 ALL VIEWPOINT MODELS

The DoDAF All Viewpoint models that can be generated in the MEGA Suite for DoDAF 2 are the:

 "AV-1 Overview and Summary Information", page 56
 "AV-2 Integrated Dictionary", page 59
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AV-1 OVERVIEW AND SUMMARY INFORMATION

AV-1 provides executive-level summary information in a consistent form that allows
quick reference and comparison among architectures. AV-1 includes assumptions,
constraints, and limitations that may affect high-level decision processes involving
the architecture.

The information included in this chapter also includes Libraries (see "The AV-1
Library Organization Chapter", page 58) and Timelines.

A timeline is used to create one or more calendars for the overall architecture, with
dates and events that are common to everyone in the organization. These calendars
can then be linked to Master Plans of the architecture to profit from the timespots
defined in the timelines. For more information on timelines, see the MEGA IT
Planning user guide, "Describing a Master Plan" chapter, "Using Timelines"
paragraph.

See:
 "The AV-1 Overview and Summary Information Chapter", page 56
 "The AV-1 Library Organization Chapter", page 58

The AV-1 Overview and Summary Information Chapter

This chapter of the report lists all the overview information relating to the
architecture. It is based on the following structure:

• Architecture Project Identification: Identifies the name, the 
contributing projects and the architects of the architecture, as well as the 
organizations developing the architecture. It also includes the 
assumptions and constraints, identifies the approving authority and the 
completion date, and records the level of effort and costs (projected and 
actual) required to develop the architecture.

• Scope: Architecture View(s) and Product Identification: Identifies 
the viewpoints and models that have been developed and the temporal 
nature of the architecture, such as the time frame covered, whether by 
specific years or by designation such as current, target, transitional, and 
so forth. Scope also identifies the organizations that fall within the scope 
of the architecture.

• Purpose and Viewpoint: Explains the purpose and the objectives of 
the architecture, which include, for example, what the architecture will 
demonstrate, the types of analyses to be applied, the expected 
performers of the analyses, the decisions to be made on the basis of the 
analyses, the decision makers and the resulting actions. The viewpoint 
from which the architecture is developed is identified.

• Context: Describes the setting in which an architecture exists. Context 
includes things such as mission, doctrine, relevant goals and vision 
statements, operation concepts, scenarios, information assurance 
context, other threats and environmental conditions, and geographical 
areas addressed, where applicable. Context also identifies the 
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authoritative sources of the rules, criteria, and conventions that were 
followed.

• Tools and File Formats Used: Identifies the tools used to develop the 
architecture as well as the file names and formats used for the 
architecture and each product. This includes the MEGA release version 
used, the name of the environment and the name of the repository.

• Findings: States the findings and the recommendations that have been 
developed based on the architectural effort. During the course of 
developing an architecture, several versions of a product may be 
produced. An initial version may focus the effort and document its scope, 
the organization involved, and so forth. After other models within an 
architecture's scope have been developed and verified, another version 
may be produced to document adjustments to the scope and to other 
aspects of the architecture that may have been identified.

• Costing Object: This includes the cost information, such as integration 
costs, equipment costs and other costs.

If the report is generated in the MEGA Modeling tool, additional information is
inserted to help the user identify the appropriate properties to include, in order to
obtain this information in each section of the report. This additional information is
removed in generated documents and Web sites.
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Example

The figure below shows the example of an AV-1 chapter generated from the SAR
architecture sample. The chapter is generated within the MEGA Modeling tool so a
few [Add] sections were inserted to set the missing property values.

Example of the AV-1 chapter in an AV-1 report

The AV-1 Library Organization Chapter

Architectures and their data are contained in libraries. Architectures are however
dependent on each other and sometimes need to use data contained in other
architectures. As such, the libraries containing the different architectures are
connected to each other through access links that express the need for data
contained in another architecture. 

This Library organization chapter therefore shows how the library containing the
DoDAF architecture is structured hirerchically along with the other libraries that it
accesses for data.
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AV-2 INTEGRATED DICTIONARY

The AV-2 Integrated Dictionary contains definitions of terms used in architecture
descriptions. It is not necessarily a literal dictionary. It consists of textual definitions
in the form of a glossary, a repository of architecture data, and the taxonomies and
metadata (i.e., data about architecture data) of this data, including metadata for
tailored products, associated with the architecture products developed. Metadata
refers to architecture data types, which are possibly expressed in the form of a
physical schema. In this document, architecture data types are referred to as
architecture data elements.

The MEGA Modeling platform enables users to retrieve all items connected to a set
of starting items. This feature is used to automatically build the entire dictionary
from a given architecture. Three chapters are proposed in the report in relation to
each of the following situations:

• The user wants to view the commented items
• The user wants to see all items of the architecture in order to determine 

what must be commented
• The user wants to know if the architecture satisfies the requirements of 

DoDAF 2.0.

See:
 "The AV-2 Integrated Dictionary Chapter", page 59
 "The AV-2 Complete Integrated Dictionary Chapter", page 60
 "The AV-2 Regulation Compliance Chapter", page 61

The AV-2 Integrated Dictionary Chapter

This chapter addresses the reader who wants to retrieve the definitions of all the
items defined or commented within the architecture. The chapter generation starts
a search for all objects directly and indirectly connected to the analyzed
architecture. Only items with comments are considered.
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A list of these commented items is generated with their name, comment and type
(metaclass). The list is preceded by the number of commented items included.

Example of the Integrated Dictionary Chapter in the Integrated Dictionary Report

The AV-2 Complete Integrated Dictionary Chapter

The Complete Integrated Dictionary chapter is based on the same principle as the
Integrated Dictionary chapter, however, items without comments are not removed
from the list. This chapter is used on the MEGA Modeling desktop as a working tool
to develop the architecture. The goal is to help the architecture designer retrieve
the items for which comments are to be added. 

 If a report is based on the AV-2 template, it is possible that the 
Complete Integrated Dictionary report chapter will not be check-marked 
in any other context than the MEGA reporting one. To correct this, 



61

DoDAF 2 All Viewpoint Models
AV-2 Integrated Dictionary

right-click the report and in its Properties dialog box, select the 
"Report Chapters" tab and change the check-marks.

Example of the Complete Integrated Dictionary Chapter

The AV-2 Regulation Compliance Chapter

This report chapter shows to what extent architecture items are compliant with the
regulations that are specified for them. It presents the compliance information in
charts with statistics.

Three levels can be defined for the modeling rules:
• Suggestion: verification of this rule is not mandatory. As such, this rule 

only applies in the rules application report.
• Recommendation: this rule must be respected. If not an alert 

(warning) will be displayed.
• Requirement: this rule must be respected. If not an error signal will be 

displayed.
 Rules of the "Suggestion" level are not taken into account for object 
validity definition. They therefore have no influence on the Fstate 
indicator shown in diagrams or navigators.

Understanding the statistic results

When the compliance of an object with a particular rule has been checked and the
object complies with the rule, the status is marked as OK. If the object does not
comply with a particular rule, it takes the rule level that has been defined for the
rule (suggestion, recommendation or requirement).
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An assessment is then carried out on the object with all the rules that are attached
to it.

• If the object does not comply with at least one "requirement" rule, the 
object is given the Failure status.

• If the object complies with all its set "requirement" rules and does not 
comply with at least one "recommendation" rule, it is given the 
Recommendation status.

• If the object complies with all its set "requirement" and 
"recommendation" rules but does not comply with at least one 
"suggestion" rule, it is given the Suggestion status.

• If the object complies with all its set rules, it is given the OK status.

The AV-2 Regulation Compliance chapter begins with an overview of the level of
compliance of architecture items with the regulation rules.

This section displays the following statistics:
• The global percentage of object compliance. Depending on the 

percentage value a colored square indicates the degree of compliance 
• The number of objects checked
• A pie chart with the status percentages: OK, Suggestion, 

Recommendation, Failure
• A table with the number and percentage of objects with the different rule 

compliance statuses.
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The next section details the level of compliance for the different types of
architecture objects. 



64 MEGA Suite for DoDAF 2

4

The final section of the chapter is a table which gives details about the architecture
items that do not have the OK status.
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DODAF 2 CAPABILITY VIEWPOINT MODELS

The DoDAF 2.0 Capability Viewpoint models that can be generated in the MEGA Suite for DoDAF
2 are the:

 "CV-1 Vision", page 66
 "CV-2 Capability Taxonomy", page 70
 "CV-3 Capability Phasing", page 75
 "CV-4 Capability Dependencies", page 80
 "CV-5 Capability to Organizational Deployment Mapping", page 86
 "CV-6 Capability to Operational Activities Mapping", page 88
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CV-1 VISION

The purpose of a CV-1 is to provide a strategic context for the capabilities described
in the architecture. It also provides a high-level scope for the architecture which is
more general than the scenario-based scope defined in OV-1.

A CV-1 Vision model begins with a description of the high-level concept. This
concept will then be further augmented by describing the high-level operational
goals and strategy in military capability terms. As a general rule, the CV-1 model is
not intended to specify system requirements or user requirements. Instead, its role
is to set the scope for the architecture in terms of future or current military
capability vision. The CV-1 model is high-level in nature and does not specify the
success criteria for an architecture. CV-2 provides metrics against each capability
which may be used to successfully measure fielded capabilities.

The main items dealt with in this model are goals/objectives and the enterprise
vision.

The enterprise vision describes the overall aims of an enterprise over a given period
of time. This can be supported by a master plan in which the evolutions that help to
achieve the overall objectives of the enterprise are described. The selected master
plan is then used to describe capability availability and show the associations
between enterprise phases and capabilities.

Goals can be described through the MEGA objective notion. The objective items are
then attached to the enterprise vision (strategic master plan) as achieved
objectives.

The Strategic Master Plans are located in the Enterprise Vision folder of the CV-1
Vision model and the objectives are located in the Enterprise Goals folder.

For each notion introduced in the CV-1 model (objective, strategic master plan),
there is a dictionary and a hierarchical report. Each report gives details through the
potential describing diagrams.

See:
 "The CV-1 Report Template", page 66
 "The CV-1 Enterprise Vision Chapter", page 67
 "The CV-1 Enterprise Vision Details Chapter", page 68
 "The CV-1 Enterprise Goal Hierarchy Chapter", page 68
 "The CV-1 Enterprise Goal Dictionary Chapter", page 69

The CV-1 Report Template

The CV-1 report template comes with three parameters.
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Master Plan Subset, which is an optional parameter. This parameter 

is used to reduce the scope of the study to a subset of the selected 
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Master Plans. If this parameter is not set, all the Strategic Master Plans 
are taken into account.

• The Objective Subset is an optional parameter. You can limit the scope of 
the study to a subset of the selected objectives by setting one or more 
objectives. All the objectives of the architecture are used in the study if 
this parameter is not set.

The CV-1 Enterprise Vision Chapter

This chapter shows the details of the Strategic Master plan in the form of a Gantt
Chart.

The data of the Gantt Chart can be modified in the report. For more information on
creating Master Plans, see CV-3.

Example of theCV-1 Enterprise Vision Chapter
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The CV-1 Enterprise Vision Details Chapter

This chapter displays the conflicts of the strategic Master Plans. 

Example of the CV-1 Enterprise Vision Details Chapter

The CV-1 Enterprise Goal Hierarchy Chapter

This chapter shows the hierarchy of the objectives of the architecture. 

Example of the CV-1 Enterprise Goal HIerarchy Chapter
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The CV-1 Enterprise Goal Dictionary Chapter

The Enterprise Goal Dictionary chapter presents a list of the objectives used in the
report. A paragraph is dedicated to each objective. This paragraph contains the long
and short name of the objective as well as its comment. For each objective, a table
is presented with the name of the milestone to which this objective is attached, in
other words where in the plan the objective is to be met.

Example of the CV-1 Enterprise Goal Dictionary Chapter
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CV-2 CAPABILITY TAXONOMY

The CV-2 model provides a structured list of the capabilities and sub-capabilities
required for the vision established in the CV-1 model. This list of capabilities is to be
delivered for a particular timeframe. It has a hierarchical structure where
capabilities are sometimes subdivided into sub capabilities and/or functions in order
to provide clarity and the appropriate level of granularity required by subsequent
processes in the capability management process.

See:
 "The CV-2 Report Template", page 70
 "The CV-2 Capability Composition Hierarchy Chapter", page 70
 "The CV-2 Capability Specialization Hierarchy Chapter", page 71
 "The CV-2 Capability Generalization Hierarchy Chapter", page 72
 "The CV-2 Capability Dictionary Chapter", page 72

The CV-2 Report Template

The CV-2 report template comes with two parameters:
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Capabilities parameter, which is an optional parameter. You can limit 

the scope of the study to a selection of capabilities by setting one or 
more capabilities. All the capabilities of the architecture are used in the 
study if this parameter is not set.

The CV-2 Capability Composition Hierarchy Chapter

This chapter gives the structure of a set of capabilities. It can be used as a source
document to develop high-level use cases and user requirements.
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The information in the chapter is presented in diagram form, if the corresponding
diagram exists, as well as in table form, with comments for the capabilities.

Example of the Capability Composition Hierarchy Chapter

The CV-2 Capability Specialization Hierarchy Chapter

The CV-2 capability specialization hierarchy chapter shows how the capability
hierarchies of the architecture are specialized. 

The varied capabilities are presented in a table along with their variants. The
libraries to which the capability belongs as well as the comments of these objects
are also indicated.

To create new specializations (variants), use the New > Variant command on the
capability to be varied (specialized).
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The CV-2 Capability Generalization Hierarchy Chapter

The CV-2 capability generalization hierarchy chapter shows how the capability
hierarchies of the architecture are generalized. 

The variants of capabilities are presented in table form along with the varied
capabilities (capability from which the variant was created). The comments and
library to which the capability belong are also presented.

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).

The CV-2 Capability Dictionary Chapter

The Capability Dictionary chapter lists all the capabilities required for the CV-1 with
their type and definition. 
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This chapter is divided into several sections :
• The first section consists of a list of all the capabilities included in the 

architecture, with their short name, long name and a comment/ 
definition.

• The second section is dedicated to the root capabilities.
• For each Root capability, a table is provided with a list of the sub-

capabilities and their definitions. The diagrams of the root capabilities 
are also provided.
The possible diagrams are:
• Capability Tree diagram
• Capability structure diagram

Example of the Capability Dictionary Chapter
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Example of a Capability Dictionary Chapter with Diagram
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CV-3 CAPABILITY PHASING

The CV-3 model indicates the planned or available capabilities at different points in
time or during specific time periods (states). This is capability phasing. The different
capability time periods (states) are indicated and are associated with milestones.
This model is created through an analysis of programmatic and deployment data in
order to determine when system elements from capabilities are to be deployed,
upgraded and/or retired. This data may be provided in part by the Project to
Capability Mapping (PV-3) model. The systems identified are structured according
to the required capabilities determined in the Capability Taxonomy (CV-2) model
and the associated timeframes. The projects that can deliver the capabilities within
the slated time periods and states are also indicated.

The availability of capabilities at specific times and the deliverables expected can be
demonstrated in Master plans, which in the context of information system planning,
can be used to define the evolutions of the system that best respond to business
function demands. The resource architectures/systems put in place to support the
capabilities (capability configuration) are also demonstrated in Master plans.
Capability configurations are created in the SV-1 model.

Master plans are expected to not only show planned elements at different
successive levels and states , but also to provide information on functional suitability
of evolutions related to business function expectations, and the impact of the of this
Master plan implementation.

The Master Plans used for the CV-3 Capability Phasing report are found in the SV-8
model.

See:
 "The CV-3 Report Template", page 75
 "The CV-3 Capability Configuration Composition Hierarchy Chapter", page 76
 "The CV-3 Capability Configuration Specialization Hierarchy Chapter", page 76
 "The CV-3 Capability Configuration Generalization Hierarchy Chapter", page 77
 "The CV-3 Capability Configuration Dictionary Chapter", page 77
 "The CV-3 Capability Phasing Chapter", page 78

The CV-3 Report Template

The CV-3 report template comes with three parameters:
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Capability Configurations Subset is an optional parameter. You can 

limit the scope of the study to a subset of the selected capability 
configurations by setting one or more capability configurations. All the 
capability configurations of the architecture are used in the study if this 
parameter is not set.

• The Master Plans Subset, which is an optional parameter. This parameter 
is used to reduce the scope of the study to a subset of the selected 
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Master Plans. If this parameter is not set, all the Strategic Master Plans 
are taken into account.

The CV-3 Capability Configuration Composition Hierarchy Chapter

The capability configuration composition hierarchy chapter presents in tabular form,
the elements to be deployed to fulfill certain capability functions. These elements
are presented in relation to the hierarchy of the systems that support the
capabilities.

Example of the Capability Configuration Composition Hierarchy Chapter

The CV-3 Capability Configuration Specialization Hierarchy Chapter

The CV-3 capability configuration specialization hierarchy shows how the capabiltiy
configurations of the architecture are specialized. 



77

DoDAF 2 Capability Viewpoint Models
CV-3 Capability Phasing

The varied capability configuration are presented in a table along with their variants.
The libraries to which the capability configuration belong as well as the comments
of these objects are also indicated.

To create new specializations (variants), use the New > Variant command on the
capability configuration to be varied (specialized).

The CV-3 Capability Configuration Generalization Hierarchy 
Chapter

The CV-3 capability configuration generalization hierarchy shows how the capability
configurations of the architecture are generalized. 

The variants of capability configurations are presented in table form along with the
varied capability configurations (capability configuration from which the variant was
created). The comments and library to which the capability configurations belong
are also presented.

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).

The CV-3 Capability Configuration Dictionary Chapter

The CV-3 Capability Configuration Dictionary lists all the capability configurations
with their definitions. This list is then followed by a dedicated section for each
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configuration which includes the diagram describing the configuration and the list of
configured capabilities in the configuration.

Example of a Capability Configuraton Dictionary Chapter

The CV-3 Capability Phasing Chapter

The Capability Phasing chapter presents a gantt chart. This chart shows in what way
projects, through their deliverables, contribute to implementing the resource
architectures that will support the capabilities. The rows represent the capabilities
(derived from the CV-2 Capability Taxonomy model) and columns represent the
phases defined in the Solution Master Plan.



79

DoDAF 2 Capability Viewpoint Models
CV-3 Capability Phasing

The capability phasing chapter details the availability of the systems that support
the capabilities of the architecture. These systems represent the resource
architectures defined in the SV-1 model and attached to the capability to create the
capability configuration. Information displayed also include the projects that can
contribute to delivering the systems, and the state (time period) of the expected
capabilities for each milestone. A matrix with the retrieved projects, their
deliverables and the time period (states) in which they are expected can be viewed
in the PV-3 Project to Capability Mapping model. These The projects retrieved are
defined with their deliverables in the PV-1 model while the states of the expected
capabilities are defined in SV-10b.

Example of a Capability Phasing Chapter

In the Capability Phasing chapter above, the SAR (Search and Rescue) capability is
covered by four different states, three of which have been detailed; "Maritime SAR
Configuration [Adhoc Rescue]", "Maritime SAR Configuration [Advances Search and
Rescue], "Maritime SAR Configuration [Full Search, Rescue and Assistance]". At the
Maritime SAR Configuration [Adhoc Rescue] state, the systems available to support
the capability are represented by the Maritime Unit in Distress and RNLI Lifeboat
Unit resource architectures. The names of the two projects contribute to
implementing the capability during this state; "Rescue Unit Training" and "Develop
Maritime Assistance".
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CV-4 CAPABILITY DEPENDENCIES

The CV-4 model shows the dependencies between capabilities (or capability
functions) which are of interest to the architecture and groups these capabilities into
logical groupings based on the need for these elements to be integrated. These
groupings are used to inform the acquisition process and the Capability Phasing
(CV-3) model.

See:
 "The CV-4 Report Template", page 80
 "The CV-4 Capability Dependency Dictionary Chapter", page 80
 "The CV-4 Capability x Capability Matrix Chapter", page 81

The CV-4 Report Template

The CV-4 report template comes with three parameters:
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Capabilities parameter, which is an optional parameter. You can limit 

the scope of the study to a selection of capabilities by setting one or 
more capabilities. All the capabilities of the architecture are used in the 
study if this parameter is not set.

• Capability Dependency parameter, which is another optional parameter. 
This parameter is used to reduce the scope of the study to the selected 
capability dependencies. If this parameter is not set, all the fcapability 
dependencies of the architecture are taken into account.

• Column Capabilities parameter. This is also an optional parameter. This 
parameter enables the creation of a table with different sets of 
capabilities for rows and for columns.

The CV-4 Capability Dependency Dictionary Chapter

The Capability Dependency Dictionary chapter lists in alphabetical order the
dependencies established between capabilities of the architecture. These
dependencies are set within the context of an upper capability so that sub-
capabilities can be dependent in one context but independent in another. lists the
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capability dependencies of the architecture. Each capability dependency is described
with a list of its dependent and required capabilities.

Example of a Capability Dependency Dictionary

The CV-4 Capability x Capability Matrix Chapter

The Capability x Capability Matrix chapter provides a table which shows the
dependencies that exist between different capabilities. Dependencies are
represented by checkmarks. A checkmark appears in the table between two
capabilities that are referenced by at least two capability compositions that are
linked by a capability dependency.
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Checkmarks cannot be added to or removed from the matrix as they are
aggregations of capability dependencies.

Example of a Capability X Capability Matrix

Accessing the diagram that contains a dependency

To access the Capability Structure Diagram that contain a dependency:
1. Unfold the CV-4 Capability Dependencies folder and right-click the 

dependency whose diagram you want to access.
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2. In the pop-up menu that appears, select Diagrams Containing Object.
An miniature of a Capability structure diagram containing the dependency
appears.
A flashing square indicates the location of the dependency in the diagram.

3. Open the diagram by clicking the Edit this Diagram button, at the top 
of the image.
The diagram opens in the workspace.

Creating dependencies

Dependencies are defined within the context of an upper capability. They are
created in Capability Structure Diagrams and linked to capability compositions.

To create a dependency:
1. Create or open an already existing Capability structure diagram.

 In the navigation tree, capabilities are found under the CV-2 
capability taxonomy folder.
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2. In the object toolbar, select the Capability Dependency icon and draw 
the dependency from the source capability composition to the target 
capability composition.

 The target capability composition is dependent on the source 
capability composition.

Example of a capability structure diagram with a dependency

The name of the dependency is a combination of the name of the upper capability
and those of the source and target capabilities of the dependency.

For example, in the diagram above, the name of the dependency is "Monitoring
[Detection -> Observation]". 

It is, however, possible to have more than one source or target capability. This could
be a case where a capability composition is included in several dependencies in the
same structure diagram or where a composition is part of dependencies in different
structure diagrams. Whatever the case, the naming rule is the same.

 The generation of dependency names is automatic and these 
names cannot be changed by the user.

Example of multiple source dependency
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In the DoDAF 2.0 navigation tree, dependencies are located in the CV-4 Capability
Dependencies folder, Capability Dependencies subfolder.

Example of dependencies in the DoDAF 2.0 navigation tree
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CV-5 CAPABILITY TO ORGANIZATIONAL DEPLOYMENT 

MAPPING

The CV-5 capability to organizational deployment mapping model describes the
mapping between capabilities and the existing or planned resources (systems) that
enable these capabilities during a particular time frame.

The information used to create the CV-5 model is drawn from other models (CV-2,
CV-4, OV-2, SV-3, PV-2, etc), and includes capabilities, system connectivity,
organizational structures, and programmatic information.

See:
 "The CV-5 Report Template", page 86
 "The CV-5 Capability to Organizational Deployment Mapping Chapter", page 86

The CV-5 Report Template

The CV-5 report template comes with two parameters:
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Subset parameter, which is optional. This parameter can be set with 

a subset of the projects in the PV-1 model and the resource architectures 
of the architecture. If this parameter is not set, all the projects and 
resource arhitectures of the architecture are taken into account.

The CV-5 Capability to Organizational Deployment Mapping 
Chapter

This chapter contains a matrix with resource architectures in columns and projects
in rows. The projects are displayed with their start and end dates. These projects
match the time period that the organization is slated to use in the resource
architecture.

For each resource architecture-project couple, a checkmark is displayed if a link
already exists.
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You can click in the matrix to add or remove checkmarks.

Example of the CV-5 Capability to Organizational Deployment Mapping Chapter
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CV-6 CAPABILITY TO OPERATIONAL ACTIVITIES MAPPING

The CV-6 Capability to Operational Activities Mapping model describes the mappings
that exist between capabilities and the operational activities that they support. 

This model is used to show which capabilities support which operational activities.
It can also be used to show which capabilities are supported (or not), to reveal gaps
in service provisions as well as to see if there are any redundancies, where a
capability is supported by more than one operational activity.

See:
 "The CV-6 Report Template", page 88
 "The CV-6 Capability to Operational Activities Mapping Chapter", page 88

The CV-6 Report Template

The CV-6 report template comes with three parameters:
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Capability Subset is an optional parameter. You can limit the scope of 

the study to a subset of the selected capabilities by setting one or more 
capabilities. All the capabilities of the architecture are used in the study if 
this parameter is not set.

• The Operational Activity Subset parameter, which is an optional 
parameter. This parameter is used to reduce the scope of the study to a 
subset of the selected functional activities and/ or functional processes. 
If this parameter is not set, all the functional activities and functional 
proceses of the architecture are taken into account.

The CV-6 Capability to Operational Activities Mapping Chapter

The Capability to Operational Activities Matrix chapter provides a table which shows
the capabilities that support selected operational (functional) activities and
functional processes. This support is represented by checkmarks. A checkmark
appears in the table between an operational activity or functional process and the
capability that supports it.

You can click in the matrix to add or remove checkmarks.
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When links exists a "+" appears under the checkmark. If you click on this "+" a table
appears with the type of link created, and the object type and objects that are
linked. 

Example of a CV-6 Capability to Operational Activities Mapping Matrix
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DODAF 2 DATA AND INFORMATION 
VIEWPOINT MODELS

The DoDAF 2.0 Data and Information Viewpoint models that can be generated in the MEGA Suite
for DoDAF 2 are the:

 "DIV-1 Conceptual Data Model", page 92
 "DIV-2 Logical data Model", page 94
 "DIV-3 Physical Data Model", page 95
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DIV-1 CONCEPTUAL DATA MODEL

DIV-1 describes the structure of an architecture domain's system data types and the
structural business process rules (defined in the architecture's OV models) that
govern the system data. It provides a definition of architecture domain data types,
their attributes or characteristics, and their interrelationships.

See:
 "Creating Data Models", page 92
 "The DIV-1 Report Template", page 93
 "The DIV-1 Conceptual Data Model Hierarchy Chapter", page 93
 "The DIV-1 Conceptual Data Model Chapter", page 93

Creating Data Models

The MEGA Suite for DoDAF 2 can be used to design data models. The data model
is a concept that can be graphically designed in Data model diagrams. The user
creates new data models from the DoDAF 2.0 start page or navigation tree.

The data models are described by one or more data model diagrams, which contain
entities with their attributes and the associations between the entities.

Example of a data model

The entities should correlate with the OV-3 information elements. These elements
are modeled with the MEGA content objects and the content can be linked to a data
model.

An information model should be based on the AV-2 model, which actually forms the
operational domain object model and which contains the definitions of all the
concepts that are relevant for the architecture effort. In turn, DIV-1 should be used
as an input to DIV-2 and DIV-3, which capture logical and physical data models.
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The DIV-1 Report Template

The DIV-1 report template is delivered with a report that describes data models.

The first parameter in this template is used to indicate the architecture to be
analyzed.

The second parameter, Data Model Subset, is optional and is used to reduce the
scope of the study to a subset of the data models of the architecture. If this
parameter is not set, all the data models defined within the architecture are taken
into account.

The DIV-1 Conceptual Data Model Hierarchy Chapter

This chapter presents in table form the hierarchy of all the data models of the
architecture. A comment or definition is also displayed for the different data models.

The DIV-1 Conceptual Data Model Chapter

This chapter lists all the selected data models in a table with their short name, long
name and comment.

Paragraphs specific to each data model are then displayed. These paragraphs
contain the following items:

• The comment
• The describing diagrams
• The table of the entities with the attributes
• The list of associations linking the entities
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DIV-2 LOGICAL DATA MODEL

The purpose of data models is to enable the analysis, design and implementation of
the data presentation, handling and storage functionality of an information system.
A data model is the representation of an information model in a form that is specific
to a particular paradigm or theory on the representation, storage and handling of
data, often reflecting a certain type of data store or repository technology. Data
models are often distinguished as logical or physical data models. 

The Logical Data Model is a generalized formal structure in computer science. As
such it directly reflects the paradigm or theory oriented mapping from the
information model to the data model. 

The Logical Data Model enables the analysis of a system’s data definition aspect,
without any consideration of implementation specific or product specific issues. It is
also used to provide a common dictionary of data definitions to consistently express
models wherever logical-level data elements are included in the descriptions. 

See:
 "The DIV-2 Report Template", page 94
 "The DIV-2 Logical Data Model Chapter", page 94
 "The DIV-2 Logical Data Model Hierarchy Chapter", page 94

The DIV-2 Report Template

The DIV-2 report template uses two parameters:
• The Architecture parameter, which indicates the architecture to be 

analyzed.
• The Data Model Subset parameter, which is optional. This parameter is 

used to reduce the scope of the study to a subset of the data models 
defined in the architecture. If this parameter is not set, all the data 
models defined in the architecture are taken into account.

The DIV-2 Logical Data Model Hierarchy Chapter

The Logical Data Model Hierarchy chapter provides the hierarchy structure of the
logical data models of the architecture.

The DIV-2 Logical Data Model Chapter

The DIV-2 logical data model chapter lists the operational data models of the
architecture. Each data model is listed with its entities and attributes and the
associations between the entities.
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DIV-3 PHYSICAL DATA MODEL

The Physical data model is used for the analysis of a system’s data implementation
aspect, with consideration for a specific product. They can also be used to:

• Provide as much detail as possible on the data elements exchanged 
between systems to reduce the risk of interoperability problems.

• Provide the data structures for use in the system design process, if 
necessary.

• Provide a common dictionary of data implementation elements (e.g. 
tables and records in a relational database schema) to consistently 
express models wherever physical-level data elements are included in 
the descriptions.

The physical data model specifies how the logical data model will be instantiated in
a particular product. The most predominant of such products are the relational
database management systems, such as those supplied by Oracle and Microsoft (in
which case the physical data model is often called a ’database schema’). Object
repository products also exist, but are less often encountered. 

The essential elements of a physical data model (in the case of a relational
database) are: tables, records and keys. In a true object-oriented data model, all
data elements are expressed as objects; whether they are classes, instances,
attributes, relationships, or events.

The DIV-3 Report Template

The DIV-3 report template uses two parameters:
• The Architecture parameter, which identifies the architecture to be 

analyzed.
• The Database Subset parameter, which is optional. This parameter is 

used to reduce the scope of the study to a subset of the databases 
defined in the architecture. If this parameter is not set, all the databases 
defined in the architecture are taken into account.

The DIV-3 Physical Data Model Chapter

The Physical Data Model chapter lists the databases modeled to support the storage
of data with their tables and column details.
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A database table is first displayed with the short name, long name and comment of
each database.

• A paragraph is dedicated to each database. This paragraph includes:
• The comment of the database.
• The diagrams describing the databases.
• The associated data models.
• The list of tables contained in the databases. This list is a table with the 

short name, the long name and the comment of each table contained in 
the database.

The database paragraphs are followed by the table paragraphs. Each table which
has one of the following items is inserted in a dedicated paragraph with:

• The comment of the table.
• The list of columns (name and comment).
• The list of indexes (name and comment).
• The list of keys (name and comment).
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DODAF 2 OPERATIONAL VIEWPOINT 
MODELS

The DoDAF 2.0 Operational Viewpoint models that can be generated in the MEGA Suite for DoDAF
2 are the:

 "OV-1 High-Level Operational Concept Graphic", page 98
 "OV-2 Operational Resource Flow Description", page 101
 "OV-3 Operational Resource Flow Matrix", page 112
 "OV-4 Organizational Relationships Chart", page 116
 "OV-5a Operational Activity Decomposition Tree", page 125
 "OV-5b Operational Activity Model", page 127
 "OV-6a Operational Rules Model", page 134
 "OV-6b Operational State Transition Description", page 137
 "OV-6c Operational Event-Trace Description", page 141
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OV-1 HIGH-LEVEL OPERATIONAL CONCEPT GRAPHIC

OV-1 is used to depict the "big picture" of the operational context of the
architecture. It describes capability and highlights the main operational nodes (see
OV-2 definition) and interesting or unique aspects of operations. It provides a
description of the interactions between the subject architecture and its
environment, and between the architecture and external systems. A textual
description accompanying the graphic is crucial. Graphics alone are not sufficient for
capturing the necessary architecture data.

This model addresses people wanting to have a general understanding of the
architecture but who have no experience in modeling or architecture methods. The
aim is therefore to be able to transfer the main purpose of the architecture without
the need for a formal description. This is why this first level of architecture
explanation uses free-form diagrams, external documents and notes and not formal
models. Even though diagrams used to describe OV-1 contain no particular type of
picture, MEGA objects can be inserted so that repository features such as name
consistency and hyperlinks are available.

Another source of general information is the repository items cited in the texts of
the architecture. Dropping any item in an object text automatically creates a link
between the referencing object and the cited item. The list of all cited items can then
be used as starting points to a deeper study of the architecture. This list only
contains the cited objects and users cannot directly insert new items. It is therefore
read-only.

See:
 "The OV-1 Report Template", page 98
 "The OV-1 High-Level Operational Concept Description Chapter", page 98

The OV-1 Report Template

The OV-1 report template is supplied with one parameter: the architecture to be
analyzed. There are no additional parameters.

The OV-1 High-Level Operational Concept Description Chapter

This chapter gives access to all the general documentation regarding the
architecture.

First, the chapter shows the "High-Level Operational Graphic" diagram, which gives
a general understanding of the architecture.

The diagram is followed by a list of all notes linked to the architecture, then a table
with the external references linked to the architecture. Depending on the report
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format the external references are displayed as a hyperlink (HTML) or a name with
the complete address of the external document.

 When external references are added to the "High-Level Graphic" 
diagram (Library diagram in MEGA terminology), they are not 
automatically linked to the architecture. This is so because in MEGA 
external references can be added to any diagram, diagrams which are 
not necessarily linked to architectures. To ensure that external 
references are linked to an architecture, this link must be made from 
the Properties dialog box, General tab, References sub-tab of the 
architecture in the DoDAF 2.0 navigation window or the DoDAF 2.0 start 
page. The external references then appear under the architecture in the 
DoDAF 2.0 navigation window and the DoDAF 2.0 start page.

A table of the cited items is also inserted in the chapter with their name, type and
comment.

The figure below shows an example of a Library diagram which includes JPEG
images and vector shapes. This is a MEGA diagram so it can also include MEGA
objects allowing access to detailed definitions.

Example of an OV-1 Library Diagram
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The OV-1 Conditions Dictionary Chapter

Conditions (environments) are used to define certain properties (such as
temperature, place, colour, etc.) that the objects to which they are linked, must
respect. 

This chapter lists the conditions (environments) of the architecture retrieved during
the report generation.

A paragraph dedicated to each condition (environment) follows with the object
defined by the condition. The properties of the conditions (environments) are
presented in a table with their name, property type and property value, their unit
and a comment.
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OV-2 OPERATIONAL RESOURCE FLOW DESCRIPTION

OV-2 graphically depicts the operational nodes (or organizations) with needlines
between the nodes that indicate a need to exchange information. The graphic
includes internal operational nodes (internal to the architecture) as well as external
nodes.

OV-2 is intended to track the need to exchange information from specific operational
nodes (that play a key role in the architecture) to others. OV-2 does not depict the
connectivity between nodes.

See:
 "Creating Operational Nodes", page 101
 "Creating Operational Node Structure Diagrams", page 102
 "The OV-2 Report Template", page 105
 "The OV-2 Operational Node Composition Hierarchy Chapter", page 106
 "The OV-2 Operational Node Specialization Hierarchy Chapter", page 106
 "The OV-2 Operational Node Generalization Hierarchy Chapter", page 107
 "The OV-2 Operational Node Dictionary Chapter", page 107
 "The OV-2 Operational Node Exchange Chapter", page 108
 "The OV-2 Operational Node Exchange Balance Chapter", page 109
 "The OV-2 Operational Node Exchange Compliance Chapter", page 109
 "The OV-2 Operational Node Realization Chapter", page 111

Creating Operational Nodes

Creating operational nodes is quite simple. This can be done from the navigation
tree as well as from the MEGA Suite for DoDAF 2 start page.

To create an operational node from the start page:
1. In the Architectures frame of the start page, click the name of the 

architecture concerned.
2. In the Viewpoints frame, click Operational Viewpoint > OV-2.
3. The operational nodes available for the operational viewpoint appear in 

the Root Operational Nodes (EAF) tab in the right frame of the start 
page.

4. Click the New icon  and in the dialog box that appears enter the 
name of the operational node.

5. Click OK.

The new operational node appears in the list in the Root Operational Nodes tab
as well as in the DoDAF 2.0 navigation tree along with the other operational nodes
for the architecture (DoDAF 2.0 > Architectures > Architecture concerned >
Operational Viewpoint > OV-2 - Operational Resource Flow Description >
...).
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Operational nodes can also be initially created in the operational node structure
diagram.

Creating Operational Node Structure Diagrams

After creating your operational nodes the need for information exchange between
operational nodes can be illustrated in the Operational Node Structure Diagram.
This information exchange is represented by interactions created between the
nodes. The diagram therefore shows how operational nodes and interactions
interact with each other.

An Operational Node Structure Diagram actually details the structure of an
operational node. The node is composed of sub-nodes that are connected to each
other through interactions. The described node establishes a context for the
interactions. For this reason sub-nodes are not directly connected in the diagram.
As sub-nodes can be reused in other contexts the interactions link the intermediate
objects that reference the sub-nodes and that are defined locally within the context
of the node. In this way you can differentiate the interactions performed in one node
context from those performed in another node context. This principle is replicated
in all structure diagrams and is further detailed in the Artifact Type and Instance
technical article. In the case of operational nodes, the intermediate objects are
called Operational Components. If no name is set for an operational component, a
name is automatically created from the referenced operational node.

To create an operational node structure diagram:
1. In the Architectures frame of the DoDAF 2.0 start page, click the name 

of the architecture concerned.
2. In the Viewpoints frame, click Operational Views > OV-2.
3. Select the All Operational Nodes (EAF) tab in the right frame of the 

start page.
4. Right-click the operational node concerned and select New > Diagram.
5. Select Operational Node Structure Diagram and click Create.

The new diagram opens in the MEGA workspace with a Root Operational
Node positioned in it.

Adding operational nodes to the diagram

Operational nodes in the Structure diagram are referred to as operational
components.

To add an operational component to the diagram: 

1. Click the Operational Component icon  in the object bar and click 
in the diagram.

2. In the Creation of Operational Component dialog box that appears, if 
you so desire, enter the name of the operational node.

 You do not have to enter a component name as the name of the 
operational node that is used for the component is automatically 
displayed in the structure diagram. The operational node name replaces 
the name entered in the Operational component name field.
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3. Click the arrow to the right of the "Operational Node Used" field and 
select Connect Operational Nodes to find an operational node that 
already exists.

 If the operational node to be used does not exist, you can create it 
by selecting Create Operational Node.

4. Select the operational node you want to use
Its name appears in the creation dialog box.

5. Click OK.
The new operational node appears in the diagram.

6. Repeat this step to create as many operational nodes as necessary.

Adding interactions to operational nodes

After creating your operational nodes you can display the interactions between
them. Interactions describe the information that can be exchanged between two
nodes. An interaction links two interacting items and is based on a definition (a
service definition or a protocol): this definition can be detailed later on in the SvcV-
2 model. The definition is used to accurately describe the information exchanged
between the two nodes, the roles played by the two nodes (customer or provider)
and the service and request points  to which the interaction is connected. Service
and request points are explained in the paragraph below.

All the structure diagrams (operational node, resource architecture or artifact
assembly in SV-1) are based on the same interaction principle. For more details on
the interaction models, see the Interaction Modeling technical article..

To add an interaction to operational nodes:
1. In the object bar of the diagram, click the Interaction button.
2. Click the first operational node to be connected and holding down the 

mouse button, drag the cursor to the second operational node and 
release the mouse button.

 The line should always be drawn in the direction in which you want 
the interaction information to flow.

3. In the Creation Interaction dialog box that appears select an existing 
Service Definition from the list.

 It is not necessary to enter an interaction name. If an interaction 
name is not entered, the interaction will automatically inherit the name 
of its Service Definition.
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4. Click OK.
A line representing the interaction appears in the diagram between the
operational nodes.

Below is an example of an operational node structure diagram. The operational
nodes are represented by yellow rectangles.

Example of an Operational Node Structure Diagram

Adding Service and Request Points to Operational Nodes

Interaction with an operational node can be made through interaction points.
Interaction points are ports for information exchanges. When a node is used as a
sub-node in an operational structure, it can interact with another node through
these interaction points. In relation to the information in his possession, the
designer of the structure can describe the interactions between two sub-nodes and
specify the points of these sub-nodes that the interaction uses to exchange the
information. 

There are two kinds of interaction points: service point and request point. The
service point is used to interact with the node that is considered to be the provider
of the information exchanged. In this case, the interacting item at the other end of
the interaction is the requester of the information that the node is able to supply.
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Request points on the other hand are used for interacting with the node that is
considered to be the consumer in the interaction. 

Please note that service and request points and interactions deal with the
information that is exchanged and not the means by which the information is
exchanged. The technical means by which information is exchanged is addressed in
the SV-2 models by way of communication ports.

Creating a Service Point or a Request Point

The process for creating a Service Point or Request Point is identical. 

To create a sService Point:

1. In the diagram insert toolbar, click Service Point .
2. Position the object at the edge of the architecture frame.

A creation dialog box opens.
3. Click the arrow at the right of the Service Definition field to define the 

service definition enabling activation of this service point.
A search dialog box opens.

4. Select the service definition associated with this service point.
5. Click Next.

A dialog box opens proposing a list of contributor roles that can be
associated with the service point.

 This second dialog box is not proposed if there is only one 
candidate role that can be associated with the service point.

6. Select the role that interests you and click OK.
The service point appears in the diagram.

To change the service point name:
1. Click the name of the service point and press key F2.
2. Enter the new name used at specification of interaction points.

The OV-2 Report Template

OV-2 report chapters are generated from the OV-2 report template. This template
is composed of eight chapters:

• The Operational Node Composition Hierarchy chapter
• The Operational Node Specialization Hierarchy chapter
• The Operational Node Generalization Hierarchy chapter
• The Operational Node Dictionary chapter
• The Operational Node Exchange chapter
• The Operational Node Exchange Balance chapter
• The Operational Node Exchange Compliance chapter
• The Operational Node Realization chapter

The OV-2 report template is structured to analyze the architecture to which it is
associated. However, two additional and optional parameters called Subsets can be
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used to restrict the scope of the report. These are the Operational Node Subset and
the Resource Type Subset.

• Operational Node Subset: This parameter can be set with interactions, 
operational nodes and diagrams. The type of values used for the 
parameter determines the scope of the report:
• Operational Node: only the specified operational nodes are 

considered. Embedded operational nodes are excluded. All incoming 
and outgoing interactions are included as well as the targeted 
operational nodes. The process of operational node collection is not 
reiterated on operational nodes found from interactions.

• Interaction: These are the interactions that exist between 
operational nodes. Only the specified interactions are considered and 
source and target operational nodes are included.

• Diagram: Operational nodes and interactions displayed in the 
diagrams are included. The diagrams must be described in the 
architecture analyzed.

• Resource Type Subset: This parameter can be set with applications, 
artifacts, org-units or resource architectures.The type of values used for 
the parameter determines the scope of the report. If no parameter is set, 
all the applications, artifacts, org-units and resource architectures are 
included in the report.
• Application: Only the specified applications are considered for the 

report.
• Artifact: These artifacts are the physical assets of the system that are 

neither applications or organizational elements. 
• Org-Unit: These can be humans or simply organizational elements. 

They can be internal or external to the enterprise. 
• Resource Architecture: These resource architectures are 

combinations of the physical assets and organizations used to provide 
a capability.

The OV-2 Operational Node Composition Hierarchy Chapter

This chapter gives a view of the operational node hierarchies. Operational Node Tree
Diagrams are displayed with the complete structure, taking into account the
optional scope.

The OV-2 Operational Node Specialization Hierarchy Chapter

The OV-2 operational node specialization hierararchy chapter shows how the
operational nodes of the architecture are specialized.

The operational nodes are presented in a table along with their comments and the
library to which they belong. If a variant of an operational node is created, the
varied operational node is presented in the table along with its variant.

To create new specializations (variants), use the New > Variant command on the
operational node to be varied (specialized).
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The OV-2 Operational Node Generalization Hierarchy Chapter

The OV-2 operational node generalization hierararchy chapter shows how the
operational nodes of the architecture are generalized.

The operational nodes are presented in table form along with their comments and
the library to which they belong. If a variant of an operational node exists, this
variant is also presented in the table along with the varied operational node
(operational node from which the variant was created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).

The OV-2 Operational Node Dictionary Chapter

The Operational Node Dictionary lists the operational nodes defined in the
architecture in an alphabetical table. This enables the retrieval of items for which
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the names are known. It also displays the Operational Node Structure diagram for
the different operational nodes.

Example of Operational Node Dictionary Chapter with Diagram

The OV-2 Operational Node Exchange Chapter

This chapter lists the needs that exist for the exchange of information from specific
operational nodes to others. Depending on the scope defined (or the default scope:
the entire architecture), the chapter lists a set of needlines as well as the source and
target operational nodes. For each needline, the exchanged information is also
listed.
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The structure diagrams in which the different needs are defined are also displayed.

Example of an Operational Node Exchange Chapter

The OV-2 Operational Node Exchange Balance Chapter

This chapter is used to verify that the exchanges defined between operational nodes
are correctly designed. All the incoming and outgoing exchanges of the operational
nodes are compared and examined to reveal missing as well as unnecessary
information for the exchange design. The chapter lists all the internal and outside
messages and interactions that detail the selected operational nodes.

The OV-2 Operational Node Exchange Compliance Chapter

The Operational Node Exchange Compliance chapter indicates the level of
compliance between the need to exchange information from one operational node
to another and the information actually exchanged through the implemented
missions.
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Activities supported by the operational nodes actually exchange information within
the context of designed missions. This information is compared with the need
defined in the needlines/interactions. Missing or unexpected information is
detected.

This chapter relies on the nodes defined in the OV-2 model as well as the functional
processes that describe how missions are performed. These processes are described
in detail in OV-5, however, a brief description is necessary to aid in understanding
the content of this chapter.

A node structure does not indicate how missions are performed. It only describes
the nodes involved in the mission and how they are structured. Through
interactions, you can guess the potential information exchanges that occur between
nodes. To add a dynamic perspective to nodes, a process must be described (see
the OV-5 model). This process is composed of activities that exchange information.
Information is actually exchanged in the process while the node structure only
describes the ability to perform such exchanges. 

Activities are performed under the control of the operational nodes.

The Operational node exchange compliance chapter identifies three states for the
information exchange:

• Information Exchange Correctly Designed: an information item is 
defined at both the node and the process levels.

• Missing Information: an information item can potentially be 
exchanged between two nodes, however, there is no process available to 
perform this exchange. The question is therefore, whether the interface 
described between the two nodes is still useful.

• Unexpected Information: an information item is exchanged in a 
process between two activities, however, there is no interaction between 
the nodes carrying out the activities. The question is therefore, should 
the information be exchanged in this manner in the process and must 
the interaction be reviewed to depict the ability to make such an 
exchange.
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The figure below is an example of an OV-2 compliance chapter. The table displays
expected and correct content.

Example of an OV-2 Operational Node Exchange Compliance Chapter

The OV-2 Operational Node Realization Chapter

The OV-2 Operational Node Realization chapter displays in a matrix, the resources
(human and non human) responsible for performing the activities required for an
operational node.

In the matrix, the resource items are displayed in columns while the operational
nodes are displayed in rows. Checkmarks appear in the matrix to show where a
particular resource is used for an operational node. You can add and remove
checkmarks in the matrix.
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OV-3 OPERATIONAL RESOURCE FLOW MATRIX

OV-3 details information exchanges and identifies who exchanges information, what
information is exchanged, why the information is necessary, and how the
information exchange must occur. There is no one-to-one mapping of OV-3
information exchanges to OV-2 needlines/interactions; rather, many individual
information exchanges may be associated with one needline.

Information exchanges express the relationship across the three basic architecture
data elements of an OV model (operational activities, operational nodes, and
information flow) with a focus on the specific aspects of the information flow and the
information content. Certain aspects of the information exchange can be crucial to
the operational mission and should be tracked as attributes in OV-3. For example,
if the subject architecture concerns tactical battlefield targeting, the timeliness of
the enemy target information is a significant attribute of the information exchange.

See:
 "The OV-3 Report Template", page 112
 "The OV-3 Operational Information Exchange Dictionary", page 112
 "The OV-3 Contents Linked to Operational Items Chapter", page 113
 "The OV-3 Operational Information Exchange Matrix Chapter", page 114

The OV-3 Report Template

The report template used to generate tne OV-3 report chapters is composed of three
parameters: the architecture described and two optional values (needline subset
and exchange properties) that reduce the scope of the study. 

• The Architecture parameter is the architecture to be analyzed
• The Needline Subsets parameter is set with some of the needlines 

described within the architecture. In this case, the OV-3 report focuses 
on this set of needlines and the information exchanges contained in 
these needlines. If no needlines are specified then all the needlines 
defined within the context of the architecture are taken into account. 

• The Exchange Properties parameter is used to specify the interactions 
used for the exchanges, that should be included in the analysis. If no 
exchange property is set, all the exchanges are taken into account.

The OV-3 Operational Information Exchange Dictionary

The Operational Information Exchange Dictionary chapter lists in alphabetical order
all the information elements (contents) of the architecture, defined on the
operational level.
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Each information element is then described in detail with a list of all the information
exchanges in which it is involved. The source and target of the information is also
included. 

The OV-3 Contents Linked to Operational Items Chapter

This chapter presents a table which lists the contents of the architecture that are
linked to operational items. This helps the user determine if the type of contents
linked are defined according to the scope defined for this operational architecture.
This definition is based on the "View Type" property.
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The OV-3 Operational Information Exchange Matrix Chapter

This chapter identifies and displays the information elements and relevant attributes
of information exchanges. These exchanges are associated to their producer and
consumer operational nodes and activities and to the interactions that they satisfy.
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Example of the Operational Information Exchange Matrix Chapter
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OV-4 ORGANIZATIONAL RELATIONSHIPS CHART

OV-4 illustrates the command structure or relationships (as opposed to relationships
with respect to a business process flow) among human roles, organizations, or
organization types that are the key players in architectures.

This model clarifies the various relationships that can exist between organizations
and sub-organizations within the architecture as well as between internal and
external organizations.

See:
 "Designing Organizations", page 116
 "The OV-4 Report Template", page 117
 "The OV-4 Org-Unit Composition Hierarchy Chapter", page 117
 "The OV-4 Org-Unit Specialization Hierarchy Chapter", page 118
 "The OV-4 Org-Unit Generalization Hierarchy Chapter", page 119
 "The OV-4 Org-Unit Dictionary Chapter", page 119
 "The OV-4 Competence Dictionary Chapter", page 120
 "The OV-4 Org-Unit Responsibility Chapter", page 120
 "The OV-4 Org-Unit Type and Actual Organizations Mapping Overview Chapter", 

page 120
 "The OV-4 Org-Unit Type and Actual Organizations Mapping Details Chapter", 

page 122
 "The OV-4 Org-Unit Type and Actual Organizations Mapping Deep Details 

Chapter", page 123

Designing Organizations

The root org-units of the organization are created from the DoDAF 2.0 start page or
the navigation tree. A global organization chart can be created to graphically show
the hierarchy of org-units. If the hierarchy is too complex to be shown in a simple
diagram, sub organizational charts can be added from any sub org-unit. Org-units
are linked by dependency links that can be tuned to express a hierarchical or
functional dependency.

To create an org-unit from the DoDAF 2.0 navigation tree:
1. Expand the folders Architectures > Architecture concerned > 

Operational Viewpoint > OV-4 - Organizational Relationships 
Chart > Org-Units. 

2. Right-click the Root Org-Units folder and select New > Org-Unit.
3. In the dialog-box that appears, enter the name of the org-unit and click 

OK.
The new org-unit appears in the list of objects in the Root Org-Units
folder. You can then specify what type of org-unit this is.

To specify the org-unit type:
1. Right-click the org-unit and select Properties.
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2. In the Characteristics tab, select one of the types from the Org-Unit 
Type drop-down list (Company, Institute, Agency, Organization, Role, 
Generic, Post).

The figure below is an example of an organizational chart.

Example of Organizational-Unit Chart

The OV-4 Report Template

Like all the other models, the OV-4 report template comes with an architecture
parameter that is used to specify the architecture to be described.

This parameter is completed by an optional parameter: Org-Unit Subset. If no value
is set, all the org-units defined in the architecture are taken into account. Otherwise,
only the given org-units are used to generate the report.

The OV-4 Org-Unit Composition Hierarchy Chapter

This chapter details the hierarchy of org-units. For each org-unit the type and
comment are displayed. The table is composed of expandable items that reveal the
complete structure of the root org-units.

If org-units are set in the Org-Unit Subset parameter, only these org-units are used
to generate the hierarchy. They are used as the roots of the generated structures.
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If a set org-unit is contained in a structure of another set org-unit then the structure
for this org-unit is not repeated.

All the organizational charts including at least one of the cited org-units are inserted
in the chapter.

The OV-4 Org-Unit Specialization Hierarchy Chapter

The Org-Unit specialization hierarchy chapter shows how the different org-units of
the architecture are specialized. 

The specializations actually refer to variants of org-units. These variants are created
to add more detail and specifics to fit particular scenarios of the architecture. They
can be created by using the New > Variant command of the org-unit to be varied
(specialized).

To show the specializations, the chapter displays a table with the varied objects,
their variants, the libraries to which they belong and their comments. It is important
to note that not only org-units with variants are displayed in the chapter.

All the org-units of the architecture are displayed if no org-unit subset was specified
in the report template. 

Example of the Org-Unit Specialization Hierarchy Chapter
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The OV-4 Org-Unit Generalization Hierarchy Chapter

This chapter shows how the different org-units of the architecture are generalized.
The variants of org-units are presented in table form along with the varied org-units
(org-units from which the variant was created). The comments and library to which
the org-units belong are also presented.

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).

The OV-4 Org-Unit Dictionary Chapter

This chapter simply creates an alphabetical list of all org-units mentioned in the Org-
Unit Subset parameter or of all the org-units of the architecture if no subset is
mentioned. For each org-unit in the table, the list of direct sub-org-units is
displayed.

Tree diagrams and structure diagrams are also inserted in the chapter.
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The OV-4 Competence Dictionary Chapter

This chapter presents list of all the competences of the architecture. The org-units
that are linked to the different competences are also displayed.

The OV-4 Org-Unit Responsibility Chapter

This chapter lists the org-units of the architecture or those mentioned in the Org-
unit subset of the analysis chapter. It also details the operations that are performed
by these org-units and indicates the organizational processes for which they are
responsible.

Statistical values concerning the maximum, minimum and average number of
operations performed per org-unit and the equivalent values for the assigned
processes are also displayed.

Organizational processes are assigned in the Properties dialog box of the Org-units,
Responsibility tab.

The operations performed by org-units are retrieved in the chapter through the use
of participants. Org-units are attached to participants in the Organizational Process
Diagram. Operations are then added to participants in the diagrams.

The list of Organizational Processes is found in the OV-6c model.

The OV-4 Org-Unit Type and Actual Organizations Mapping 
Overview Chapter

The org-unit "type" is the generic org-unit or an org-unit template created for a
particular purpose and on which actual org-units can be based. Org-units can then
be created and mapped to these "types". These are the "actual" organizational
resources.

This chapter gives an overview of the mapping levels that exist between org-unit
types and the actual organizational resources (org-units). It also gives the
percentage of mapping compliance between the types and actual org-units.

 To verify if a mapping exists for an org-unit type, right click the 
type and click Locate. If no mapping exists, the Locate command is 
grayed. For more details on mapping objects, see the MEGA 
Architecture user guide, "Application Deployment" chapter.
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The Org-Unit Type and Actual Organizations Mapping Overview chapter begins with
a pie chart that indicates the percentage of mapped and unmapped organizational
resources.

This pie chart is then followed by a list of the organizational resources of the
architecture and a table that displays the mapping for the highest level of
organizational resources (the organization). 
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The figure below shows that mappings exist for the "UK SAR Government
Department" organization: 7 org-units are mapped, which account for 87.5% of the
organization’s organizational resources.

The OV-4 Org-Unit Type and Actual Organizations Mapping Details 
Chapter

This chapter gives more details of the mapping between the org-unit types and the
actual organizational resources. It shows the mapping levels of the different org-
unit types with their actual organizations. This information is presented in table
form.
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In the figure below, the "UK SAR Government Department" organization is mapped
to the "SAR Government Department" type. 

The OV-4 Org-Unit Type and Actual Organizations Mapping Deep 
Details Chapter

This chapter gives deep details of the mapping between the organization type and
the actual organization. A list of the mapped organizational resources is also
provided.

In this chapter each organizational resource (org-unit) has a dedicated paragraph
with a table that indicates its mapping with a type. The mapped organizational
resources (org-unit components) of this organizational resource are also indicated
with their corresponding type.
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The figure below indicates the mapping between the organizational resources of an
organization with the corresponding org-unit types.
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OV-5A OPERATIONAL ACTIVITY DECOMPOSITION TREE

OV-5 describes the operations that are normally conducted in the course of
achieving a mission or an operational activity. It describes capabilities, operational
activities (or tasks), input and output (I/O) flows between activities, and I/O flows
to/from activities that are outside the scope of the architecture.

The OV-5 analysis reports are generated with different chapters that assist in rapidly
getting a synthesis of modeled information to aid in decision making. The displayed
information can particularly help to:

• Clearly define and identify the responsible entities for the different 
operational activities, when coupled with the operational nodes of OV-2 

• Reveal unnecessary and redundant operational activities
• Make decisions about adding, merging and omitting operational activities
• Define and identify problems, opportunities and operational activities and 

their interactions that require close examination
• Provide a necessary foundation for depicting activity sequencing and 

timing in OV-6 views
• Provide a clear picture of how operations are performed and thereby 

support the analysis and design of services and systems.

The OV-5a analysis report presents the different capabilities and operational
activities of the architecture in a hierarchical structure.

See:
 "The OV-5a Report Template", page 125
 "The OV-5a Operational Activity Composition Hierarchy Chapter", page 125
 "The OV-5a Operational Activity Specialization Hierarchy Chapter", page 126
 "The OV-5a Operational Activity Generalization Hierarchy Chapter", page 126

The OV-5a Report Template

The OV-5a report template is supplied with two parameters: the architecture and
the activity.

• The Architecture parameter defines the architecture to be analyzed.
• The Operational Activity Subset, which is an optional parameter, is used 

to reduce the scope of the study. It can be set with either just a few 
activities or a few functional processes. If this parameter is not set, all 
activities are taken into account.

The OV-5a Operational Activity Composition Hierarchy Chapter

This chapter shows the structure of functional processes through the operational
(functional) activities they contain. When functional processes are selected, the
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trees are decomposed as follows: functional process to activities to sub-activities
and so on.

The OV-5a Operational Activity Specialization Hierarchy Chapter

The OV-5a operational activity specialization hierararchy chapter shows how the
functional processes of the architecture are specialized.

The functional processes are presented in a table along with their comments and
the library to which they belong. If variants of functional processes are created, the
varied functional processes are also presented in the table along with their variants.

To create new specializations (variants), use the New > Variant command on the
functional process to be varied (specialized).

The OV-5a Operational Activity Generalization Hierarchy Chapter

The OV-5a operational activity generalization hierarchy chapter shows how the
functional processes of the architecture are generalized.

The functional processes are presented in table form along with their comments and
the library to which they belong. If a variant of a functional process exists, this
variant is also presented in the table along with the varied functional process
(functional process from which the variant was created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).
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OV-5B OPERATIONAL ACTIVITY MODEL

OV-5b puts capabilities and operational activities in their context and indicates the
relationships that exist among the different activities (tasks), inputs and outputs.

See:
 "Creating Activity Models", page 127
 "Retrieving Interesting Information in the OV-5b Chapters", page 131
 "The OV-5b Report Template", page 131
 "The OV-5b Operational Activity Dictionary Chapter", page 132
 "The OV-5b Operational Activity Exchange Chapter", page 132
 "The OV-5b Operational Activity Exchange Balance Chapter", page 132

Creating Activity Models

The entry point for the operational activity models is the functional process concept.
Functional processes describe a sequence of transformation activities. To describe
a functional process, you can use the Functional Process diagram. This functional
process can then be broken down to reveal the different activities of the process.

The Functional Process diagram contains the activities that can be assigned to
operational nodes (see figure below). The details of an activity can then be further
described in another Functional Process diagram. This is how a hierarchy of
activities is to be generated.
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The figure below is an example of a Functional Process Diagram. It displays the
Search process of the architecture. In this figure the process contains activities that
are assigned to different operational nodes.

 Note that activities can sometimes call different processes. See the 
MEGA Process BPMN Edition user guide for more information on 
creating process diagrams.

Example of a Functional Process diagram

The figure below shows the details of the Send Distress Signal activity through
another dedicated Functional Process diagram. In this figure, the described activity
contains two sub-activities.

A Detailed Illustration of the OV-5 Send Distress Signal Activity

To create the "Functional Process Diagram":
1. In the DoDAF 2.0 navigation window, expand the OV-5a Operational 

Activity Model and Root Functional Pocesses folders.
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2. Right-click the functional process for which you wish to create the 
diagram and select New > Diagram > Functional Process Diagram 
> Create.
A diagram opens in the workspace, on the right with a frame representing
the functional process to be described.

Participants

As you will have noticed, you can place your participants inside as well as outisde
of the process on which the Functional Process diagram is based. The participants
placed on the outside of the process should not have activities placed on them. The
purpose of the participant is not to describe activities but to help detail the external
interactions of the process.

Adding participants to the Functional Process diagram

Before you place a participant in a diagram, you must first create the paticipant and
assign it to an operational node or operational component. When this is done, only
the assigned component or node can be attached to this participant in the diagram.

It is more accurate to assign an operational component than an operational node to
a participant. This is so as operational components are already defined in particular
contexts.

Activities

Activities are added to the participants in the diagram to indicate the steps in the
process.

To add an activity:
1. In the objects bar select the Functional Activity icon and click in the 

diagram, on the participant responsible for the activity.
2. Enter the name of the functional process and click OK.

The new activity appears in the diagram.
 If the activity represents another functional process, you can call 
this process from within the Properties dialog box, Characteristics 
tab, "Called Functional Process" box. Note the shape difference between 
activities with and without called processes.

You can describe your activities in detail through Activity Decomposition diagrams.

Events

When you add events to your diagram (Start End, etc.), you may choose to place
them in the process or on the frame of the Process described by the diagram: this
can be done through a drag and drop motion. If you place the event on the frame,
a red rectangle appears in the event.

 The event cannot be returned to the inside of the process with a 
drag and drop motion.
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To remove the event from the frame and place it inside the process:
 Right-click the event and in its contextual menu, select Detach.

 You can then drag and drop the event into the frame.

Message

Messages are used to pass on information from one element to another. This
exchange of information in the process diagram is displayed in message flows
through the use of the message flow icon.

Sequence

The activities in a process are not all carried out simultaneously. Often the execution
or completion of one activity triggers or leads to another activity. Sequence flows
are therefore used to indicate the steps to be followed (sequence of activities) in a
process. The sequence flows of activities are indicated through the use of the
sequence flow icon. 

Messages are also sent from one activity to another and, as mentioned before, are
represented through the use of message flows.

If you so desire, you can combine the sequence of activities with the exchange of
information between these activities. This can be done through the use of the
"Sequence Flow with Data Object" icon.

To create a sequence flow with message content between two activities:
1. In the objects menu bar click the arrow of the Sequence Flow icon and 

select Sequence Flow with Data Object.
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2. Click on the activity where the flow begins and holding down the mouse 
button, draw a line to the activity to be linked.

 Lines are drawn in the direction of the flow.
3. Release the mouse button.

 The sequence flow normally starts from an event, for example, 
Start. 

4. Create a new content or find an already existing one and link it to the 
sequence flow.

5. Click OK.
A line with an arrow appears in the diagram between the two activities.
The name of the attached content appears next to the line. The arrow
indicates the direction of the sequence/message flow.

Retrieving Interesting Information in the OV-5b Chapters

To ensure that interesting information appears in the chapters, and especially the
OV-5b Operational Activity Exchange and Operational Activity Exchange Balance
chapters, the modeler should ensure that the functional processes to be studied
and / or included in the analyses at least have the following data:

• There should be messages with content between at least two activities of 
a functional process

• The participants in functional processes should be associated to 
operational nodes. The operational nodes are found in OV-2.

• The operational nodes associated to functional processes should have 
interactions that are based on the content of the functional processes. 

It can be argued that the most interesting section of the OV-5b Operational Activity
Exchange chapter is the table that lists the different exchanges that are sent from
or to functional processes or activities with the information element. If there are no
messages with content between operational activities, there will be no exchange to
show in the chapter. 

Likewise if there are no incoming or outgoing exchanges to study there will be
nothing to display in the OV-5b Operational Activity Exchange Balance chapter.

The OV-5b Report Template

The OV-5b report template is supplied with two parameters: the architecture and
the activity.

• The Architecture parameter defines the architecture to be analyzed.
• The Operational Activity Subset, which is an optional parameter, is used 

to reduce the scope of the study. It can be set with either just a few 
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activities or a few functional processes. If this parameter is not set, all 
activities are taken into account.

The OV-5b Operational Activity Dictionary Chapter

This chapter displays a list of all the functional processes and activities used in the
study. Each activity and functional process is displayed with its short name, long
name and comment.

The chapter begins with a list of the all the functional processes in the architecture.

A detailed paragraph for each functional process follows with the describing
Functional process diagram and a list of the involved activities. Sub processes are
also listed if they exist.

A list of all the activities in the architecture then follows with paragraphs to describe
each activity.

The content of each paragraph varies depending on the type of item being
described. Generally, functional processes have diagrams that describe them.
Activities may also have sub-activities. The paragraphs relating to activities display
the describing diagrams and list the contained activities with their name, comment
and describing diagrams. On the other hand, if the item is a functional process, a
paragraph is generated if the functional process has at least one describing diagram
or if it is composed of activities. This paragraph will display the describing diagrams
and lists the contained activities. 

The called functional processes of activities are also listed.

The OV-5b Operational Activity Exchange Chapter

This chapter shows the diagrams that display information exchanges between
functional processes and activities. It also details the information exchange between
the selected activities. All messages or interactions connecting activities are
displayed in a list with their name, comment and source and target activities.

The OV-5b Operational Activity Exchange Balance Chapter

This chapter helps to determine the compliance of the exchanges defined within
functional processes and the exchanges received and/or sent by these functional
processes. The chapter lists all the exchanges modeled within and outside each
functional process between the contained and detailing activities.

Different icons with arrows are used to give valid information relating to each
message and interaction. These arrows help to determine what is missing from and
what is unnecessary for the exchange design.
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The information of the chapter is presented in table form with a list of the
operational activities of the architecture. For each operational activity the balance
between the incoming and outgoing information is shown.

Example of the OV-5b Operational Activity Exchange Balance Chapter
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OV-6A OPERATIONAL RULES MODEL

OV-6a specifies the operational or business rules that are constraints to an
enterprise, a mission, operation, business, or an architecture. While other OV
models (OV-1, OV-2, and OV-5) describe the structure of a business (what the
business can do, for the most part) they do not describe what the business must do,
or what it cannot do.

Rules are modeled in relation to the constraining objects. A constraint can be
potentially linked to any object of the architecture. This is done within the different
diagrams showing the objects to be constrained or by adding new constraints via
the property pages.

Constraints retrieved from a deep exploration of the architecture are displayed in
the DoDAF 2.0 navigation tree and start page. You can also create constraints from
these locations. The constraints displayed are those attached to the operational
items of the architecture.

 "The OV-6a Report Template", page 134
 "The OV-6a Operational Rules Model Chapter", page 134
 "The OV-6a Rules Linked to Operational Items Chapter", page 135

The OV-6a Report Template

The OV-6a report template is supplied with one parameter: the architecture for
which the report is required. There are no additional parameters. The template
comes with two chapters, the OV-6a Operational Rule Model chapter and the OV-6a
Rules Linked to Operational Items chapter.

The OV-6a Operational Rules Model Chapter

This chapter lists the constraints and requirements attached to the operational
items of the architecture. The constraints are the external constraining elements
that set the terms for whatever solutions are implemented while the requirements
are the needs and requests of the user that define the contract or agreement to be
carried out. 

The lists of requirements and constraints are displayed in alphabetical order with an
additional column for the comments. A paragraph is added for each listed constraint
and requirement to explain their constrained objects.

If constraints and requirements are created from objects in Operational node
structure diagrams (OV-2), these constraints and requirements can be retrieved in
the Optional Rules Model chapter provided the "View Type" property is set to
Operational. The constraints are then retrieved in the Operational Constraints folder
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while the requirements are retrieved in the Operational Requirements folder of the
OV-6a navigation tree.

Example of the OV-6a Operational Rule Model Chapter

The OV-6a Rules Linked to Operational Items Chapter

It is also possible to generate a chapter that lists all the potential constraints linked
to an operational item.

This chapter displays a table with an alphabetical list of the constraints that are
linked to operational items. This helps the user determine if the type of constraints
linked are defined according to the scope defined for this operational architecture.
This definition is based on the "View Type" property.

If a constraint is not typed as Operational, a warning icon is displayed for this
constraint in the Scope column. Although not typed as operational, the constraint
appears in the table because it is linked to an operational item. This happens if the
constraint was not created from the DoDAF 2.0 navigation tree but from a diagram
and then attached to an operational item of this diagram. The "View Type" property
for constraints with a warning can, however, be changed from the table (right click
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the constraint > Properties > DoDAF > DoDAF 2 State Level > DoDAF 2.0
Object View Type > etc.). Refresh the chapter to show the changes.

Example of a Rules Linked to Operational Items Chapter
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OV-6B OPERATIONAL STATE TRANSITION DESCRIPTION

OV-6b is a graphical method used to describe how an operational node or activity
responds to various events while changing its state. The associated diagram shows
the sets of events to which the architecture will respond (by taking an action to
move to a new state) as a function of its current state. Each transition specifies an
event and an action.

The MEGA Suite for DoDAF 2 is used to describe the specific behaviors (state
machines) attached to activities. A behavior is a specific concept used to describe
how an activity reacts to different events from start points to end points.

 The terms "state machine" and "behavior" are used 
interchangeably in this section.

See:
 "Creating State Machines", page 137
 "The OV-6b Report Template", page 139
 "The OV-6b Operational State Transition Description Chapter", page 139

Creating State Machines

Two methods exist for creating state machines: from an activity or from the
navigation tree. For a state machine to be set in the operational range, it must meet
one of the following constraints: be connected to an activity or be explicitly marked
as operational using the View Type property. If the property is set using the
Operational Object View value, the state machine is considered an operational one.
Therefore, when the user creates a new state machine in the navigation tree, the
property is set to Operational Object View and states described in the state machine
must relate to an operational state machine.

Other operational state machines can be created directly from an activity. In order
to retrieve all the state machines, a sub-folder is added to the OV-6b folder. New
state machines can be created from this location.

Once a state machine has been created it can be described using state diagrams.
These diagrams contain events and successions from event to event. 

To create an operational state machine:
1. In the DoDAF 2.0 navigation tree, expand the OV-6b - Operational 

State transition Description folder. 
2. Right click Operational State Machines folder and select New > State 

Machine.
3. In the dialog box that appears, enter the name of the state machine and 

click OK.
The new state machine is created in the Operational State Machines
folder.
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You can change the property of the behavior in the Properties page of the folder
in the DoDAF tab, DODAF 2 State Level subtab.

The figure below is an illustration of a state diagram.

Example of a State Diagram (Conduct Joint Force Targeting States)

An event relates to a point in time while the succession matches what happens
between two events. To create a state diagram the user must remember that each
arrow corresponds to a state and each graphical circle corresponds to the transition.

If a state can be reached from two or more previous states, then a synchronization
object must be used.

If a state can reach two or more following states then a decision object must be used
(for example the Execution Completed state in the previous figure).
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The OV-6b Report Template

The OV-6b report template comes with two parameters:
• The Architecture parameter, which specifies the architecture to be 

analyzed.
• The Activity Subset parameter, which is an optional parameter. This 

parameter is used to reduce the scope of the study to a subset of 
selected activities. In this case, only the state machines attached to the 
selected activities are considered. If this parameter is not set, all the 
state machines attached to an activity are taken into account.

The OV-6b Operational State Transition Description Chapter

This chapter lists all the state machines attached to the selected activities. The
chapter starts with a simple table of the state machines (short name, long name,
comment) and the linked activities.

For each state machine which has a describing diagram or at least one event, a
dedicated paragraph is generated with its title being the name of the state machine.
This paragraph displays the comment of the state machine and the (commented)
describing diagrams. It also lists the events (states) with their name and comment
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in a table. The successions (transitions) are listed with their name, comment and
source and target events.

Example of an Operational State Transition Description Chapter
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OV-6C OPERATIONAL EVENT-TRACE DESCRIPTION

OV-6c provides a time-ordered examination of the information exchanges between
the participating operational nodes of a particular scenario. Each event-trace
diagram should have an accompanying description that defines the particular
scenario or situation.

The MEGA Suite for DoDAF 2 models missions and organizational processes via
operations. These processes describe who does what to perform missions,
regardless the service delivered to the customer. The starting point of the
description is an organizational process. This description is done in two ways: either
by splitting the organizational process into smaller parts (sub-organizational
processes), or by describing how the organizational process is actually performed
by the different participants. The participants themselves are designed within the
context of the organizational process and are later associated to org-units of the
organization. The Organizational Process Diagram is used to detail how the
organizational process is performed.

See:
 "The OV-6c Report Template", page 141
 "The OV-6c Operational Event-Trace Composition Hierarchy Chapter", page 142
 "The OV-6c Operational Event-Trace Specialization Hierarchy Chapter", page 142
 "The OV-6c Operational Event-Trace Generalization Hierarchy Chapter", page 142
 "The OV-6c Operational Event-Trace Dictionary Chapter", page 142
 "The OV-6c Operational Event-Trace Exchange Chapter", page 143
 "The OV-6c Operational Event-Trace Exchange Balance Chapter", page 143

The OV-6c Report Template

The OV-6c Report Template supplies reports to detail business process
implementation. It is defined with three parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Interaction Scenario Subset parameter, which is optional. This parameter 
is set with Interaction scenarios and is used to reduce the scope of the 
study. If no value is set for this parameter, all the interaction scenarios 
are taken into account for the report.

• The Organizational Process Subset parameter, which is optional. This 
parameter is set with organizational processes and is used to reduce the 
scope of the study to those selected. If a value is not set, all the 
organizational processes are taken into account.
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The OV-6c Operational Event-Trace Composition Hierarchy Chapter

This chapter shows the hierarchical structure of the organizational processes
through their operations. The selected organizational process mentioned within a
structure are not reconsidered when starting a new structure (to avoid redundant
listing).

The tree structure displays the name and comment of each organizational process
in a table.

The OV-6c Operational Event-Trace Specialization Hierarchy 
Chapter

The OV-6c operational event-trace specialization hierararchy chapter shows how the
organizational processes of the architecture are specialized.

The organizational processes are presented in a table along with their comments
and the library to which they belong. If a variant of an organizational proces is
created, the varied organizational process is presented in the table along with its
variant.

To create new specializations (variants), use the New > Variant command on the
organizational process to be varied (specialized).

The OV-6c Operational Event-Trace Generalization Hierarchy 
Chapter

The OV-6c operational event-trace generalization hierararchy chapter shows how
the organizational processes of the architecture are generalized.

The organizational processes are presented in table form along with their comments
and the library to which they belong. If a variant of an organizational process exists,
this variant is also presented in the table along with the varied organizational
process (organizational process from which the variant was created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).

The OV-6c Operational Event-Trace Dictionary Chapter

This chapter lists all the organizational processes with their details and all the
interaction scenarios that are examples of how the architecture behaves from an
operational perspective. These items are listed with their name and comment.

A paragraph is added for each organizational process which has at least some
components or a describing diagram. The title of the paragraph is the name of the
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organizational process. This paragraph contains the comment, the list of involved
components and the (commented) diagram.

Paragraphs are similarly generated for each interaction scenario.

The OV-6c Operational Event-Trace Exchange Chapter

This chapter is used to show the exchanges that occur between organizational
processes and operations in the architecture.

The OV-6c Operational Event-Trace Exchange Balance Chapter

This chapter is used to show the balance between the exchanges defined within an
organizational process and the exchanges it receives and/or sends out. It lists all
the internal and outside messages and interactions that detail the selected
organizational process.
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DODAF 2 PROJECT VIEWPOINT MODELS

The DoDAF 2.0 Project Viewpoint models that can be generated in the MEGA Suite for DoDAF 2
are:

 "PV-1 Project Portfolio Relationships", page 146
 "PV-2 Project Timelines", page 149
 "PV-3 Project to Capability Mapping", page 152
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PV-1 PROJECT PORTFOLIO RELATIONSHIPS

The purpose of the Project Portfolio Relationships model (PV-1)is to give an
organizational perspective of programmes, projects, portfolios and initiatives. It
provides details on the relationships that exist between the organizations that own
these programmes, projects, portfolios and initiatives. It is also used to identify the
level of maturity to be achieved at each stage of a programme's life-cycle.

All this information can be found in the different chapters of the PV-1 model.

See:
 "The PV-1 Report Template", page 146
 "The PV-1 Project Hierarchy Chapter", page 146
 "The PV-1 Project Dictionary Chapter", page 147

The PV-1 Report Template

The PV-1 report template uses three parameters:
• The Architecture parameter, which is the architecture to be analyzed. 

This is the sole parameter that enables the retrieval of all the root 
projects of the architecture.

• The Projects parameter, which is optional. This parameter is used to 
reduce the scope of the study. The selected projects must of course 
belong to the architecture being analyzed. If no project has been 
selected, all the projects of the architecture are taken into account.

• The Column Projects parameter. This is also an optional parameter. This 
parameter enables the creation of a table with different sets of projects 
for rows and for columns. 

The PV-1 Project Hierarchy Chapter

The project hierarchy chapter shows the structure of the projects implemented in
the analyzed architecture.

The Project composition diagram is displayed to show the structure of the projects.
This diagram is followed by a table of the project hierarchy. The Root project is
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displayed with its comment and its sub-projects. The deliverables and comments of
the sub-projects are also displayed.

Example of a Project Hierarchy Chapter

The PV-1 Project Dictionary Chapter

The project dictionary chapter provides a list of all the projects of the architecture
in alphabetical order.

This list is presented in table with the short name, long name and comment of each
project.



148 MEGA Suite for DoDAF 2

8

A paragraph is then dedicated to each project. In this paragraph, the deliverables
expected of the project are listed. The project composition diagram is also
displayed.

Example of a Project Dictionary Chapter
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PV-2 PROJECT TIMELINES

The PV-2 gives a timeline perspective of programmes. It shows how projects are
grouped together to form a coherent acquisition programme and summarizes the
interdependencies among projects and the links between project phases.

The intended usage of the PV-2 includes:
• Project management and control (including delivery timescales)
• Project dependency risk identification
• Management of dependencies
• Portfolio management

See:
 "The PV-2 Report Template", page 149
 "The PV-2 Hierarchical Project Dependencies Chapter", page 149
 "The PV-2 Project Dependencies Chapter", page 150

The PV-2 Report Template

The PV-2 report template uses three parameters:
• The Architecture parameter, which is the architecture to be analyzed. 

This is the sole parameter that enables the retrieval of all the root 
projects of the architecture.

• The Projects parameter, which is optional. This parameter is used to 
reduce the scope of the study. The selected projects must of course 
belong to the architecture being analyzed. If no project has been 
selected, all the projects of the architecture are taken into account.

• The Column Projects parameter. This is also an optional parameter. This 
parameter enables the creation of a table with different sets of projects 
for rows and for columns. 

• The Display of Project Steps parameter. This parameter is otional/ It is 
used to specify if project steps are displayed under their parent project, 
in a tree of projects or if all the projects are displayed on the same level.

The PV-2 Hierarchical Project Dependencies Chapter

The Hierarchical Project Dependencies chapter shows the dependencies of projects
in the architecture. This chapter allows you to use the subset parameters to
generate appropriate sized tables. The projects are displayed according to the
defined project hierarchy. 

The chapter information is displayed in a matrix with project trees as rows and
column headers.
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Dependencies between two projects are represented by icons. An icon appears in
the matrix between projects linked by a dependency. You can add or remove
dependencies by clicking in the different cells of the matrix.

Example of a Hierarchical Project Dependencies Chapter

The PV-2 Project Dependencies Chapter

The Project Dependencies chapter also shows the dependencies of projects in the
architecture, however, project hierarchy is not displayed.

The dependencies are represented as icons in a matrix with projects as rows and
column headers. An icon appears in the matrix between projects linked by a
dependency. You can add or remove dependencies by clicking in the different cells
of the matrix.
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The PV-2 Project Timeline Chapter

The project timeline chapter contains a Gantt Chart with the different planned
projects of the architecture. In this Gantt Chart displays:

• Projects and their sub-projects along with their start and end dates
• Project progression with percentage values
• Project sequence (black arrow)

Example of a Project Timeline Gantt Chart
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PV-3 PROJECT TO CAPABILITY MAPPING

The purpose of the Project to Capability Mapping (PV-3) model is to primarily
support the acquisition and fielding processes, including the management of
dependencies between projects and the integration of all relevant project and
programme elements to achieve a capability.

In PV-3, programmes and projects are mapped to capabilities to show how the
specific projects and programme elements help to achieve a capability. Projects are
mapped to the capability for a particular time period. Projects may contribute to
multiple capabilities and may mature across time periods. 

The PV-3 model can be used to identify capability redundancies and shortfalls,
highlight programme phasing issues, expose organizational or system
interoperability problems, and support programme decisions, such as when to
phase out a legacy system.

See:
 "The PV-3 Report Template", page 152
 "The PV-3 Project Deliverables X Capability Increments Chapter", page 152

The PV-3 Report Template

The PV-3 report template uses two parameters:
• The Architecture parameter, which identifies the architecture to be 

analyzed.
• The Projects Subset parameter, which is optional. This parameter 

reduces the scope of the study to a subset of the projects selected. The 
selected projects must belong to the architecture. If no project is 
selected, all the projects of the architecture are taken into account.

• The Capability Increment parameter, which is also optional. this 
parameter is set with the time periods that you wish to include in the 
analysis. If no time period is selected, all the time periods of the 
architecture are taken into account

The PV-3 Project Deliverables X Capability Increments Chapter

This chapter shows the relationship between the states of capability configurations
and the deliverables produced by the projects implemented to attain the expected
states.

This relationship is presented in a matrix with a project tree with deliverables as
rows and time periods as column headers.

Checkmarks appear in the matrix to show where a particular deliverables is
expected, to ensure that a state of a system part is available. The deliverables are
not directly connected to the state but to the time periods of the items that are
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linked to the states. The time periods are the intermediate notions that group both
the states and the items.

Example of the Project Deliverables X Capability Increments Chapter
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DODAF 2 SERVICE VIEWPOINT MODELS

The DoDAF 2.0 Service Viewpoint models that can be generated in the MEGA Suite for DoDAF 2
are the:

 "SvcV-1 Services Context Description", page 156
 "SvcV-2 Service Resource Flow Description", page 158
 "SvcV-3a Systems-Service Matrix", page 161
 "SvcV-3b Services-Services Matrix", page 162
 "SvcV-4 Services Functionality Description", page 164
 "SvcV-5 Operational Activity to Services Traceability Matrix", page 165
 "SvcV-6 Services Resource Flow Matrix", page 166
 "SvcV-7 Services Measures Matrix", page 167
 "SvcV-8 Services Evolution Description", page 168
 "SvcV-9 Services Technology & Skills Forecast", page 169
 "SvcV-10a Services Rules Model", page 170
 "SvcV-10b Services State Transition Description", page 171
 "SvcV-10c Services Event-Trace Description", page 172

Depending on its outcomes, a service may be a System Service or an Operational Service. The
availability of service subviews, and their content, depends on the service.:

Subviews Availability

SvcV-1, SvcV-2, SvcV-3a, SvcV-3b, 
SvcV-4, SvcV-5, SvcV-6

For System Services and Operational services with 
a content depending on the service

SvcV-7, SvcV-10a, SvcV-10b For System Services and Operational services with 
the same content

SvcV-8, SvcV-9, SvcV-10c Only for System Services 
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SVCV-1 SERVICES CONTEXT DESCRIPTION

The SvcV-1 Service Context Description Viewpoint is dedicated to the identification
of services, service items, and their interconnexions.

With the MEGA Suite for DoDAF 2 product, the SvcV-1 Service Context
Description Viewpoint is based on service taxonomy concept whitch is basically a
system of classification designed to organize knowledge according to the service
perspective, and to facilitate the harmonization of services across several domains
(or several architectures). Its general purpose is for organizing one’s knowledge of
something into categories of similar things, in order to understand something better
through comparison with other similar things. In the Service Context Description
Viewpoint, the service taxonomy represents the operational domain’s knowledge, as
described in the Operational View, in terms of services, structured in some useful
way. The definitions of the services are defined in ScvV-2.

The different services are classified as operations, application or information
services.

With the MEGA Suite for DoDAF 2 product, the user can create services with
variants. They can also create structure and tree diagrams to decompose and
represent the hierarchy of these services.

See:
 "Creating a Service Taxonomy", page 156
 "The SvcV-1 Report Template", page 157
 "The ScvV-1 Service Definition Specialization Hierarchy Chapter", page 157
 "The ScvV-1 Service Definition Generalization Hierarchy Chapter", page 157

Creating a Service Taxonomy

To create a System Service Taxonomy from the ScvV-1 Service Taxonomy folder
of the "Service Viewpoint (System)" folder :

1. Right click the Service Taxonomy folder and select New > Service 
Taxonomy.

2. Name the Service Taxonomy.
3. Click OK.

The new Service Taxonomy appears in the folder of the Service from which
it was created. The corresponding Service Taxonomy Diagram is also
created.

To facilitate the description process, a service can be decomposed into sub parts
which are assembled together in an interaction system. The different service layers
can be graphically described in diagrams.

The modeling principles are similar to those used for the capability viewpoints.
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The SvcV-1 Report Template

The ScvV-1 report template is delivered with a report that displays the service
taxonomy represented as a hierarchy. This template is defined with two
parameters:

• The Architecture parameter which indicates the architecture to be 
analyzed.

• The System Service Taxonomy to take into account.

The ScvV-1 Service Definition Specialization Hierarchy Chapter

This chapter shows how the different services of the architecture are specialized. In
fact variants of certain services are created to add more detail and specifics to fit
and support particular scenarios of the architecture. 

To show these variants, the Specialization Hierarchy chapter presents the varied
objects and their variants in a table. The libraries to which the services belong as
well as the comments of these objects are also indicated. 

To create new specializations (variants), use the New > Variant command on the
service to be varied (specialized).

The ScvV-1 Service Definition Generalization Hierarchy Chapter

This chapter shows how the different services of the architecture are generalized. 

The variants of services are presented in table form along with the varied services
(service from which the variant was created). The comments and library to which
the services belong are also presented. 

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).
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SVCV-2 SERVICE RESOURCE FLOW DESCRIPTION

The SvcV-2 Service Resource Flow Description model describes Resource Flows
exchanged between Services.

Service definition includes, among other things, the definition of interfaces, and
connecting the interfaces to service definition components.

The main entry point of the SvcV-2 model is the Service Resource Flow Description
folder. This concept matches the definition of the exchange protocol that must be
fulfilled to benefit from the exposed services. 

An exchange protocol (or Service Definition) defines how a consumer and a
provider must behave in order to carry out a particular service. These exchange
protocols are connected to the service points. The service that displays this service
point will play the role of the provider in the exchange protocol (or Service
Definition).

See:
 "Creating Service Definitions", page 158
 "The SvcV-2 Report Template", page 160
 "The SvcV-2 Service Definition Dictionary Chapter", page 160
 "The SvcV-2 Service Definition Usage Chapter", page 160

Creating Service Definitions

Service definitions can be created directly in the Service Resource Flow Description
folder or during the creation of Service Definition Diagram. 

During the creation of the service definition, the creation wizard presents two of
roles: "Consumer" and "Provider".

The "Consumer" is initiators of the service.

The "Consumer " notion is used to indicate that a service definition exists between
the consumer and the provider. When the consumer sends information requesting
a particular service, a response is expected from the "provider".

Creating an Service Definition Diagram (BPMN)

A service definition is represented by a Service Definition Diagram (BPMN).

To create a Service Definition Diagram (BPMN) from an interaction:
1. Right-click the interaction.
2. Select the associated exchange contract and, in its pop-up menu, click  

New > Diagram.
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3. Select Exchange contract diagram (BPMN) from a specific dialog 
box. Confirm that the Diagram initialization check box is selected, and 
click Create.
The diagram opens with the exchange contract frame and the two roles
representing consumer and the provider.

Defining an Operation or a Service joint action

In a Service Definition Diagram (BPMN), operations are described by:
• Operation joint actions
• Service joint actions

To create an Service joint actions:
1. Click the service joint action button and click in the diagram within the 

service defintion frame.
The creation dialog box opens.

2. Click the arrow at the right of the Specification box.
3. Select Connect in the drop-down list and select the service definition 

associated with the service joint action.
4. In the From field, select the described service definition role connected 

to the "Consumer" role of the service joint action.
5. In the To field, select the described service definition role connected to 

the "Provider" role of the service joint action.
6. Click Finish.

Creating Events

"Start" and "End" events are required in description of the service assured by the
service definition.

To create the service definition "End" event:
1. In the insert toolbar, click the Event button.
2. Click in the frame of the described service definition.

The Creation of Event dialog box appears.
3. In the Name box, enter "End".
4. In the Event Nature frame, select End.
5. Click Finish. 

The service definition "End" event appears in the diagram.

Creating a sequence flow
A sequence flow is a directional link that represents chronological organization of
the different processing steps.

To create a sequence flow:

1. Click the Sequence Flow button. 
2. Click the first object representing the start step, and, holding the mouse 

button down, draw a line to the object representing the next step.
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Creating a Gateway

Complying with BPMN standard, several gateway types are proposed in the diagram
insert toolbar.

To create a gateway:
1. Click the arrow at the right of the Gateway button in the diagram insert 

toolbar and select the gateway type you wish to create.
2. Click in the diagram.

The gateway appears in the diagram with shape appropriate to its type.

The SvcV-2 Report Template

The SvcV-2 Report Template supplies a dictionary chapter that details the services
defined to support the different operational activities of the architecture. It is
defined with two parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Service Definition Subset parameter, which is optional. This parameter is 
set with service definitions (protocols) and is used to reduce the scope of 
the study. If no value is set for this parameter, all the service definitions 
are taken into account for the Report.

The SvcV-2 Service Definition Dictionary Chapter

The Service Definition Dictionary chapter presents :
• the list of Service Definition of the architecture subset with their long 

name, short name and comment,
• for each Service Definition

• the diagrams
• a table with the list of consumers,
• a table with the list of providers,
• a table with the list of service joint actions.

The SvcV-2 Service Definition Usage Chapter

The Service Definition Usage chapter presents, for each Service Definition of the
architecture subset, a table with the list of the service definition usage in the
architecture. 
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SVCV-3A SYSTEMS-SERVICE MATRIX

The SvcV-3a Systems-Services Matrix describes the relationships among or
between systems and services in a given Architectural Description. A SvcV-3a
enables a quick overview of all the system-to-service resource interactions specified
in one or more SvcV-1 Services Context Description models.

The SvcV-3a Systems-Service Matrix Report Template

The SvcV-3a Systems-Services Matrix Report Template is defined with two
parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Service Definition Subset parameter, which is optional. This parameter is 
set with service definitions (protocols) and is used to reduce the scope of 
the study. If no value is set for this parameter, all the service definitions 
are taken into account for the Report.

The SvcV-3a Agents-Services Matrix Chapter

The Agents-Services Matrix chapter displays, for each service definition defined in
parameters, a matrix with the list of agents interacting with the service through a
Service Port. 

Depending on the role types ("Consumer / Provider" or "Emitter / Receiver") linked
to the Service Port, the service definition is considered to be "Requested" or
"Offered".

For a System Services ViewPoint, the agents are resource architecture objects
defined in "SV-1 Sytems Interface Description". For a operational Services
ViewPoint, the agents are operational nodes defined in "OV-2 Operational Resource
Flow Description".



162 MEGA Suite for DoDAF 2

9

SVCV-3B SERVICES-SERVICES MATRIX

The SvcV-3b Services-Services Matrix describes the relationships among services in
a given Architectural Description. It can be designed to show relationships of
interest, (e.g., service-type interfaces, planned vs. existing interfaces).

A SvcV-3b enables a quick overview of all the services resource interactions
specified in one or more SvcV-1 Services Context Description models.

See:
 "Creating Service Operation", page 162
 "The SvcV-3b Service Matrix Report Template", page 163
 "The SvcV-3b Service Operation Dictionary Chapter", page 163
 "The SvcV-3b Service Operation Usage Chapter", page 163

Creating Service Operation

Service Operation can be created directly in the Services-Services Matrix folder or
during the creation of Service Definition Diagram. 

During the creation of the service operation two participants are created : "Invoker
Participant" and "Invoked Participant".

The "Invoker Participant" is the initiator of the exchange.

The "Invoked Participant" notion is used to indicate that an exchange contract exists
between the consumer and the provider. When the consumer sends information
requesting a particular service, a response is expected from the provider.

The "Invoker Participant" notion is used when the exchange occurs on the
operational level to asses the possible information exchange between two nodes.
With this kind of exchange, the "Emitter" sends out information to a receiver,
however, a response from the receiver is not mandatory.

Creating an service operation diagram (BPMN)

A Service Operation is described by a Service Operation Diagram (BPMN)
representing the sequence flow of messages exchanged.

To create a Service Operation Diagram (BPMN):
1. Right-click an Exchange and select New  > Diagram
2. Select "Service Operation Diagram (BPMN)" from a specific dialog box. 

Confirm that the Diagram initialization check box is selected, and click 
Create.
The diagram opens. The frame of the service operation is positioned and
the two roles (Consumer and Supplier) are created.
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Creating a message flow with content
You must specify the message flows and their content exchanged between the two
exchange roles.

To create a message flow and its content:
1. In the exchange diagram, click the Message Flow With Content 

button.
2. Click the role that represents the message flow sender and, holding the 

mouse button down, draw a link to the message flow recipient.
The Creation of Message Flow With Content dialog box opens.

3. In the Content drop-down list, select the content you wish to associate 
with the flow. 
The message flow is displayed with its content in the diagram.

The SvcV-3b Service Matrix Report Template

The SvcV-3b Services Matrix Report Template supplies a dictionary chapter that
details the services defined to support the different operational activities of the
architecture. It is defined with two parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Service Subset parameter, which is optional. This parameter is set with 
service operations and is used to reduce the scope of the study. If no 
value is set for this parameter, all the service operations are taken into 
account for the Report.

The SvcV-3b Service Operation Dictionary Chapter

The Service Operation Dictionary chapter presents :
• the list of Service Operation of the architecture subset with their long 

name, short name and comment,
• for each Service Operation

• the diagrams,
• a table with the list of consumers,
• a table with the list of providers,
• a table with the list of service joint actions.

The SvcV-3b Service Operation Usage Chapter

The Service Operation Usage chapter presents, for each Service Operation of the
architecture subset, a table with the list of the service operation usage in the
architecture. 
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SVCV-4 SERVICES FUNCTIONALITY DESCRIPTION

The SvcV-4 Services Functionality Description describes the functions performed by
services and the service data flows among service functions (activities).

The SvcV-4 Services Functionality Description Report Template

The SvcV-4 Services Functionality Description Report Template is defined with two
parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Service Definition Subset parameter, which is optional. This parameter is 
set with service definitions (protocols) and is used to reduce the scope of 
the study. If no value is set for this parameter, all the service definitions 
are taken into account for the Report.

The SvcV-4 Service Definition Composition Hierarchy Chapter

This chapter presents the diagram for each service operation.

A table presents the hierarchy of the service definitions.



165

DoDAF 2 Service Viewpoint Models
SvcV-5 Operational Activity to Services Traceability Matrix

SVCV-5 OPERATIONAL ACTIVITY TO SERVICES 

TRACEABILITY MATRIX

The SvcV-5 Operational Activity to Services Traceability Matrix presents a mapping
of services (activities) back to operational activities (activities).

The SvcV-5 Operational Activity to Services Traceability Matrix 
Report Template

The SvcV-5 Operational Activity to Services Traceability Matrix Report Template is
defined with two parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Service Definition Subset parameter, which is optional. This parameter is 
set with service definitions (protocols) and is used to reduce the scope of 
the study. If no value is set for this parameter, all the service definitions 
are taken into account for the Report.

• Service Process Subset parameter, which is optional. This parameter is 
set with service processes and is used to reduce the scope of the study. 
If no value is set for this parameter, all the service processes of the 
architecture are taken into account for the Report.

The SvcV-5 System Processes to System Services Traceability 
Chapter

The "System Processes to System Services Traceability" chapter presents a matrix
showing the service invokation within the processes.
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SVCV-6 SERVICES RESOURCE FLOW MATRIX

The SvcV-6 Services Resource Flow Matrix provides details of service Resource Flow
elements being exchanged between services and the attributes of that exchange.

The SvcV-6 Services Resource Flow Matrix Report Template

The SvcV-6 Services Resource Flow Matrix Report Template is defined with two
parameters:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

• Content Subset parameter. This parameter is set with Work products 
(Contents) representing the exchanged flow.

The SvcV-6 Service Information Exchange DictionaryChapter

The first paragraph of the Service Information Exchange Dictionary chapter
presents a table with the Work products (Contents) in the architecture. The
comments for contents are also displayed.

The following paragraphs are dedicated to each work product. A table lists the
exchanges the work product is involved in, especially the source element and the
target element.
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SVCV-7 SERVICES MEASURES MATRIX

The SvcV-7 Services Measures Matrix is dedicated to the measures (metrics) of
Services Model elements for the appropriate timeframe(s).

A SvcV-7 Viewpoint is based on requirement concept. 

Creating Requirements

Requirements can be created directly in the "SvcV-7 Services Measures Matrix"
folders. 

The SvcV-7 Services Measures Matrix Report Template

The SvcV-7 Services Measures Matrix Report Template is defined with only one
parameter:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

The SvcV-7 Services Measures Chapter

The Service Measures chapter presents a table with the structure of the
requirements in the architecture. The comments for these service definitions are
also displayed.
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SVCV-8 SERVICES EVOLUTION DESCRIPTION

The SvcV-8 Services Evolution Description describes the planned incremental steps
toward migrating a suite of services to a more efficient suite or toward evolving
current services to a future implementation.

 For further information on Master Plan creation and display with 
MEGA Suite for DoDAF 2, see "SV-8 Systems Evolution Description", 
page 206.



169

DoDAF 2 Service Viewpoint Models
SvcV-9 Services Technology & Skills Forecast

SVCV-9 SERVICES TECHNOLOGY & SKILLS FORECAST

The SvcV-9 Services Technology & Skills Forecast defines the underlying current
and expected supporting technologies that have been targeted using standard
forecasting methods. 

 For further information on this service Viewpoint, see "SV-9 
Systems Technology and Skills Forecast", page 211.
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SVCV-10A SERVICES RULES MODEL

The SvcV-10a Services Rules Model is one of three models used to describe service
functionality. It identifies Constraints that are imposed on systems functionality
due to some aspect of system design or implementation.

Creating a Constraint

To create a Constraint from the SvcV-10a Services Rules Model folder of the
"Service Viewpoint (System)" folder :

1. Right click the Service Constraints folder and select New > Service 
Constraints.

2. Name the Service Constraint.
3. Click OK.

The new Service Constraint appears in the folder of the Service from
which it was created.

The SvcV-10a Services Rules Model Report Template

The SvcV-10a Services Rules Model Report Template is defined with only one
parameter:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

The SvcV-10a Resources Constraints Specification Chapter

The Resources Constraints Specification chapter presents a table with the
constraints defined for the architecture. The comments for these constraints are
also displayed.
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SVCV-10B SERVICES STATE TRANSITION DESCRIPTION

The SvcV-10b Services State Transition Description is one of three models used to
describe service functionality. It identifies responses of services to events.

With MEGA Suite for DoDAF 2, this viewpoint describes the specific behaviors
(state machines) attached to services. A behavior is a specific concept used to
describe how a service reacts to different events from start points to end points.

 The terms "state machine" and "behavior" are used 
interchangeably in this section.

Creating State Machines

To create a State Machine from the ScvV-1Ob Service State Transition folder of
the "Service Viewpoint (System)" folder :

1. Right click the System State Machines folder and select New > State 
Machine.

2. Name the State Machine.
3. Click OK.

The new State Machine appears in the folder of the Service from which it
was created.

 For further information on State Machine creation and descritpion 
with MEGA Suite for DoDAF 2, see "Creating State Machines", page 
137.

The SvcV-10b Services State Transition Description Report 
Template

The SvcV-10b Services State Transition Description Report Template is defined with
only one parameter:

• The Architecture parameter, which specifies the architecture to be 
analyzed.

The SvcV-10b Resources State Transition Description Chapter

The Resources State Transition Description chapter presents lists all the state
machines attached to the selected activities. The chapter starts with a simple table
of the state machines (short name, long name, comment) and the linked activities.

For each state machine which has a describing diagram or at least one event, a
dedicated paragraph is generated with its title being the name of the state machine.
This paragraph displays the comment of the state machine and the (commented)
describing diagrams. It also lists the events (states) with their name and comment.
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SVCV-10C SERVICES EVENT-TRACE DESCRIPTION

The SvcV-10c Services Event-Trace Description is used to describe service
functionality. It identifies service-specific refinements of critical sequences of events
described in System Services.

 For further information on this service Viewpoint, see "SV-10c 
Systems Event-Trace Description", page 215.
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The DoDAF models in the Standards Viewpoint represent the set of rules that govern the
arrangement, interaction, and interdependence of parts or elements of the Architecture Description.
These sets of rules can be specified at the enterprise level and applied to each solution, while each
solution's architecture description depicts only those rules pertinent to the architecture described.
The purpose of the Standard Viewpoint is to ensure that a solution satisfies a specified set of
operational or capability requirements. The Standards Models capture the doctrinal, operational,
business, technical, or industry implementation guidelines upon which engineering specifications
are based, common building blocks are established, and solutions are developed. It includes a
collection of the doctrinal, operational, business, technical, or industry standards, implementation
conventions, standards options, rules, and criteria that can be organized into profiles that govern
solution elements for a given architecture. DoD requires that the Technical Standards of models be
produced from the DoD IT Standards Registry (DISR) to determine the minimum list of standards
that should be used to design new architecture descriptions. 

The DoDAF Standard Viewpoint models that can be generated in the MEGA Suite for DoDAF 2 are
the:

 "StdV-1 - Standards Profile", page 174
 "StdV-2 Standards Forecast", page 176
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STDV-1 - STANDARDS PROFILE

The Standards Profile model (StdV-1) provides a list of the technical, operational
and business standards that guide and constrain the implementation of systems as
defined in the various models of the System Viewpoint. 

See:
 "Defining the Standards", page 174
 "The StdV-1 Template Report", page 175
 "The StdV-1 Standards Profile Chapter", page 175

Defining the Standards

In the MEGA Suite for DoDAF 2 application, a standard is a specific independent
notion that can be created in order to establish a list. The standard notion
encompasses all the technical and non technical items that are recommended by the
company for designing the architecture.

A standard can be linked to the definition of repository items such as applications,
databases, artifacts, resource architectures and communication protocols. This link,
even though non mandatory, is useful in helping to provide a more accurate
definition of the standard. For example, if a computing engineer process states that
it is mandatory to use UML for application design, then UML can be defined in the
tool as a standard. This standard will not, however, be linked to any object of the
repository.

The sections below indicate how standards can be described. For more information
on the metamodel behind the standard notion, see "StdV-1 Standards Profile", page
260 and "StdV-2 Standards Forecast", page 260.

Standard Decomposition

A standard can be decomposed into sub-parts. Each part is called a Standard
Component. A standard component can reference another existing standard, in
which case the name of the component can be automatically created from the name
of the standard on which it is based (this is not mandatory and the user can rename
the component).

For example, the DNS standard is defined from different smaller standards:
• DNS

• IETF STD 13:1987
• RFC 1034:1987
• RFC 1035:1987
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Standard and Approving Organizations

A standard is approved/created by an organization. For example, HTML is created
by the W3C and UML is created by the OMG.

Standard Usability

Declaring a list of standards can be useful, however, comparing this list to the
standard that is used to implement a resource architecture is more beneficial. This
comparison can be made if the components of the architecture detail the standards
on which they are based. To make the comparison, a special link exists between
architecture items and standards.

 An application, for example, can be cited as a defining item for a 
standard while another application can be based on this standard.

Example:

The Open Office tool can be cited as the standard documentation tool while a
business application used to generate meeting reports can be based on this
standard.

The StdV-1 Template Report

The StdV-1 report template produces a report that gives a graphical understanding
of the evolution of the standards in relation to planned systems of the architecture.

The template uses two parameters to generate the reports:
• The first parameter is the Architecture which indicates the architecture to 

be analyzed.
• The Standard Subset parameter. This is an optional value that is used to 

reduce the scope of the study. This parameter is set with the standards 
described in the architecture. In this case, the StdV-1 report focuses on 
this set of standards. The MEGA objects used to set this parameter are 
standards.

The StdV-1 Standards Profile Chapter

This chapter presents the standards and guidelines that apply to the analyzed
architecture(s). Paragraphs dedicated to each standard follow, listing the elements
that use the stanard in question.
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STDV-2 STANDARDS FORECAST

The purpose of the Standards Forecast model (StdV-2) is to identify emerging,
obsolete and fragile standards, and to assess their impact on the architecture and
its constituent elements. A forecast that addresses emerging standards gives insight
into the direction that the project will take.

In the MEGA Suite for DoDAF 2 application, the standards forecast gives the
details of a specific type of master plan: the standard master plan. When a master
plan is created from the StdV-2 folder in the DoDAF 2.0 navigation tree, this master
plan automatically has the "Standard" type checked. For other kinds of master plans
the user can check other types, however, the "Standard" type remains checked.

The standards defined in the StdV-1 model can then be planned in the different
states. MEGA provides a default state and for standards. The following states are
normally appropriate for standards:

Similarly to the "preparation", "production", and "retirement" states that can be
linked, the states above are linked to equivalent stereotypes that classify them:

• Envisioning, Emerging: the standard is not available in a stable state 
for users but work is being done to achieve this stable state. The applied 
Stereotype is "Preparation".

• Confirmed: the standard is in a mature state and can be confidently 
used by the users. The applied Stereotype is "Production".

• Obsolete: the standard is no longer available and the user should 
consider another standard or a new release of the standard. The applied 
Stereotype is "Retirement".

See:
 "Milestones and Time periods", page 176
 "Customization", page 177
 "The StdV-2 Report Template", page 177
 "The StdV-2 Standards Forecast Chapter", page 177
 "The StdV-2 Standard Forecast Description Chapter", page 177

Milestones and Time periods

Business milestones are usually useless in the description of standard forecasts as
they are not developed by the designer team but supplied by external organizations
(for example HTML is defined by the W3C). So, even though milestones can still be
defined in standard master plans, it is recommended that you only have a few of
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them representing the very big steps in the standard evolution and that you set the
start and end dates on the periods to match the different states of the standard.

Customization

Similarly to any time-dependent item, a specific state machine can be created with
a set of customer-defined states. This machine can then be attached to the standard
metaclass if it applies to any standard (verify that the designer has the appropriate
rights to see the metaclass) or directly to a specific standard. If defining a new set
of states, check that all the defined states are classified via the three stereotypes:
"Preparation", "Production" and "Retirement".

 The Setup tab of a behavior item allows you to set the metaclasses 
that can be associated to the states. For more information, see the 
MEGA IT Planning user manual, "Describing a Master Plan" chapter, 
"Object life cycle status" paragraph.

The StdV-2 model comes with a report template that produces a report with two
chapters.

The StdV-2 Report Template

The StdV-2 report template produces a report that gives a graphical understanding
of the evolution of the standards in relation to planned systems of the architecture.

The template uses two parameters to generate the report chapters:
• The first parameter is the Architecture which indicates the architecture to 

be analyzed.
• The second parameter, Master Plan Subset, is optional. This parameter 

indicates the master plans to be analyzed. Groups of master plans are 
considered in reports to enable plan comparisons. If no master plan is 
set, all the master plans of the architecture are taken into account and 
the collected master plans are compared individually.

The StdV-2 Standards Forecast Chapter

This chapter presents a view of the standards in a Gantt chart. 

This chart provides a detailed representation of the possible conflicts that may occur
during the evolution of the standards and the systems planned in the SV-8 model
or the technologies defined in the SV-9 model.

The StdV-2 Standard Forecast Description Chapter

The standard standard forecast description chapter displays a table with milestones
as column headers and Standards in rows. The states occupy the cells between the
standards and the milestones.
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This chapter is particularly useful when the StdV-2 master plan is also an
aggregation of a sub-master plan. In this case the table displays the standards as
they are planned in the sub-master plans.

It is also very useful when it shows the potential availability conflicts between
standards and other dependent items.
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DODAF 2.0 SYSTEM VIEWPOINT MODELS

The DoDAF 2.0 System Viewpoint models that can be generated in the MEGA Suite for DoDAF 2
are the:

 "SV-1 Systems Interface Description", page 180
 "SV-2 Systems Resource Flow Description", page 188
 "SV-3 Systems-Systems Matrix", page 192
 "SV-4 Systems Functionality", page 194
 "SV-5a Operational Activity to Systems Function Traceability Matrix", page 199
 "SV-5b Operational Activity to Systems Traceability Matrix", page 201
 "SV-6 Systems Data Exchange Matrix", page 202
 "SV-7 Systems Measures Matrix", page 205
 "SV-8 Systems Evolution Description", page 206
 "SV-9 Systems Technology and Skills Forecast", page 211
 "SV-10a Systems Rules Model", page 212
 "SV-10b Systems State Transition Description", page 214
 "SV-10c Systems Event-Trace Description", page 215
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SV-1 SYSTEMS INTERFACE DESCRIPTION

The purpose of the System Interface Description is to illustrate which systems
collaborate, and in what way they do so, to support the operational domain’s
information and information exchange needs as defined in the Operational View;
most notably in OV-2 and OV-3.

SV-1 links together the Operational Viewpoint and the System Viewpoint by
depicting which systems and system connections realize which information
exchanges. A system is defined as any organized assembly of resources and
procedures united and regulated by interactions or interdependences to accomplish
a set of specific functions. The term system in the System Viewpoint is used to
denote software intensive systems (Federation of Systems (FoS), System of
Systems (SoS), subsystems, and system components) and can include web
services, network components and other hardware components, such as routers,
satellites and network segments. 

A system’s services are accessed through the system’s interfaces. Generally, an
interface is a contract between the providers and consumers of (system) services.
With software intensive systems, this contract is a declaration of a coherent set of
public system functionalities. The system’s interfaces specify the system’s
behaviour without specifying implementation aspects. An SV-1 connection between
system interfaces is the systems representation of an OV-2 needline or OV-3
information exchange. A single needline or information exchange may translate into
multiple connections between system interfaces. 

An SV-1 documents:
• Systems and their interfaces
• System use dependencies between interfaces
• System collaborations (systems interacting with each other through their 

interfaces)
• Distributions of software systems to hardware systems
• Connections between hardware systems
• Patterns (optional); standard system collaborations that have been 

proven to be sound solutions to known problems).
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See:
 "Creating Capability Configurations", page 181
 "The SV-1 Report Template", page 182
 "The SV-1 Application Composition Hierarchy Chapter", page 182
 "The SV-1 Application Specialization Hierarchy Chapter", page 182
 "The SV-1 Application Generalization Hierarchy Chapter", page 182
 "The SV-1 Application Dictionary Chapter", page 183
 "The SV-1 Application Exchange Balance Chapter", page 183
 "The SV-1 Artifact Composition Hierarchy Chapter", page 183
 "The SV-1 Artifact Specialization Hierarchy Chapter", page 183
 "The SV-1 Artifact Generalization Hierarchy Chapter", page 183
 "The SV-1 Artifact Dictionary Chapter", page 184
 "The SV-1 Artifact Exchange Balance Chapter", page 184
 "The SV-1 Resource Architecture Composition Hierarchy Chapter", page 184
 "The SV-1 Resource Architecture Specialization Hierarchy Chapter", page 184
 "The SV-1 Resource Architecture Generalization Hierarchy Chapter", page 184
 "The SV-1 Resource Architecture Dictionary Chapter", page 185
 "The SV-1 Resource Architecture Exchange Balance Chapter", page 185
 "The SV-1 System Exchange Chapter", page 185
 "The SV-1 System Exchange Compliance Chapter", page 185

Creating Capability Configurations

A capability configuration consists of a Resource Architecture attached to a
capability of the DoDAF architecture. This resource architecture, which is created in
the SV-1 model, usually presents solutions for the operation of the architecture with
different deliverables. These deliverables can include projects. Projects are defined
in the PV-1 model.

To create a capability configuration :
1. Expand the Systems Viewpoint, SV-1 Systems Interface 

Description and Resource Architectures and All Resource 
Architectures folders.

2. Right-click the resource architecture concerned and select Properties.
3. In the Characteristics tab, Configured Capabilty box, use the New or 

Connect button to create or link the capability to be included in the 
capability configuration.
The new capability configuration automatically appears in the CV-3
Capability Phasing Capability Configurations folder. It takes the name
of the architecture resource that supports the capability.

 Capability configurations can also be created in the creation wizard 
during the creation of resource architectures.
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The SV-1 Report Template

The SV-1 report template synthesizes information about the composition and
interaction of systems. This template is composed of four parameters:

• The Architecture to be analyzed.
• The Application Subset. This parameter is optional and is used to reduce 

the scope of the study to a subset of the different applications used in 
the architecture.

• The Artifact Subset. This is also an optional parameter. This is used to 
reduce the scope of the study to a selection of artifacts. If no artifact is 
selected, all the artifacts of the architecture are included in the analysis. 

• The Resource Architecture Subset, which is also optional. This parameter 
is set with a subset of the resource architectures defined in the 
architecture. If this parameter is not set, all the resource architectures of 
the architecture are taken into account in the analysis.

The SV-1 Application Composition Hierarchy Chapter

This chapter gives a view of the application hierarchies. Application Tree Diagrams
are displayed with the complete structure, taking into account the optional scope.

The SV-1 Application Specialization Hierarchy Chapter

The SV-1 application specialization hierararchy chapter shows how the applications
of the architecture are specialized.

The applications are presented in a table along with their comments and the library
to which they belong. If a variant of an application is created, the varied application
is presented in the table along with its variant.

To create new specializations (variants), use the New > Variant command on the
application to be varied (specialized).

The SV-1 Application Generalization Hierarchy Chapter

The SV-1 application generalization hierararchy chapter shows how the applications
of the architecture are generalized.

The applications are presented in table form along with their comments and the
library to which they belong. If a variant of an application exists, this variant is also
presented in the table along with the varied application (application from which the
variant was created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).
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The SV-1 Application Dictionary Chapter

The Application Dictionary chapter lists the applications defined in the architecture
in an alphabetical table. This enables the retrieval of items for which the names are
known. It also displays the Application Structure diagram for the different
applications.

The SV-1 Application Exchange Balance Chapter

This chapter is used to verify that the exchanges defined between applications are
correctly designed. All the incoming and outgoing exchanges of the applications are
compared and examined to reveal missing as well as unnecessary information for
the exchange design. The chapter lists all the internal and outside messages and
interactions that detail the selected applications.

The SV-1 Artifact Composition Hierarchy Chapter

This chapter gives a view of the artifact hierarchies. Artifact Tree Diagrams are
displayed with the complete structure, taking into account the optional scope.

The SV-1 Artifact Specialization Hierarchy Chapter

The SV-1 artifact specialization hierararchy chapter shows how the artifacts of the
architecture are specialized.

The artifacts are presented in a table along with their comments and the library to
which they belong. If a variant of an artifact is created, the varied artifact is
presented in the table along with its variant.

To create new specializations (variants), use the New > Variant command on the
system process to be varied (specialized).

The SV-1 Artifact Generalization Hierarchy Chapter

The SV-1 artifact generalization hierararchy chapter shows how the artifacts of the
architecture are generalized.

The artifacts are presented in table form along with their comments and the library
to which they belong. If a variant of an artifact exists, this variant is also presented
in the table along with the varied artifact (artifact from which the variant was
created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).
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The SV-1 Artifact Dictionary Chapter

The Artifact Dictionary chapter lists the artifacts defined in the architecture in an
alphabetical table. This enables the retrieval of items for which the names are
known. It also displays the Artifact Structure diagram for the different artifacts.

The SV-1 Artifact Exchange Balance Chapter

This chapter is used to verify that the exchanges defined between artifacts are
correctly designed. All the incoming and outgoing exchanges of the artifacts are
compared and examined to reveal missing as well as unnecessary information for
the exchange design. The chapter lists all the internal and outside messages and
interactions that detail the selected artifacts.

The SV-1 Resource Architecture Composition Hierarchy Chapter

This chapter gives a view of the resource architecture hierarchies. Resource
Architecture Tree Diagrams are displayed with the complete structure, taking into
account the optional scope.

The SV-1 Resource Architecture Specialization Hierarchy Chapter

The SV-1 resource architecture specialization hierararchy chapter shows how the
resource architectures of the architecture are specialized.

The resource architectures are presented in a table along with their comments and
the library to which they belong. If a variant of a resource architecture is created,
the varied resource architecture is presented in the table along with its variant.

To create new specializations (variants), use the New > Variant command on the
system process to be varied (specialized).

The SV-1 Resource Architecture Generalization Hierarchy Chapter

The SV-1 resource architecture generalization hierararchy chapter shows how the
resource architectures of the architecture are generalized.

The resource architectures are presented in table form along with their comments
and the library to which they belong. If a variant of a resource architecture exists,
this variant is also presented in the table along with the varied resource architecture
(resource architecture from which the variant was created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).
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The SV-1 Resource Architecture Dictionary Chapter

The Resource Architecture Dictionary chapter lists the resource architectures
defined in the architecture in an alphabetical table. This enables the retrieval of
items for which the names are known. It also displays the Resource Architecture
Structure diagram for the different resource architectures.

The SV-1 Resource Architecture Exchange Balance Chapter

This chapter is used to verify that the exchanges defined between resource
architectures are correctly designed. All the incoming and outgoing exchanges of
the resource architectures are compared and examined to reveal missing as well as
unnecessary information for the exchange design. The chapter lists all the internal
and outside messages and interactions that detail the selected resource
architectures.

The SV-1 System Exchange Chapter

This chapter shows the diagrams that display information exchanges between
systems. It also details the information exchange between the selected systems. All
interactions connecting systems are displayed in a list with their name, the source,
and target of the exchange and the information elements.

The SV-1 System Exchange Compliance Chapter

This chapter indicates the level of compliance between the need to exchange
information from one system to another and the information actually exchanged
through the implemented missions.

Tasks supported by the systems actually exchange information within the context
of designed missions. This information is compared with the need defined in the
needlines/interactions. Missing or unexpected information is detected.

This chapter relies on the systems defined in the SV-1 model as well as the system
processes that describe how missions are performed. These processes are described
in detail in SV-4, however, a brief description is necessary to aid in understanding
the content of this chapter.

A system structure does not indicate how missions are performed. It only describes
the systems involved in the mission and how they are structured. Through
interactions, you can guess the potential information exchanges that occur between
systems. To add a dynamic perspective to systems, a process must be described
(see the SV-4 model). This process is composed of tasks that exchange information.
Information is actually exchanged in the process while the system structure only
describes the ability to perform such exchanges. 
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Tasks are performed under the control of resource architectures, applications and
artifacts.

The System exchange compliance chapter identifies three states for the information
exchange:

• Information Exchange Correctly Designed: an information item is 
defined at both the system and the process levels.

• Missing Information: an information item can potentially be 
exchanged between two systems, however, there is no process available 
to perform this exchange. The question is therefore, whether the 
interface described between the two systems is still useful.

• Unexpected Information: an information item is exchanged in a 
process between two tasks, however, there is no interaction between the 
systems carrying out the tasks. The question is therefore, should the 
information be exchanged in this manner in the process and must the 
interaction be reviewed to depict the ability to make such an exchange.
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The figure below is an example of an SV-1 system exchange compliance chapter.
The table displays expected and correct content.

Example of an SV-1 System Exchange Compliance Chapter
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SV-2 SYSTEMS RESOURCE FLOW DESCRIPTION

The SV-2 model specifies the system resource flows that exist between systems and
may also list the protocol stacks used in connections.

The purpose of this model is to define the connectivity requirements between nodes.
This model is then used to estimate the requirements for physical routing and
bandwidth. An SV-2 model provides a different viewpoint of information already
specified in the OV-2, OV-3 and SV-1.

SV-2 is useful when planning physical connections and routings between nodes. It
is also intended to assist with the analysis of the connectivity between systems
within or between nodes.

See:
 "The SV-2 Report Template", page 188
 "The SV-2 System Ports Dictionary Chapter", page 189
 "The SV-2 System Ports by Application Dictionary Chapter", page 189
 "The SV-2 System Ports by Artifact Dictionary Chapter", page 189
 "The SV-2 System Ports by Resource Architecture Dictionary Chapter", page 189
 "The SV-2 Communication Channels Dictionary Chapter", page 190
 "The SV-2 Communication Channels by Application Dictionary Chapter", page 190
 "The SV-2 Communication Channels by Artifact Dictionary Chapter", page 190
 "The SV-2 Communication Channels by Resource Architecture Dictionary 

Chapter", page 190

The SV-2 Report Template

The SV-2 report template synthesizes information about the connectivity between
systems.

The parameters taken into account for the report are:
• The Architecture to be analyzed.
• The Application Subset. This parameter is optional and is used to reduce 

the scope of the study to a subset of the different applications used in 
the architecture.

• The Artifact Subset. This is also an optional parameter. This is used to 
reduce the scope of the study to a selection of artifacts. If no artifact is 
selected, all the artifacts of the architecture are included in the analysis. 

• The Resource Architecture Subset, which is also optional. This parameter 
is set with a subset of the resource architectures defined in the 
architecture. If this parameter is not set, all the resource architectures of 
the architecture are taken into account in the analysis.
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The SV-2 System Ports Dictionary Chapter

This chapter lists the communication ports of the architecture in alphabetical order.
This information is presented in a table. A paragraph dedicated to each of the
retrieved communication ports is displayed in the report. This paragraph includes:

• The physical resource to which the communication port belongs with its 
name and comment

• The communication channel to which the port is attached with its name 
and comment

The SV-2 System Ports by Application Dictionary Chapter

This chapter lists all the applications to which the communication ports retrieved
during the study are linked.

A paragraph dedicated to each application is displayed with the name and comment
of the communication ports and communication protocols that belong to it. The
Application Structure Diagram for each application is also displayed.

The SV-2 System Ports by Artifact Dictionary Chapter

This chapter lists all the artifacts of the architecture (or those defined in the analysis
scope) linked to communication ports.

A paragraph dedicated to each artifact is displayed with the following:
• The Artifact Assembly Diagram for the artifact
• The "owned" communication ports of the artifact with their name and 

comment
• The communication protocols that the different communication ports 

use, with their name and comment

The SV-2 System Ports by Resource Architecture Dictionary 
Chapter

This chapter lists all the resource architectures of the architecture (or those defined
in the analysis scope) linked to communication ports.

A paragraph dedicated to each resource architecture is displayed with the following:
• The Resource Architecture Structure Diagram for the resource 

architecture concerned
• The "owned" communication ports of the resource architecture with their 

name and comment
• The communication protocols that the different communication ports 

use, with their name and comment
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The SV-2 Communication Channels Dictionary Chapter

This chapter provides a list of the communication channels of the architecture with
their "End points" (artifact component, communication channel, etc). This
information is presented in a table. A paragraph dedicated to each of the retrieved
communication channels is displayed in the chapter. This paragraph includes:

• The physical resource to which the communication channel belongs, with 
its name and comment

• The communication ports that use the communication channel, with their 
name and comment

• The communicating elements, e.g. artifact, linked to the communication 
channel

• The communication protocols used by the communication ports, with 
their name and comment

The SV-2 Communication Channels by Application Dictionary 
Chapter

This chapter lists all the applications to which the communication channels retrieved
during the study are linked.

A paragraph dedicated to each application is displayed with the name and comment
of the communication channel and communication protocols that belong to it. The
Application Structure Diagram for each application is also displayed.

The SV-2 Communication Channels by Artifact Dictionary Chapter

This chapter lists all the artifacts of the architecture (or those defined in the analysis
scope) linked to communication channels.

A paragraph dedicated to each artifact is displayed with the following:
• The Artifact Assembly Diagram for the artifact
• The "owned" communication channels of the artifact with their End 

points
• The communication protocols used, with their name and comment

The SV-2 Communication Channels by Resource Architecture 
Dictionary Chapter

This chapter lists all the resource architectures of the architecture (or those defined
in the analysis scope) linked to communication channels.
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A paragraph dedicated to each resource architecture is displayed with the following:
• The Resource Architecture Structure Diagram for the resource 

architecture
• The "owned" communication channels of the resource architecture with 

their End points (e.g. Architecture use, physical asset, etc.)
• The communication protocols used, with their name and comment
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SV-3 SYSTEMS-SYSTEMS MATRIX 

SV-3 provides details about the interface characteristics described in SV-1 for the
architecture, arranged in matrix form.

SV-3 gives a quick overview of all the interface characteristics presented in multiple
SV-1 diagrams. The matrix form facilitates making rapid assessments of the
potential commonalities and redundancies (or, if fault-tolerance is desired, the lack
of redundancies).

SV-3 is a useful tool for managing the evolution of systems and system
infrastructures, the insertion of new technologies/functionalities, and the
redistribution of systems and processes with evolving operational requirements.

Users can easily access SV-3 reports in the DoDAF 2.0 navigation tree and on the
DoDAF 2.0 start page. No other objects are displayed since the aim is to synthesize
information already designed in the SV-1 section.

See:
 "The SV-3 Report Template", page 192
 "The SV-3 Systems to Systems Channel Matrix Chapter", page 192
 "The SV-3 systems to Systems Interaction Matrix Chapter", page 193

The SV-3 Report Template

The SV-3 Report template synthesizes information about the system interfaces in a
matrix.

The first parameter is used to indicate the architecture to be analyzed.

The second parameter, the System Subset is optional. This is used to reduce the
scope of the study to a subset of the systems defined in the architecture. If this
parameter is not set, all the systems defined in the architecture are taken into
account. The subset can be defined by setting systems.

The SV-3 Systems to Systems Channel Matrix Chapter

This chapter displays a squared matrix of systems which indicates if systems are
connected to other systems through communication channels. The systems are
organized in rows and columns.

Each cell in the matrix represents the communication channel between a system in
row and a system in a column. If a communication channel exists between two
systems, the corresponding cell contains a black dot.

Diagonal cells dealing with the same source and target are grayed.
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The SV-3 systems to Systems Interaction Matrix Chapter

This chapter displays the system components that should be able to interact with
each other. The system interaction information is displayed in a squared matrix. The
selected systems are organized in rows and columns.

Each cell in the matrix represents the interface between a system in a row and a
system in a column. If an interface exists, the corresponding cell contains a black
dot.

Diagonal cells dealing with the same source and target are grayed.

Example of the SV-3 Systems to Systems Interaction Matrix
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SV-4 SYSTEMS FUNCTIONALITY

The SV-4 model documents system functional hierarchies and system functions, and
the system data flows between them. While SV-1 products describe the available
interface between systems, they do not explain how these interfaces are used to
exchange information or how data flows between the systems. The SV-4 model
shows how data is transferred through system functions and binds these system
functions to the system. Similarly, data transferred by functions can be described in
a service perspective.

The MEGA Suite for DoDAF 2 models system functions and their flow of data via
system processes. System processes are the system counterpart to operational
processes. A system process describes a set of system functions (tasks) performed
by the IT system. The system functions are linked to each other by messages that
transport data.

System process modeling is similar to OV-5b and OV-6a process modeling (BPMN-
based).

The figure below illustrates the "Maritime Rescue" system process which is involved
in the performance of several tasks. These tasks are placed on the different
participants which are more or less responsible for carrying them out. The different
information exchanged between the tasks and the corresponding data flow is
indicated in the diagram.

Example of a System Process Diagram
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See:
 "The SV-4 Report Template", page 195
 "The SV-4 System Function Composition Hierarchy Chapter", page 195
 "The SV-4 System Function Specialization Hierarchy Chapter", page 195
 "The SV-4 System Function Generalization Hierarchy Chapter", page 196
 "The SV-4 System Function Dictionary Chapter", page 196
 "The SV-4 System Function Exchange Chapter", page 196
 "The SV-4 System Function Exchange Balance Chapter", page 196

The SV-4 Report Template

The SV-4 report template synthesizes information about the system functions and
the data flowing between them.

The first parameter indicates the architecture to be analyzed.

The second parameter, called the System Process Subset, is optional. This is used
to reduce the scope of the study to a subset of the system processes defined in the
architecture. If this parameter is not set, all the system processes defined in the
architecture are taken into account.

The SV-4 System Function Composition Hierarchy Chapter

This chapter expands the hierarchy of system functions. It details the hierarchical
structure of the system processes and their assigned tasks. The performance of
system functions can be delegated to other system processes. This results in a
system functions tree where system functions are indirectly connected by sub-
system processes.

The chapter starts from (explicitly or implicitly) selected system processes. For each
system process a tree structure of the system function is displayed with its name
and comment. The tasks and performing system processes are also included in the
tree.

The SV-4 System Function Specialization Hierarchy Chapter

The SV-4 system function specialization hierararchy chapter shows how the system
processes of the architecture are specialized.

The system processes are presented in a table along with their comments and the
library to which they belong. If a variant of a system proces is created, the varied
system process is presented in the table along with its variant.

To create new specializations (variants), use the New > Variant command on the
system process to be varied (specialized).
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The SV-4 System Function Generalization Hierarchy Chapter

The SV-4 system function generalization hierararchy chapter shows how the system
processes of the architecture are generalized.

The system processes are presented in table form along with their comments and
the library to which they belong. If a variant of a system process exists, this variant
is also presented in the table along with the varied system process (system process
from which the variant was created).

To add a new generalization, use the Connect > Variant Of command of the
specialized item (variant).

The SV-4 System Function Dictionary Chapter

This chapter lists the flows of data exchanged by the system function.

A list of the system processes retrieved during the analysis is presented.

If all the system processes of the architecture are retrieved (no value for the sub-
system process parameter), the system process diagrams of the root system
process are displayed in the report.

A paragraph dedicated to each of the selected or retrieved system processes is
displayed in the report. This paragraph includes:

• The system process with its name and comment
• The system process diagrams which describe the system process
• The list of tasks organized by the system process with the name and 

comment of each task
• The list of all the tasks retrieved in the architecture

The SV-4 System Function Exchange Chapter

The SV-4 System Function Exchange chapter lists the interactions that are set
between the tasks of system processes. It shows the diagrams that display
information exchanges between system processes and system functions. It also
details the information exchange between the selected tasks. All messages or
interactions connecting tasks are displayed in a list with their name, comment and
source and target and the information element that is exchanged.

The SV-4 System Function Exchange Balance Chapter

This chapter helps to define the compliance of the exchanges defined within system
processes and the exchanges received and /or sent by these system processes. The
report lists all the exchanges modeled within and outside each system process
between the contained and detailing tasks.
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All incoming and outgoing exchanges defined inside and outside of the system
process are compared. This comparison enables the user to determine missing as
well as unnecessary information for the exchange design. 

Different icons with arrows are used to give valid information relating to each
message and interaction. These arrows aid in the comparison making process.

Example of the SV-4 System Function Exchange Balance Chapter

Retrieving Interesting Information in the SV-4 Report Chapters

To ensure that interesting information appears in the report chapters, and especially
the SV-4 System Function Exchange and System Function Exchange Balance
chapters, the modeler should ensure that the system processes to be studied and /
or included in the report at least have the following data:

• There should be tasks that "call" other system processes
• There should be messages with content between at least two tasks of a 

system process

It can be argued that the most interesting section of the SV-4 System Function
Exchange chapter is the table that lists the different exchanges that are sent from
or to system processes and tasks with the information element. If there are no
messages with content between tasks, there will be no exchange to show in the
chapter. 

If there are no called system processes for tasks, and if the called system processes
have not been described or modeled, in other words are empty, the exchanges
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concerning these system processes are excluded from the SV-4 System Function
Exchange Balance chapter. Likewise if there are no incoming or outgoing exchanges
to study there will be nothing to display in this chapter.
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SV-5A OPERATIONAL ACTIVITY TO SYSTEMS FUNCTION 

TRACEABILITY MATRIX

The SV-5a Operational Activity to Systems Function Traceability Matrix represents
the mapping of operational activities to system functions thus demonstrating how
system functions support the operational activities.

Operational activities do not necessarily map one-to-one with system functions and
as such SV-5a forms an integral part of the eventual complete mapping from
operational capabilities to systems. SV-5a is an explicit link between the Operational
Viewpoint and the System Viewoint. The operational activities are drawn from OV-
5a and 5b while the system functions are drawn from SV-4. The relationship
between operational activities and system functions can also be many-to-many
where one operational activity may relate to multiple system functions, and one
system function may relate to multiple operational activities.

See:
 "The SV-5a Report Template", page 199
 "The SV-5a Operational Activity to Systems Function Traceability Matrix Chapter", 

page 200

The SV-5a Report Template

The SV-5a report template generates a matrix of the mapping between a group of
system functions and activities.

• The first parameter indicates the Architecture to be analyzed.
• The second parameter, the Operational Activity Subset, is optional. It 

restricts the study to a subset of the operational activities. If this 
parameter is not set, all the activities defined in the architecture are 
taken into account. This can result in a large matrix. To focus on a 
specific part of the architecture, the parameter value is defined using 
either activities or business capabilities (business processes).

• The third parameter, the System Task Subset, which is also optional, is 
used to reduce the scope of the study to a subset of the system functions 
defined in the architecture. If this parameter is not set, all the system 
functions defined in the architecture are taken into account. The 
parameter value is defined by setting system capabilities as shortcuts to 
all the contained system functions.
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The SV-5a Operational Activity to Systems Function Traceability 
Matrix Chapter

This chapter displays a matrix where rows contain the selected system functions and
columns contain the operational activities. Mappings between system functions and
operational activities can be indicated in each cell of the matrix. A checkmark is
displayed if a mapping exists. 
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SV-5B OPERATIONAL ACTIVITY TO SYSTEMS TRACEABILITY 

MATRIX

SV-5b is an extension of SV-a to depict the mapping of operational activities to
systems. It addresses the links between systems described in the SV-1 Systems
Functionality Description and the operational activities specified in the OV-5a
Operational Activity Decomposition Tree or the OV-5b Operational Activity Model.

The SV-5b Report Template

The SV-5b report template generates a matrix of the mapping between systems and
operational activities. The parameters taken into account for the report are:

• The Architecture to be analyzed.
• The Subset parameter. This parameter is optional and can be set with a 

subsets of the functional elements (e.g. functional activity, functional 
process) and the resource types (e.g. applications, artifacts, org-unit, 
resource architecture) of the architecture. If this parameter is not set, all 
these aforementioned architecture objects are taken into account in the 
analysis.

The SV-5b Operational Activity to Systems Traceability Matrix 
Chapter

This chapter displays a matrix where rows contain systems and columns contain
operational activities. Cells with checkmarks indicate that the corresponding system
is mapped to an operational activity.
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SV-6 SYSTEMS DATA EXCHANGE MATRIX

SV-6 specifies the characteristics of the system data exchanged between systems.
This model focuses on automated information exchanges (from OV-3) that are
implemented in systems. Non-automated information exchanges, such as verbal
orders, are only depicted in OV models.

System data exchanges express the relationship across the three basic architecture
data elements of an SV (systems, system functions, and system data flows) and
focus on the specific aspects of the system data flow and the system data content.
These aspects of the system data exchange can be crucial to the operational mission
and are critical to understanding the potential for the nonattainment of objectives
and the constraints introduced by the physical aspects of the implementation.

SV-6 relates to, and grows out of OV-3. The operational characteristics for the OV-
3 information exchanges are replaced with the corresponding system data
characteristics.

Performance attributes for the operational information exchanges are replaced by
the actual system data exchange performance attributes for the automated portions
of the information exchange.

See:
 "The SV-6 Report Template", page 202
 "The SV-6 Systems Data Exchange Dictionary Chapter", page 203
 "The SV-6 Systems Data Exchange Matrix Chapter", page 203
 "The SV-6 Contents Linked to System Items Chapter", page 204

The SV-6 Report Template

The report template used to generate the SV-6 report is composed of three
parameters.

• The first parameter is the Architecture to be analyzed.
• The second parameter is an optional value that is used to reduce the 

scope of the study. This parameter is set with interfaces described in the 
architecture. In this case, the SV 6 report focuses on this set of 
interfaces and on the information exchanges contained in these 
interfaces. The MEGA objects used to set this parameter are 
Interactions.

• The third parameter, which is also optional is set with the exchange 
properties to be considered during the analysis. The objects used for 
these properties are of the MEGA MetaAttribute and MetaAssociationEnd 
types, which are applicable to content and message flows. During the 
report generation, the value for the parameter is verified and for each 
correct value encountered, a column is added to the table that displays 
the value of the attribute for the content or the message flow, or the list 
of the objects linked to the association. 
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The SV-6 Systems Data Exchange Dictionary Chapter

The Systems Data Exchange Dictionary is similar to the OV-3 Operational
Information Exchange Dictionary, however, columns characterize the system
properties of the exchange.

This Systems Data Exchange Dictionary chapter lists in alphabetical order all the
information elements (contents) of the architecture, defined at the system level.

Each information element is then described in detail with a list of all the information
exchanges in which it is involved. The source and target of the information is also
included.

Example of the SV-6 Systems Data Exchange Dictionary

The SV-6 Systems Data Exchange Matrix Chapter

This chapter identifies and displays the information elements of the architecture
systems and the relevant attributes of their information exchanges. These
exchanges are associated to their producer and consumer systems and tasks and to
the interactions that they satisfy.
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The SV-6 Contents Linked to System Items Chapter

This chapter presents a table which lists the contents of the architecture that are
linked to system items. This helps the user determine if the type of contents linked
are defined according to the scope defined for this system architecture. This
definition is based on the "View Type" property.

Example of a Contents Linked to System Items Chapter
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SV-7 SYSTEMS MEASURES MATRIX

The Systems Measures Matrix (SV-7) identifes the quality requirements considered
crucial to the successfull achievement of the mission goals assigned to systems.
Very often these requirements are the deciding factors in acquisition and
deployment decisions, and figure strongly in systems analyses and simulations done
to support the acquisition decision processes and system design refinement. 

SV-7 therefore specifies the quality requirements of systems, system hardware and
software items, their interfaces (system data carried by the interface and the
communications link details that implement the interface), and their functions. It
specifies the current quality requirements and those expected or required at
specified times in the future. The quality requirement categories are selected by the
architect and end user community. As the complete set of quality requirements may
not be known at the early stages of architecture definition, it is to be expected that
this model will be updated throughout the system’s specification, design,
development, testing, and maybe even its deployment and operations life-cycle
phases. 

SV-7 builds on other viewpoints by specifying quality requirements for systems and
interfaces (defined in SV-1), system ports and communications (defined in SV-2),
system functions (described in SV-4), system data exchange attributes (defined in
SV-6), and data definitions (defined in DIV). If the future quality expectations are
based on expected technology improvements, then the quality requirements and
their time periods will be coordinated by using a Systems Technology Forecast (SV-
9). If quality improvements are associated with an overall system evolution or
migration plan, then the time periods in SV-7 will be coordinated with the milestones
in a Systems Evolution Description (SV-8).

The SV-7 Report Template

The SV-7 report template is supplied with one parameter: the architecture to be
analyzed. There are no additional parameters.

The SV-7 Systems Measures Chapter

This chapter lists the quality requirements of the architecture with their name and
comment. A paragraph dedicated to each requirement is displayed with the sub-
requirements of the requirement. It also displays the objects constrained by the
requirement.
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SV-8 SYSTEMS EVOLUTION DESCRIPTION

SV-8 captures evolution plans that describe how the system, or the architecture in
which the system is embedded, will evolve over a lengthy period of time. 

To successfully understand the time evolutions, timeline milestones are very
important. In Information system planning, master plans are used to define long
term evolutions of system that will best respond to business function demands.

The MEGA Suite for DoDAF 2 allows the user to create master plans that describe
system evolution. A master plan is composed of milestones where life periods of
architecture items are constrained. The master plans are used to describe system
evolution scenarios and depending on the analysis of these scenarios, the scenarios
can either be elected, rejected or postponed.

An architecture contains one or more master plans. Each of them describes the
evolution of different parts of the system. A specific master plan is used to describe
the overall evolution of the system. The creation of this master plan is transparent
to the user. It enables the creation of top level scenarios.

For further information on Master Plan modeling, see the MEGA IT Planning
documentation.

See:
 "Creating a Solution Master Plan", page 206
 "Displaying the Gantt Chart", page 207
 "The SV-8 Report Template", page 209
 "The SV-8 Gantt Chart Chapter", page 209
 "The SV-8 Systems Evolution Description Chapter", page 210
 "The SV-8 Systems Evolution Comparison Chapter", page 210

Creating a Solution Master Plan

Solution Master Plans are created in the navigation tree. The details of these Master
Plans are then displayed as a graphical representation in a Gantt Chart.

To create a Solution Master Plan in the DoDAF 2.0 navigation tree:
1. In the DoDAF 2.0 navigation window expand the Systems Viewpoint 

and SV-8 Systems Evolution Description folders.
2. Right-click the All System Master Plans folder and select New > 

Master Plan.
3. Enter the name of your Master Plan.
4. Select the planning mode of your Master Plan. By default the Master plan 

is date-oriented.
5. Click OK.

The new Master Plan appears in the tree under the All System Master
Plans folder. 
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A Planned Item Periods folder is automatically created with the Master Plan.
Three basic milestones are created with the "milestone-oriented" Master Plans; As-
Is, To-Be, Distant Future.

Displaying the Gantt Chart

The Gantt chart is automatically created with the master plan.

To view the Gantt chart of a master plan:
1. Right click on the new master plan.
2. Select the Open Gantt Chart command.

The Master Plan is initialized with the milestones that were created.
Milestone arrangement is from left to right.

You can create and modify elements directly in the Gantt Chart.

To complete the Master plan, you can:
• Create milestones
• Create planned configuration capabilities
• Add the time periods of objects to be planned.
• Indicate the lifecycle status of the planned objects.

Creating milestones in a Gantt Chart

A milestone marks the date on which the results of a task are expected. Each
milestone therefore corresponds to the beginning or end of availability of a resource
architecture/system. Milestone arrangement is from left to right.

To create a milestone and add it to a Master plan from the Gantt Chart:
1. Click the Milestone button at the top of the Gantt Chart.

2. In the dialog box that appears, enter the name of the milestone.
3. Indicate the type of milestone to be created. In the case of a standard 

milestone, select the preceding milestone.
4. Click OK.

The Milestone is created and appears in the Master Plan. This Milestone is
also displayed in the Properties dialog box of the Master Plan, in the
Characteristics tab.

 Milestones belong to a particular master plan and cannot be reused 
in others.

If you made an error and wish to delete the milestone, click the cross on
the milestone.

 You can change the name and dates of a milestone in its 
Properties dialog box, Characteristics tab. Do not forget to refresh 
the Gantt chart to display the modifications.
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Creating planned capability configurations with time periods and lifecycle 
status

You can describe the life periods of configuration capabilities.

To create planned configuration capabilities with time periods and lifecycle status:
1. Above the master plan table, click the Add Time Period button.
2. In the Query dialog box that appears, use the Find button to find the 

required object, in this case the resource architecture of the capability 
configuration.

3. In the list proposed, select your object and click OK.

The dialog box for adding planned items opens with the chosen object.
4. Click Next to continue.

You are then required to select the lifecycle status of the object. This cycle status is
attached to the planned configuration capability and is integrated between two
milestones. 

You have the choice between three cycle states:
• Preparation
• Production
• Retirement

5. Select the lifecycle status that applies and click Next.

You are then required to select dates that indicate the beginning and end of the
availability of the planned configuration capability.

6. Select the start and end dates for the planned item then click Finish.
The planned system appears in the diagram along with the name of the
system.
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When completed, the Gantt Chart displays the milestones, planned objects and time
periods.

Example of an SV-8 Gantt Chart

 You can access the properties of an object by selecting this object 
then in the "Selected Elements" box right-click the name of the object.

For more details on master plan modeling, refer to the MEGA IT Planning user
guide.

The SV-8 Report Template

The SV-8 report template gives a graphical understanding of the evolution planned
for the system.

The first parameter indicates the architecture to be analyzed.

The second parameter, Master Plan Subset, which is optional, indicates the master
plans to be analyzed. Groups of master plans are considered in chapters to enable
plan comparisons (see the chapter below). If no master plan is set, all the master
plans of the architecture are taken into account and the collected master plans are
compared individually.

A similar chapter is also displayed in the property pages of the master plan. It can
be used as an input tool to create and modify the milestones and the planned items.
This is known as the Gantt Chart Chapter.

The SV-8 Gantt Chart Chapter

This chapter gives an automatic graphical representation of the analyzed master
plans. A Gantt chart is displayed for each master plan.
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The SV-8 Systems Evolution Description Chapter

This chapter lists all the systems planned within the context of one or more master
plans. The purpose of this chapter is to summarize planned items in relation the
scenarios involved (What are the systems added? What is removed? What is
maintained?).

The SV-8 Systems Evolution Comparison Chapter

This chapter lists all the systems planned within the context of one or more master
plans. The purpose of this chapter is to enable a comparison of the planned items
in relation to the scenarios involved (What are the systems added? What is
removed? What is maintained?). It also displays conflicts that exist among planned
time periods.



211

DoDAF 2.0 System Viewpoint Models
SV-9 Systems Technology and Skills Forecast

SV-9 SYSTEMS TECHNOLOGY AND SKILLS FORECAST

The SV-9 defines the underlying current and expected supporting technologies that
have been targeted using standard forecasting methods. Expected supporting
technologies are those that can be reasonably forecasted given the current state of
technology and expected improvements.

New technologies should be tied to specific time periods, which can correlate with
the time periods used in SV-8 milestones.

SV-9 provides a summary of emerging technologies that impact the architecture
and its existing planned systems. The focus should be on the supporting
technologies that may most affect the capabilities of the architecture or its systems.

The SV-9 Report Template

The SV-9 report template shows the impact on technology of system evolution.
• The first parameter indicates the architecture to be analyzed.
• The second parameter, Master Plan Subset, which is optional, indicates 

the master plans to be analyzed. Groups of master plans are considered 
in the report to enable plan comparisons. If no master plan is set, all the 
master plans of the architecture are taken into account and the collected 
master plans are compared individually.

The SV-9 Technology Forecast Chapter

This chapter gives a graphical representation of the impact of system evolution on
the technology proposed in different master plans. A Gantt chart is displayed for
each master plan.

The SV-9 Technology Forecast Description Chapter

This chapter shows the impact of the system evolution proposed in different master
plans on the technology. Its purpose is to enable a comparison of the planned items
in relation to the scenarios involved (What are the systems added? What is
removed? What is maintained?). It also displays conflicts that exist among planned
time periods.
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SV-10A SYSTEMS RULES MODEL

Systems rules are constraints on architectures, systems, system hardware/software
items, and/or system functions. While other SV models (SV-1, SV-2, SV-4, DIV-1)
describe the static structure of the System and Service Views (this is, what the
systems can do), they do not describe, for the most part, what the systems must
do, or what they cannot do.

At the system or system hardware/software item level, SV-10a describes the rules
which depict how the architecture or its systems should behave under specific
conditions. At lower levels, it may consist of rules that specify the pre- and post-
conditions of system functions. Such rules can be expressed in a textual form, for
example, "If (this condition) exists, and (this event) occurs, (perform these
actions)."

The purpose of this model is to allow an understanding of behavioral rules and
constraints imposed on systems and system functions.

The DoDAF 2.0 navigation tree and the DoDAF 2.0 start page shows the constraints
grabbed during a deep exploration of the architecture. However, constraints cannot
be created from these locations. The constraints displayed are those attached to
system items of the architecture (system functions, system nodes, etc.).

See:
 "The SV-10a Report Template", page 212
 "The SV-10a Resources Constraints Specification Chapter", page 212
 "The SV-10a Rules Linked to System Items Chapter", page 213

The SV-10a Report Template

The SV-10a report template is supplied with one parameter: the architecture on
which the report is based. There are no additional parameters involved. The
template comes with two chapters: The SV-10a Resources Constraints Specification
chapter and the SV-10a Rules Linked to System Items chapter.

The SV-10a Resources Constraints Specification Chapter

This chapter lists the constraints and requirements attached to system items of the
architecture. This is an alphabetical list with an additional column for the comments.
A paragraph is added for each listed constraint and requirement to explain their
constrained objects .

If constraints and requirements are created from objects in Operational node
structure diagrams (OV-2), these constraints and requirements can be retrieved in
the Systems Rule Model chapter provided the "View Type" property of the constraint
is set to System. The constraints are then retrieved in the System Constraints
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folder while the requirements are retrieved in the System Requirements folder of
the SV-10a navigational tree.

The SV-10a Rules Linked to System Items Chapter

It is also possible to generate a chapter that lists all the potential constraints linked
to a system item.

This chapter displays a table with an alphabetical list of the constraints that are
linked to system items. This helps the user determine if the type of constraints
linked are defined according to the scope defined for this system architecture. This
definition is based on the "View Type" property.

If a constraint is not typed as System, a warning icon is displayed for this constraint
in the Scope column. Although not typed as system, the constraint appears in the
table because it is linked to a system item. This happens if the constraint was not
created from the DoDAF 2.0 navigation tree but from a diagram and then attached
to a system item of this diagram. The " View Type" property for rule with a warning
can, however, be changed from the table (right click the constraint > Properties
> DoDAF > DoDAF 2 State Level > DoDAF 2.0 Object View Type > etc.).
Refresh the chapter to show the changes.
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SV-10B SYSTEMS STATE TRANSITION DESCRIPTION

The SV-10b is a graphical method of describing a system (or system function)
response to various events by changing its state. The diagram basically represents
the sets of events to which the systems in the architecture will respond (by taking
an action to move to a new state) as a function of its current state. Each transition
specifies an event and an action.

The explicit time sequencing of system functions in response to external and
internal events is not fully expressed in SV-4. SV-10b can be used to describe the
explicit sequencing of the system functions. Alternatively, SV-10b can be used to
reflect explicit sequencing of the actions internal to a single system function, or the
sequencing of system functions in relation to a specific system.

Basically, state chart diagrams can be unambiguously converted to structured
textual rules that specify timing aspects of system events and the responses to
these events, with no loss of meaning. However, the graphical form of the state
diagrams can often allow quick analysis of the completeness of the rule set, and
detection of dead ends or missing conditions. These errors, if not detected early
during the systems analysis phase, can often lead to serious behavioral errors in
fielded systems, or to expensive correction efforts.

The MEGA Suite for DoDAF 2 can be used to describe specific state machines
attached to tasks. A state machine is a specific concept used to describe how a task
reacts to different events from the start points to the end points.

The SV-10b Report Template

The SV-10b report template comes with one parameter:
• The Architecture parameter that indicates the analyzed architecture.

The SV-10b Resources State Transition Description Chapter

This chapter lists all the state machines attached to tasks (activities). The chapter
starts with a simple table of the state machines (short name, long name, comment)
and the linked tasks.

For each state machine with a describing diagram or at least one event, a dedicated
paragraph is generated which has the name of the state machine as the title and
which displays the comment and the (commented) describing diagrams. The
paragraph lists the events (name and comment) in a table. The successions are
listed with their name, comment and the source and target events.
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SV-10C SYSTEMS EVENT-TRACE DESCRIPTION

Systems Event-Trace Descriptions (SV-10c) are used for moving from the initial
systems design to the next level of detail, to help define a sequence of system
interactions, and to ensure that each participating system or human role has the
necessary information it needs, at the right time, in order to perform its assigned
functionality.

SV-10c provides a time-ordered examination of system data elements exchanged
between participating systems (external and internal) or human roles, as a result of
a particular scenario or situation. Each particular scenario or situation may reflect
system-specific aspects or refinements of critical sequences of events described in
the Operational Viewpoint.

The SV-10c Report Template

The SV-10c report template provides a report of the interaction scenarios of the
architecture.

The parameter used for the report is the Architecture to be analyzed.

The SV-10c Resources Event-Trace Description Chapter

This chapter lists all the interaction scenarios in a table. The table displays the short
name, the long name and the comment of the interaction scenarios.

A specific paragraph is added for each interaction scenario which has detailed
information. This paragraph contains:

• The diagrams describing the interaction scenario
• The list of participating system or human role instances (name and 

comment)
• The list of message instances
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MODELING RULES AND REGULATIONS

The points dealt with in this chapter are:

 "Submodeling Regulation", page 218
 "DoDAF 2 Modeling Rules", page 219
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SUBMODELING REGULATION

The DoDAF 2 Modeling Regulation is a regulation (set of consistency rules)
dedicated to DoDAF 2. It includes the following sub-regulations that already exist:

• Report Regulation
• BPMN Regulation
• Isolated Object Regulation
• Message Flow Regulation
• Project and Method Regulation
• Structure & Organization Regulation
• Time Constraint Regulation
• Variation Modeling Regulation
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DODAF 2 MODELING RULES

The MEGA Modeling tool comes with a set of consistency rules that can be used to
verify that modeled architectures are well-designed. You can also set your own
rules. For further information on rules and regulations in MEGA Modeling Suite, see
the MEGA Common Features EN manual, The "MEGA Platform" chapter,
"Consistency Rules" paragraph.

In order to assist the user designing DoDAF 2.0 architectures, a set of rules have
been added that can be activated to dynamically check the relevance of certain
configurations. When these rules are set, warnings are displayed in the navigation
tree and/or diagrams that explain the pending issue for each architecture item and
offer solutions to correct them.

The table below displays additional rules that are specific to the DoDAF 2.0 context.
All rules that are already defined can be used to check a DoDAF 2.0 architecture.
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Component Naming

Rule Type of Rule Metaclass 
concerned Rule description

An organizational pro-
cess should not 
contain more than one 
operation with the 
same name

Recommendation Organizational Process An organization pro-
cess having two or 
more operations with 
the same may lead to 
confusing report since 
it is not possible to 
distinguish one from 
the other.
List the objects having 
the same names.

A system process 
should not contain 
more than one task 
having the same

Recommendation System Process A system process 
having two or more 
tasks with the same 
may lead to confusing 
report since it is not 
possible to distinguish 
one from the other.
List the objects having 
the same names.
Development Note: 
This already existing 
rule should be adapted 
to manage task and 
operation in a system 
process

A capability should not 
contain more than one 
capability composition 
having the same name

Recommendation Capability A capability having 
two or more capabi-
lity compositions with 
the same may lead to 
confusing report since 
it is not possible to 
distinguish one from 
the other.
List the objects having 
the same names.

An operational node 
should not contain 
more than one opera-
tional component 
having the same name

Recommendation Business Function
(Operational Node)

An operational node 
having two or more 
components with the 
same may lead to 
confusing report since 
it is not possible to 
distinguish one from 
the other.
List the objects having 
the same names.
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A functional process 
should not contain 
more than one func-
tional activity having 
the same name

Recommendation Functional Process A functional process 
having two or more 
activities with the 
same may lead to 
confusing report since 
it is not possible to 
distinguish one from 
the other.
List the objects having 
the same names.

An artifact should not 
contain more than one 
artifact component 
having the same name

Recommendation Artifact An artifact having two 
or more components 
with the same may 
lead to confusing 
report since it is not 
possible to distinguish 
one from the other.
List the objects having 
the same names.

An artifact should not 
contain more than one 
application host 
having the same name

Recommendation Artifact An artifact having two 
or more application 
hosts with the same 
may lead to confusing 
report since it is not 
possible to distinguish 
one from the other.
List the objects having 
the same names.

Rule Type of Rule Metaclass 
concerned Rule description
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A resource architec-
ture should not 
contain more than one 
architecture use 
having the same name

Recommendation Resource Architecture A resource architec-
ture having two or 
more architecture 
uses with the same 
may lead to confusing 
report since it is not 
possible to distinguish 
one from the other.
List the objects having 
the same names.

A resource architec-
ture should not 
contain more than one 
physical asset having 
the same name

Recommendation Resource Architecture A resource architec-
ture having two or 
more physical assets 
with the same may 
lead to confusing 
report since it is not 
possible to distinguish 
one from the other.
List the objects having 
the same names.

A resource architec-
ture should not 
contain more than one 
human asset having 
the same name

Recommendation Resource Architecture A resource architec-
ture having two or 
more human assets 
with the same may 
lead to confusing 
report since it is not 
possible to distinguish 
one from the other.
List the objects having 
the same names.

Rule Type of Rule Metaclass 
concerned Rule description
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Ownerships

Rule Type of Rule Metaclass 
concerned Rule description

An operation must be 
defined in the context 
of a organizational 
process

Requirement Operation An operation is a com-
ponent defining an 
organization process. 
It cannot be defined 
outside the scope of 
an organizational pro-
cess.

A task must be 
defined in the context 
of system process

Requirement Task A task is a component 
defining a system pro-
cess. It cannot be 
defined outside the 
scope of a system pro-
cess.

A capability composi-
tion must be defined 
in the context of a 
capability

Requirement Capability Composition A capability composi-
tion is a component 
defining a capability. It 
cannot be defined out-
side the scope of a 
capability.

A capability depen-
dency must be defined 
in the context of a 
capability

Requirement Capability Dependency A capability depen-
dency determines 
what components of a 
capability are 
dependent from each-
other. This definition 
must be established in 
the context of the 
components owner 
(the upper capability).

An operational compo-
nent must be defined 
in the context of an 
operational node

Requirement Operational Compo-
nent

An operational compo-
nent is a component 
defining an operatio-
nal node. It cannot be 
defined outside the 
scope of an operatio-
nal node.

A functional activity 
must be defined in the 
context of an functio-
nal process

Requirement Functional Activity A functional activity is 
a component defining 
a functional process. It 
cannot be defined out-
side the scope of a 
functional process.
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Data Modeling

An artifact component 
must be defined in the 
context of an artifact

Requirement Artifact Component An artifact component 
is a component defi-
ning an artifact. It 
cannot be defined out-
side the scope of an 
artifact.

An application host 
must be defined in the 
context of an artifact

Requirement Application Host An application host is 
a component defining 
an artifact. It cannot 
be defined outside the 
scope of an artifact.

An architecture use 
must be defined in the 
context of a resource 
architecture

Requirement Architecture Use An architecture use is 
a component defining 
a resource architec-
ture. It cannot be 
defined outside the 
scope of a resource 
architecture.

An physical asset must 
be defined in the 
context of a resource 
architecture

Requirement Physical Asset A physical asset is a 
component defining a 
resource architecture. 
It cannot be defined 
outside the scope of a 
resource architecture.

An human asset must 
be defined in the 
context of a resource 
architecture

Requirement Human Asset A human asset is a 
component defining a 
resource architecture. 
It cannot be defined 
outside the scope of a 
resource architecture.

Rule Type of Rule Metaclass 
concerned Rule description

Rule Type of Rule Metaclass 
concerned Rule description

The use of the Entity 
(DM) / Data Model 
relationship is not 
recommended in the 
DoDAF 2 context

Recommendation Entity (DM) The relationship 
allowing the linking of 
an data entity to a 
detailing data model 
does not belong to the 
UML notation. It is not 
recommended to use 
to create data model 
since it will not be 
handle by the DoDAF 
2 reports.
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Participation

Rule Type of Rule Metaclass 
concerned Rule description

A participant of an 
organizational pro-
cess should only be 
assigned by org-units 
or human assets

Requirement Participant It is recommended to 
not assign architecture 
items that are not org-
units or human assets 
to the organizational 
process participants 
since the exchange 
compliance reports 
will not able to esta-
blish proper analysis.
List assigned objects 
that are not confor-
med to the rule.

A participant of an 
functional process 
should only be 
assigned by operatio-
nal nodes or operatio-
nal components

Requirement Participant It is recommended to 
assign architecture 
items that are not 
operational nodes or 
operational compo-
nents to the functio-
nal process 
participants since the 
exchange compliance 
reports will not able to 
establish proper ana-
lysis.
List assigned objects 
that are not confor-
med to the rule.

A participant of an 
system process should 
only be assigned by 
artifacts, artifact com-
ponents, applications, 
application hosts, org-
units, human assets, 
resource architec-
tures or architecture 
uses

Requirement Participant It is recommended to 
assign architecture 
items that are not arti-
facts, artifact compo-
nents, applications, 
application hosts, org-
units, human assets, 
resource architec-
tures or architecture 
uses to the system 
process participants 
since the exchange 
compliance reports 
will not able to esta-
blish proper analysis.
List assigned objects 
that are not confor-
med to the rule.
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Service Definition (Protocol)

Rule Type of Rule Metaclass 
concerned Rule description

A message must be 
connected to one pro-
ducer and one consu-
mer role of the service 
definition

Requirement Message Development Note: 
Check that there is a 
message rule that 
checks that a message 
is not connected to 
two roles. This rule 
must be updated to 
include the protocol 
context exception.

A service point must 
play a provider role of 
a service definition.

Requirement Service Point A service point plays 
one of the roles of a 
service definition. This 
role must be a provi-
der role so that the 
service point is a sup-
porter for the exposed 
service.
List the wrong roles.

Appliance Condition: 
The service point is 
linked to any role that 
is not a provider role 
of a service definition 
(protocol).
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A request point must 
be play a consumer 
role of a service defini-
tion

Requirement Request Point A request point plays 
one of the roles of a 
service definition. This 
role must be a consu-
mer role so that the 
request point is a 
consumer of the 
requested service.
List the wrong roles.

Appliance Condition: 
The request point is 
linked to any role that 
is not a consumer role 
of a service definition 
(protocol).

A service point should 
be linked to a service 
definition role.

Suggestion Service Point A service point is 
designed to explain 
what service is 
exposed to the consu-
mers. It is more accu-
rately defined if a 
provider role of a ser-
vice definition is 
connected.

Appliance Condition: 
The service point is 
not connected to a 
role.

A request point should 
be linked to a service 
definition role.

Suggestion Request Point A request point is 
designed to explain 
what service is 
requested by the inte-
racting item. It is 
more accurately 
defined if a consumer 
role of a service defini-
tion is connected.

Appliance Condition: 
The service point is 
not connected to a 
role.

Rule Type of Rule Metaclass 
concerned Rule description



228 MEGA Suite for DoDAF 2

12

BPMN Modeling

Rule Type of Rule Metaclass 
concerned Rule description

A functional process 
must include only 
functional activities 
that can be based on 
sub-processes

Requirement Functional Process In order to ensure pro-
cess analyses, each func-
tional process is 
described by sequencing 
and interacting functional 
activities. If a sibling 
functional process is 
involved then a call to it is 
specified linking the 
appropriate activity. This 
enables the separation 
between the functional 
process definition and the 
references to other exis-
ting processes.

An organizational pro-
cess must include only 
operations that can be 
based on sub-pro-
cesses

Requirement Organizational Process In order to ensure pro-
cess analyses, each orga-
nizational process is 
described by sequencing 
and interacting opera-
tions. If a sibling organi-
zational process is 
involved then a call to it is 
specified linking the 
appropriate operation. 
This enables the separa-
tion between the organi-
zational process definition 
and the references to 
other existing processes.

An system process 
must include only 
tasks that can be 
based on sub-pro-
cesses

Requirement System Process In order to ensure pro-
cess analyses, each sys-
tem process is described 
by sequencing and inte-
racting tasks. If a sibling 
system process is invol-
ved then a call to it is 
specified linking the 
appropriate task. This 
enables the separation 
between the system pro-
cess definition and the 
references to other exis-
ting processes.
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Dependency

Rule Type of Rule Metaclass 
concerned Rule description

Only one dependency 
should be set between 
two capability compo-
sitions

Recommendation Capability Dependency There is more than 
one capability depen-
dency that links the 
same capability 
sources and targets.
List all the dependen-
cies.

Development Note: 
Check all the sources 
and targets thinking 
that more than one 
source can exist.

Only one dependency 
should be set between 
two projects

Recommendation Project Dependency There is more than 
one project that links 
the same project 
sources and targets.
List all the dependen-
cies.

Development Note: 
Check all the sources 
and targets thinking 
that more than one 
source can exist.
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METAMODEL RENAMING

Customer feedback have indicated that a difficulty exists in using the DoDAF 2.0 application with a
mixture of both DoDAF 2.0 and MEGA vocabulary. This difficulty is visible in the DoDAF 2.0
navigation tree which uses DoDAF 2.0 vocabulary while created objects have MEGA metaclass
names.

To bridge the gap between both worlds (MEGA and DoDAF 2.0) and simplify the appropriation of
the DoDAF 2.0 application by a DoDAF 2.0 expert, the MEGA metamodel has been translated and
the notions used renamed. DoDAF 2.0

This section therefore details the mapping made between the MEGA and DoDAF 2.0 concepts used.
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MEGA METAMODEL RENAMING

This section indicates the concepts relating to DoDAF 2.0 models and the MEGA
concepts used to implement them. 

The table below lists the concepts renamed with their standard definition (from the
MEGA perspective) and the DoDAF 2.0 definition. The aim of this renaming is to
make the mapping between the DoDAF 2.0 concepts and the MEGA concepts as
invisible as possible for the user. 

MEGA Concept DoDAF 2.0 
Concept

Initial MEGA Defi-
nition

DoDAF 2.0 Defini-
tion

Business Function Operational Node A business function is 
a skill or grouping of 
skills of interest for 
the enterprise.

An operational node is 
a node that performs a 
role or a mission.
A node is a represen-
tation of an element of 
architecture that pro-
duces, consumes or 
processes data.

Folder of Business 
Functions

Folder of Operational 
Nodes

Non-methodological 
grouping of business 
functions.
This concept enables 
assembly under the 
same root of business 
functions around a 
common theme when 
this theme cannot be 
explained in the 
method.

Non-methodological 
grouping of operatio-
nal nodes.
This concept enables 
assembly under the 
same root of operatio-
nal nodes around a 
common theme when 
this theme cannot be 
explained in the 
method.

Objective Skill
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THE HOPEX METAMODEL FOR DODAF 2.0

This chapter presents all the HOPEX metamodels used to implement the DoDAF 2.0
viewpoints.

A graphical representation of each metamodel is included, each with HOPEX
names. If the names are changed when the DoDAF 2 Metamodel Customizations
add-on is imported, the new names are highlighted in yellow near the HOPEX
names.

 Some views are not directly supported by a dedicated metamodel. 
They are instead linked to data modeled in two or several other views.
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Notation

The metamodel diagrams in this section are based on the UML notation. Below are
a few points to help you better understand these diagrams.

Concept Meaning Notation

MetaClass Defines object type.
Each rectangle may include a list of 
properties.

Abstract MetaClass This concept cannot be instantiated 
and must be inherited from 
concrete metaclasses (gray rec-
tangle).
Each rectangle may include a list of 
properties.

Association For each association :
- Association end names are dis-
played to indicate the relationship 
between the linked objects.
- The multiplicity (1, 0..1, *) is dis-
played for some associations. This 
determines the range of linkable 
objects.
- A white circle at the end of an 
association indicates which is the 
major object in the association, i.e., 
the object which is modified in case 
the association is removed.
- A black diamond at the end of an 
association indicates that the other 
object is a component of the major 
object. It is a strong association 
between the two objects. When the 
major object is deleted, all is com-
ponents are also deleted.

Inheritance Inheritances are illustrated by 
arrows drawn between concepts.
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Examples

Where appropriate diagrams exist in, metamodels are illustrated by examples.
These examples are used to illustrate how notions and relationships are drawn in
specific diagrams. The content is therefore not at all concrete; the names of items
are based on the names of notion suffixed by a random number so that the reader
is able to associate the graphical representation to their corresponding object types.

 "All Viewpoint Metamodels", page 236
 "Capability Viewpoint Metamodels", page 237
 "Data and Information Viewpoint Metamodels", page 242
 "Operational Views Metamodels", page 244
 "Project Viewpoint Metamodels", page 257
 "Service Viewpoint Metamodels", page 259
 "Standard Viewpoint Metamodels", page 260
 "System Viewpoint Metamodels", page 262
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ALL VIEWPOINT METAMODELS

 "AV-1 Overview and Summary Information", page 236
 "AV-2 Integrated Dictionary", page 236

AV-1 Overview and Summary Information

AV-1 defines the architecture (Architecture Description) contained in a HOPEX
library. All items of the architecture are automatically defined in the associated
library. Additional properties define the general purpose of the architecture.

AV-1 Metamodel

AV-2 Integrated Dictionary

The integrated dictionary is composed of all the items defined in the context of the
Architectural Description object. From this object, the container library is retrieved
via the Architecture Library association. The library is then explored to retrieve all
contained items based on the HOPEX extraction tool. The dictionary is composed
of these items.

AV-2 Metamodel
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CAPABILITY VIEWPOINT METAMODELS

 "CV-1 Vision", page 237
 "CV-2 Capability Taxonomy", page 238
 "CV-3 Capability Phasing", page 239
 "CV-4 Capability Dependencies", page 240
 "CV-5 Capability to Organizational Deployment Mapping", page 241
 "CV-6 Capability to Operational Activities Mapping", page 241

CV-1 Vision

From the enterprise master plan defined in theNAV-1 metamodel, it is possible to
refine the definition by inserting capability planning. Both the master plans and the
milestones that divide enterprise life into sub-sections can be linked to goals that
describe the expectations over a duration of time.

CV-1 Metamodel
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CV-2 Capability Taxonomy

CV-2 defines capabilities and the composition of capabilities.

CV-2 Metamodel

Below is an example of a Capability Structure Diagram that describes a capability
(Capability-19) that contains two capability compositions (12 and 45) based on
other capabilities (respectively 20 and 23).

CV-2 Example in a Capability Structure Diagram

In the example below, the same capability structure is drawn, however, this time in
a tree diagram. By default, composition names are not displayed so that the drawing
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appears like a tree. It is, however, possible to force the display of composition
names, if required (as done for composition-45).

CV-2 Example in a Capability Tree Diagram

CV-3 Capability Phasing

CV-3 illustrates when solutions are implemented. Solutions are resource
architectures that support a capability. The master plan defines the temporal views
via milestones.

To be considered capability configurations the resource architectures must be linked
to a capability.

CV-3 Metamodel
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CV-4 Capability Dependencies

CV-4 identifies the dependencies between capabilities. Dependencies are identified
in relation to the context in which they are included and link the capability
compositions that are defined within an upper capability. Two associations are
required in order to set the source and target of each dependency.

The CapabilityDependencyName property is used to automatically find the name of
the dependency that depends on the "container" capability and the capability source
and target.

CV-4 Metamodel

The CV-4 and CV-2 examples are similar as they rely on the same kind of diagram
(Capability Structure Diagram). In the CV-4 example, capability dependencies are
represented by dashed arrows.

CV-4 Example in the Capability Structure Diagram
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CV-5 Capability to Organizational Deployment Mapping

This Metamodel enables the possibility of making links between capabilities and
resources during a particular period of time. The temporal views are captured in the
Master plans through milestones. 

CV-5 Metamodel

CV-6 Capability to Operational Activities Mapping

This Metamodel enables the possible of making links between capabilities (CV-2)
and functional activities (OV-5).

CV-6 Metamodel
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DATA AND INFORMATION VIEWPOINT METAMODELS

 "DIV-1 Conceptual Data Model", page 242
 "DIV-2 Logical data Model", page 242
 "DIV-3 Physical Data Model", page 243

DIV-1 Conceptual Data Model

The DIV-1 metamodel describes the data model and the entities and associations
that formalize the information transported between operational items. This
metamodel is based on a common entity-association metamodel. The link to the
operational model is established through the content transported by the messages.

The View Type property is set to Operational to identify conceptual data models.

DIV-1 Conceptual Data Model Metamodel

DIV-2 Logical data Model

The logical data model metamodel is similar to the information model metamodel
defined in the DIV-1 viewpoint. The sole difference is that in the logical data model
metamodel the message flow connected to the content must exchange information
between system items.
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In this metamodel, the View Type property is set to System to identify system data
models.

DIV-2 Metamodel

DIV-3 Physical Data Model

The DIV-3 metamodel supports the creation of databases with tables, columns, keys
and indexes.

DIV-3 Metamodel



244 MEGA Suite for DoDAF 2

14

OPERATIONAL VIEWS METAMODELS

 "OV-1 High-Level Operational Concept Graphic", page 244
 "OV-2 Operational Resource Flow Description", page 245
 "OV-3 Operational Resource Flow Matrix", page 246
 "OV-4 Organizational Relationships Chart", page 247
 "OV-5a Operational Activity Decomposition Tree", page 249
 "OV-6a Operational Rules Model", page 252
 "OV-6b Operational State Transition Description", page 254
 "OV-6c Operational Event-Trace Description", page 254

OV-1 High-Level Operational Concept Graphic

OV-1 is used to create high-level descriptions of architectures. Graphical
descriptions are illustrated through diagrams that include items of the library that
contains the architecture. Additional information can be attached to the architecture
by way of external references and notes.

OV-1 Metamodel
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OV-2 Operational Resource Flow Description

OV-2 describes the operational nodes of architectures. Each node can be subdivided
into different parts that are modeled as Operational Components. These
subdivisions are typed by sub-operational nodes.

In HOPEX operational nodes are called Business Functions.

OV-2 Structure Metamodel

In the example below, one operational node (1) contains two operational
components. These components reference sub-operational nodes (2 and 3).

Example of OV-2 Structure
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The OV-2 Metamodel is useful in defining the connectivity between operational
components via interactions.

OV-2 Interactions Metamodel

OV-2 Interaction Example

OV-3 Operational Resource Flow Matrix

The OV-3 model shows the matrix of the contents developed from the OV-2 and
those defined in the OV-5 models.
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The OV-2 model defines interactions that have protocol definitions. The definitions
are refined by messages exchanged between different protocol roles. Each message
carries an information element: the content.

The OV-5 model describes the functional behaviors of the operational nodes. From
the activities performed by these nodes result some messages (modeled by BPMN
message flows that also carry information elements.

One OV-3 report shows a matrix of the shared content between the OV-2 and OV-
5a and 5b models.

OV-3 Metamodel

It is also possible to create content directly from the OV-3 model. In this case, the
content is stamped at the operational level thanks to the View Type property.

OV-4 Organizational Relationships Chart

Organizational units are modeled thanks to the Org-Unit metaclass. In the DoDAF 2
Metamodel implementation, org-units are composed via a whole-part model that
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means there are contextual intermediate items at each hierarchy level to bring the
contextual dependencies (in this case information interactions).

Three types of org-units can be used: Organization, Post and Role. These are types
usually delivered by HOPEX with other names but these names appear if the
DoDAF 2 Metamodel Customization add-on has been imported.

Organizational-units inherit from several abstract notions that support the following
features:

• Variable Object: enables the creation of variant of the organization-
units. Each variant inherits from the components that can be replaced or 
excluded.

• Constrained Element: enables the adding of constraint to the 
organizational units. Constraints are defined in the 

• Physical Resource: enables the connection of process performance 
items and interaction scenario performance items. These items are the 
links between the organizational structure and the processes or 
interaction scenarios that describe the behavior of the structure.

• Organizational Resource: enables the ownership of interactions and 
communication channels between the components of an organizational 
unit.

An organizational unit can also be connected to some resources that define the
competencies he can develop.

Finally, organizational units are embodied by persons that have the role defined in
the organizational structure.

The OV-4 Metamodel also introduces the notion of a mapping between organizations
defined at a type level and those defined as the actual organizations. These mapping
allows for example to associate generic definitions to concrete organizations
deployed in different geographical sites.
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The following figure shows the Metamodel that supports this mapping. A Mapping
Type defines the mappings that can be created. In this situation the mapping is
between root organizational units. A notion of left and right mapped element is
introduced that is a generic term to differentiate between both set of mapped items.
Indeed, the mapping relationship is considered as an equivalence association and
there are no preferred directions.

The Organizational Structure

Once a mapping is created, the sub items can be mapped. There are connected
thanks to Mapping Items. In this mapping, the org-unit components and the
resources (competences) can be mapped.

OV-5a Operational Activity Decomposition Tree

Activity models are described through HOPEX functional processes. These models
are composed of participants (roles involved in the process) and functional activities
(tasks performed by participants). Functional processes describe scenarios of
operational node structures. The participants can therefore be assigned by either
operational nodes or operational components (the contextualized embodiment of an
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operation node). Functional activities can rely on sub-processes (called functional
processes).

OV-5a Structure Metamodel

OV-5a Sequence Flow metamodel



251

The HOPEX Metamodel for DoDAF 2.0
Operational Views Metamodels

Each functional activity can be sequenced in a functional process via a Sequence
Flow.

OV-5b Sequence Flow metamodel

OV-5b Example with Sequence Flow

Functional activities may exchange information through message flows. Information
can also be retrieved from/created in data objects. Data objects attached to
sequence flows are actually shortcuts to the source in the data object while the
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target retrieves the information to perform the activity. Data objects can be defined
with states.

OV-5b Message Flow and Data Objects

OV-5b Structure with Sequence and Message

OV-6a Operational Rules Model

Operational rules are modeled in relation to two notions: constraints that apply to
the operational items as external restrictions to the potential means for the project
achievement and requirements that are external requests at the capability level.
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This Metamodel enables the linking of operational items to constraints and
requirements in order to indicate what cannot be done and what must be fulfilled.

Constraints are Applied to Operational Items

OV-6a Imposed and Derived Operational Requirements



254 MEGA Suite for DoDAF 2

14

OV-6b Operational State Transition Description

OV-6b Metamodel

OV-6c Operational Event-Trace Description

The OV-6c metamodel can be divided into two parts: a process description and a
specific scenario where generic roles are instantiated.
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The process metamodel is similar to the OV-5a Metamodel. OV-6c is BPMN-
compliant, however, for this model participants are assigned to org-units and
human assets (org-units defined within the context of a resource architecture).

OV-6c Organizational Process Metamodel

Another alternative for the event-trace description is the operational interaction
scenario that allows the creation of operational node instances (or more accurately
operational components) and message instances.
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Interaction scenarios describe examples of processes through the interaction
scenario performances that link functional processes to operational nodes.

OV-6c Operational Interaction Scenario
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PROJECT VIEWPOINT METAMODELS

 "PV-1 Project Portfolio Relationships", page 257
 "PV-3 Project to Capability Mapping", page 257

PV-1 Project Portfolio Relationships

The PV-1 model details the projects that support the design and implementation of
architectures. Projects are dependent on each other (Project Dependency). They
produce deliverables that are embodied by MEGA objects such as applications and
org-units.

PV-1 Metamodel

PV-3 Project to Capability Mapping

The PV-3 metamodel makes the link between the project deliverables and periods
of a resource architecture (SV-1) defined to support a capability (CV-2) and planned
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in a solution master plan (CV-3). A period can be linked to a state that matches one
of the available resource architecture states.

PV-3 Metamodel
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SERVICE VIEWPOINT METAMODELS

 "SvcV-2 Service Resource Flow Description", page 259

SvcV-2 Service Resource Flow Description

Service definitions rely on the Service Definition notion in HOPEX. Each Service
Definition defines two or more roles that are involved in the service. One role
corresponds to consumers while the other corresponds to providers. The consumer
is connected to the service definition by the initiation association.

SvcV-2 MetaModel
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STANDARD VIEWPOINT METAMODELS

 "StdV-1 Standards Profile", page 260
 "StdV-2 Standards Forecast", page 260

StdV-1 Standards Profile

The StdV-1 metamodel supports the description of standards and can be used to
link standards to the items by which they are defined. At the opposite end of the
metamodel, standards can be linked to the elements that use them.

StdV-1 Metamodel

StdV-2 Standards Forecast

The StdV-2 model is based on master plans that can be used to plan and forecast.
As standards are time-dependent objects time periods can be linked to them and
placed into master plans of standards. The time periods represent moments in the
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"lifetime" of the standard and so they can be linked to states (UML states) that are
appropriate for the standard objects.

StdV-2 Metamodel
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SYSTEM VIEWPOINT METAMODELS

 "SV-1 Systems Interface Description", page 262
 "SV-2 Systems Resource Flow Description", page 266
 "SV-3 Systems - Systems Matrix", page 268
 "SV-4 Systems Functionality", page 268
 "SV-5a Operational Activity to Systems Function Traceability Matrix", page 269
 "SV-5b Operational Activity to Systems Traceability Matrix", page 270
 "SV-7 Systems Measures Matrix", page 270
 "SV-8 Systems Evolution Description", page 272
 "SV-9 Systems Technology and Skills Forecast", page 272
 "SV-10a Systems Rules Model", page 273
 "SV-10b Systems State Transition Description", page 275
 "SV-10c Systems Event-Trace Description", page 275

SV-1 Systems Interface Description

The SV-1 Metamodel is used to describe resource architectures, artifacts and
applications. Resource architectures and artifacts are described using a component
structure approach. Resource architectures are composed of physical assets (typed
by artifacts), human assets (typed by org-units) and architecture uses (typed by
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resource architecture). The objects are typed through the Deployed Resource
association. Only physical assets and human assets can be localized (linked to Site).

SV-1 Metamodel for Resource Architectures

SV-1 Example Including All Kind of Objects in a Resource Architecture

The metamodel that describes artifacts is similar to the resource architecture
metamodel. The items included in this metamodel are artifact components (Artifact
type) and application host (Application type).

Artifacts are deployed within the context of resource architectures. Their items are
deployed in the same manner therefore there are no sites in this metamodel.

SV-1 Metamodel for Artifact Structure
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The example below is of an artifact that contains a sub-artifact (via an Artifact
Component) and an application (via an Application Host).

SV-1 Example Showing an Artifact Assembly Diagram

System Interface

The interfaces between SV-1 items are described via service and request points.
Information is exchanged via interaction-connected service definitions. The SV-1
metamodel is similar to the OV-2 metamodel. 

In the figure below, the pink highlighted sections indicate the notions used to model
interactions.
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The View Type property is set to System to identify system data models.

SV-1 Metamodel for Interactions

SV-1 Interaction Example
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SV-2 Systems Resource Flow Description

In the SV-1 Metamodel, information exchanges are modeled through interactions
and service definitions as in the OV-2 Metamodel. It is also possible to model the
means set to support interactions that are not within the scope of an operational
viewpoint. This information is modeled in SV-2.

The introduced notions are similar to interactions; these notions are communication
ports, communication channels and communication protocols.

The pink highlighted sections in the Metamodel indicate the relationships used to
create a communication path which is composed of two communication end points
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(either a communication port or any communicating element endpoint).

SV-2 Metamodel for Communication Means

SV-2 Exchange Means Example
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Communication Protocols

Communication protocols can be decomposed into layers, which are then detailed
via sub-protocols (one or more per layer). The corresponding Metamodel is
indicated below.

SV-2 Metamodel for Communication Protocols

SV-3 Systems - Systems Matrix

This model shows two matrices between communicating elements: one matrix with
a checkmark in the cells when a communication channel exists between the row and
the column item, one other matrix with a checkmark in the cells when an interaction
exists between the row and the column item. 

SV-4 Systems Functionality

The SV-4 Metamodel is similar to the process metamodel used for OV-5 and OV-6a.
In this Metamodel, participants can be assigned by any of the items modeled in the
SV-1 model. This assignment can be done at the general level (Application, Artifact,
Resource Architecture) or at a more accurate level within the context of an
architecture (Application Host, Physical Asset, Architecture Use).
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Note: Since the organizational part defined in the OV-4 model is included in system
models, both org-units (general level) and Human Assets (contextual level) can be
assigned to participations.

SV-4 Metamodel Describing System Processes

SV-5a Operational Activity to Systems Function Traceability Matrix

This matrix allows to link functional behavioral elements (functional processes or
functional activities) to system behavioral elements (system processes or tasks).

In both the functional and system scopes, there are some processes that can be
assessed and hierarchically organized. Such organizations are obtained either using
the inheritance mechanism (variation) or the composition mechanism. In the last
situation, components are respectively functional activities and tasks.

Thus, it is possible to link the independent behavioral elements (processes) or the
contextualized elements corresponding to those including in a process (activities
and tasks).
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SV-5b Operational Activity to Systems Traceability Matrix

This matrix is used to link functional elements (functional processes or functional
activities) to resource types (resource architectures, artifacts, applications and org-
units).

SV-5b Metamodel

SV-7 Systems Measures Matrix

This model assesses all the system requirements (those having the View Type
property set to "System") and having the Requirement Type property set to
"Quality".
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These requirements can constrain all the architecture elements defined in the
system views.
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SV-8 Systems Evolution Description

The SV-8 metamodel can be used to plan systems (resource architectures
connected, or not, to a capability).

SV-8 Metamodel

SV-9 Systems Technology and Skills Forecast

The SV-9 Metamodel is similar to the SV-8 Metamodel, however, it can be used to
plan technology item (artifacts). To plan architecture items, the Infrastructure
Planning property of the master plan must be activated.

SV-9 Metamodel
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SV-10a Systems Rules Model

System rules are modeled in relation to two notions: constraints that apply to the
system items as external restrictions to the potential means for the project
achievement and requirements that are external requests at the capability level.

SV-10a Metamodel for Constraints
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SV-10a Metamodel for Requirements
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SV-10b Systems State Transition Description

The SV-10b Metamodel is similar to the OV-6b Metamodel. In this Metamodel the
View Type property is set to System to categorize the behavior at the system level.

SV-10b Metamodel

SV-10c Systems Event-Trace Description

SV-10c Metamodel supports the time-ordered description of events in a system.
This is supported by the interaction scenario concept that contains instances and
message instances.
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An interaction scenario describes an example of a process through the interaction
scenario performance that links a system process to a resource architecture.

SV-10c Metamodel
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In the example below, the first message instance is based on content (content-10)
while the second message instance is not yet specified.

A System Interaction Scenario Diagram
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